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Veripress User Manual

Copyright © Serendipity Software Pty Ltd

Reproduction of any part of this user manual is strictly forbidden without prior written permission from Serendipity
Software Pty Ltd. All company names, product names and trademarks mentioned in this manual are the property of the
respective company.

Important Notice

Every effort is made to ensure the information contained within this user manual is correct. Serendipity Software Pty
Ltd cannot be held responsible for any errors contained within this user manual and will not enter into any
negotiations for claims of compensation relating to actions taken resulting from the information provided in this user
manual for any reason whatsoever.

Serendipity Software Pty Ltd is constantly making improvements to the software and as such, this user manual may not
contain the latest information. Every effort is made to maintain the user manual and for the latest version please check
the website:

http://www.serendipity-software.com.au

If you find any errors within this user manual, please detail them in an email to: support@serendipity-software.com.au

Supporting Tutorial and HowTo documentation is available on our website:

http://www.serendipity-software.com.au/support
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Product Overview

Veripress is used to accurately softproof post-RIP data on a calibrated monitor, replacing hardcopy proofs in the print
production process.

Veripress runs in a Server and Client configuration. The Server runs on a network computer and is protected by a USB
dongle. The dongle licenses the level of software and the input filters and output drivers purchased.

The Client is used as the configuration tool and monitoring application for the Server. It can be run on the same
machine, or on another locally (LAN) or remotely (WAN) networked computer. The Client connects to the Server via
standard TCP/IP network protocol and is not licensed, so it can be run multiple times on the network.

Veripress has an input filter for most of the major manufacturers proprietary RIPs. The input filters read the native RIP
format and understand how jobs are assembled, the plates associated with a job and the directory structure. RIPs that
include databases and impositions are also read and understood. Jobs are proofed using the same post-RIP data that
goes to the press, thus maintaining data integrity and accuracy of the proofs.

Files are ripped once by the proprietary RIP and output as many times as desired. The jobs reside on the RIP, are
monitored by the Veripress Server and are displayed by the Client in the RIPMonitor, with all associated plates stitched
together. The files can be selected and submitted for processing by the Server as desired, or can be configured to
process automatically. At the processing point, jobs are copied (spooled) over from the RIP to the Server, leaving the
original untouched. Once the whole job is spooled, the Server begins to work on the files.

Imaging is the first process to take place. Imaging interprets the file format, completes any imposition assembling
required (for supported imposition RIPs) or any merging of CT/LW files, preserves any screening on the files and
samples the jobs resolution to change it to that of the output format configured. An intermediate file format is created
at this point, called the Imaged File. The Imaged File can be viewed using the SoftProof utility. The file format maintains
all the plates associated with the job and is viewed at the full output resolution. The Imaged File can also be re-
submitted at any time for processing to the same or a different output. There is no need to spool and interpret the job
again.* Many Veripress workflows will primarily use these imaged files for proofing.

After the imaging process has completed, the job is passed to the rendering engine. This takes the Imaged File and
creates the file ready for output. The process includes applying any output characteristics such as orientation, cropping,
colour management (ICC Profiles) and creation of the output file.

The Imaged File can be rendered as many times as desired. Each time, any of the output characteristics can be changed
prior to rendering. Once the job is rendered, it is saved internally as a Serendipity Blackmagic Image file and can be
forwarded to a remote location for viewing.

The Client monitors the whole process from start to finish, showing a jobs progress in a QueueManager and
QueueStatus window. Jobs can be managed separately by placing a job on hold, releasing a job, cancelling or promoting
as desired. The processes (queues) can be paused at any time, holding all jobs from spooling, imaging & rendering. If a
job fails, the error can be examined, rectified and the job retried. There are logs reporting all Server and Client
functionality and job information from first detection on the RIP to final output. The logs can be searched, filtered or
saved to a file.

Jobs in the QueueManager can be loaded and proofed in a press room environment to a calibrated monitor; controlled
using an attached touch screen.

The system creates a database of all configurations, calibration curves and other settings. This database can be backed-
up on demand or automatically, so a working copy is always available. It can be copied to any other Veripress as a
whole database or as individual items.

*This applies to any output characteristics. If any changes are required for the Imaged File, e.g., changing plates, resolution etc, the file will need to be

re-submitted from the RIPMonitor.
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Installation

The installation section describes the process for each platform in turn.

The software is supplied on one DVD for Macintosh, Linux and Windows versions. All versions come with a dongle and
require a dongle driver be installed. Existing installations of the software are given the opportunity to upgrade,
preserving any existing configurations.

What's on the DVD?

The DVD contains all elements required to run Veripress and associated programs.

They are divided into directories, detailed below:

Agent - Contains the Agent software for all supported platforms. Choose the subdirectory that matches the
required operating system.

Docs - Contains all documentation.

Dongle - Contains the dongle drivers for Linux, MacOSX and Windows.

Drivers - Contains the Megarip PPDs for all supported platforms.

Extras - Contains additional components and print drivers loaded as part of the install process.

HTML - Contains the information required for the web browser install. This automatically launches the default
browser for installation to begin.

Linux - Contains the Veripress and AppleTalk installation packages for Linux.

MacOSX - Contains the Veripress installation package for MacOSX.

Serendipity Client - Contains the Serendipity Client for all supported platforms.

Testprn - Contains Serendipity internal test prints.

Windows - Contains the Veripress installation package for Windows.
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Windows Installation

Administrator rights are required to install Veripress and the Serendipity Agent. If upgrading from an existing
installation to version 5.3, see “Upgrading to Version 5.3” within this manual.

Installing the Dongle Driver - Windows
The first step is to install the dongle driver.

To install:
1. Remove all SuperPro USB dongles.
2. Onthe DVD, navigate to the dongle/windows folder.
3. Double click the Sentinel Protection Installer.exe file to launch the installer.
4. Follow the onscreen instructions to complete the installation.
5. Restart the computer when finished.

Installing Veripress
The next step once the dongle driver is installed is to install Veripress. There are two (2) Windows files available for
installation - 32 bit or 64 bit version. Select the appropriate file for your system to install.

1. Either select and run the Veripress installer by clicking the link on the browser page (if it pops up as an
Autoplay when the disk is inserted), or go to the DVD and navigate to the Windows directory to run the file
Veripress.msi (32 or 64 bit version).

2. Follow the onscreen instructions to complete the installation.

Note: You can type your own path and the installation program will make the folder for you, provided your chosen
location has valid permissions. Use back slashes (\) to separate directories.

Installation of the Serendipity Agent

If you are polling a RIP (or RIP folder) on a Windows machine, the most efficient method is to use the Serendipity
Remote Agent. This runs a service on the Windows machine where the RIP is located. Veripress communicates with the
Agent to poll and transfer jobs.

To install:

1. Either
a. Select and run the Veripress installer by clicking the link on the browser page (if it pops up as an
Autoplay when the disk is inserted), or
b. Run the agent32.msi (32-bit) or agent64.msi (64-bit) file, located in the /agent/windows folder of
the installation DVD.
2. Follow the onscreen instructions to complete the installation.

Once the installation has finished, proceed to the “Running the Software” section of this manual.
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Mac OS X Installation

Administrator rights are required to install Veripress and the Serendipity Agent. If upgrading from an existing
installation to version 5.3, see the “Upgrading to Version 5.3” section within this manual.

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:
1. Remove all SuperPro USB dongles.
2. On the DVD, navigate to the dongle /macosx folder.
3. Double click the Sentinel System Driver.pkg file to launch the installer.
4. Follow the onscreen instructions to complete the installation.
5. Restart the computer when finished.

Installing the Serendipity Printer Drivers
The Serendipity Printer Drivers are used when setting up a Published Pagesetup for printing (or proofing) from a third
party application (e.g. Photoshop) directly to Veripress.

The installation package is located on the Veripress 5.3 Installation DVD:

1. Navigate to the /drivers/mac folder and run the file Serendipity Printer Drivers.pkg
2. An installer window will appear. Follow the prompts to complete the installation of the drivers. The installer
will require administrator access privileges.

Installing Veripress

1. Go to the macosx folder on the Veripress installation DVD.
2. Double click the file Veripress.pkg to launch the installer.
3. Follow the onscreen instructions to complete the installation.

Important note: Before starting the software after installation, see the Running the Software section (Mac OS X only).

Installation of the Serendipity Agent

If you are polling a RIP (or RIP folder) on a Mac OS X machine, the most efficient method is to use the Serendipity
Remote Agent. This runs a service on the Mac OS X machine where the RIP is located. Veripress communicates with the
Agent to poll and transfer jobs.

To install:

1. Select and run Serendipity Agent.pkg file located in the agent/macosx folder on the installation DVD.
2. Follow the onscreen instructions to complete the installation.

Once the installation has finished, proceed to the “Running the Software” section of this manual.

Creating Dock Start Icons
To make it easy when starting the Server and Client, it is recommended you create a Dock shortcut. To do this:

1. Run the Veripress Server and Client applications from the installation location.

2. Once the Server and Client icons appear in the dock, right click (or CTRL+click) the mouse and select Keep in
Dock from the menu.

3. Alternatively, drag the Server and Client icons directly onto the Dock before they have been launched.

4. Toremove the Dock icons, drag them off the dock with the mouse onto the desktop and release.
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Linux Installation

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:
1. Remove all SuperPro USB dongles.

2. Navigate to the dongle/linux folder on the installation DVD.
3. Double click the sntl-sud-7.5.1-0.i386.rpm file to install the driver.

Installing Veripress

Important Note: Before installing on a Linux x64 operating system, please ensure the following i686 (32-bit) libraries

are installed.

¢ libstdc++.i686 GNU Standard C++ Library

* mesa-libGLU.i686 Mesa libGLU runtime library

* zlib.i686 The zlib compression and decompression library

* freetype.i686 A free and portable font rendering engine

¢ libXrender.i686 X.0rg X11 libXrender runtime library

* fontconfig.i686 Font configuration and customisation library

¢ glib2.i686 A library of handy utility functions

* libpng.i686 A library of functions for manipulating PNG image format files
¢ libSM.i686 X.0rg X11 Sm runtime library

If the Package Installer can not locate the libraries, open a terminal window, go to the /root directory and install each
library using the following command:

yum install name of library

To Install Veripress

Navigate to the linux folder on the installation DVD.

Double click the install.sh file and select “Run in Terminal”.

A terminal window will popup and the installer will display the default installation directory.
Press Enter to install or type an alternative path then press Enter.

W

Note: If using an alternate install path, ensure the folder exists and that the current user has read/write/execute

permissions for the folder.

5. When the installation is complete the terminal window will close.

Once the installation has finished, proceed to the “Running the Software” section of this manual.
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Upgrading to Version 5.3
This section details upgrading an existing Veripress installation to version 5.3. The installer automatically upgrades the
existing database to the current 5.3 format. As a precaution before upgrading, it is recommended that the Veripress
database and ICC profiles are backed-up using the Archives application (see Windows Upgrade or Mac OS X Upgrade
sections for details), or by copying the database directories (see Copying the Database and ICC Folders section for

details).

Important Note: Pagesetups imported from Version 3 archives will automatically be split into Media and Pagesetup
data types but remain functionally linked. Version 5.3 archives cannot be opened or imported into previous versions of
Veripress.

Windows - Upgrading to Version 5.3

Archiving Current Installations
To Archive a Database:

1.
2.

Run the existing Veripress Server and Serendipity Client.

Go to the Serendipity Client Application menu > Archives (This
application is called Archiver in earlier versions).

Select File menu > Perform Full Backup.

Alternatively, select Edit menu > Add to Archive (All) and add
all database items to the archive file, or right click in the
Archives window and select Add to Archive (All) > Everything
from the contextual menu.

Once all database items have appeared in the Archives window,
select File menu > Save Archive to save the .sdb archive file to a
chosen location.

Close the Archives application when finished.

Installing the Dongle Driver Update
Version 5 dongles (new or upgraded) require an up-to-date Safenet dongle driver in order to function.

To upgrade:

1.

AR

Make sure the Veripress Server and Client are not running and remove any Veripress (or any other SuperPro
USB) dongles from the computer.

On the Veripress installation DVD, navigate to the dongle/windows folder and run the Sentinel Protection
Installer.exe file. Alternatively, download and run the latest driver install from the Safenet website
(http://www.safenet-inc.com/support-downloads/sentinel-drivers/).

Run the Sentinel installer.

Select Upgrade and Next.

Follow the onscreen instructions to complete the upgrade.

Restart the computer when finished.

Installing C++ Runtime Libraries

To run correctly, Veripress 5.3 requires the installation of Microsoft Visual C++ Redistributable libraries that may not
be present in your Windows operating system. If these were not installed for the existing Veripress version, they will
need to be installed now.

To install:

1.

2.

Navigate to the windows folder on the Veripress DVD.
a. For Windows 32-bit - Run the vcredist_x86.exe file
b. For Windows 64-bit — Run the vcredist x64.exe file
Follow the prompts to install Microsoft Visual C++ 2008 Redistributable.

Serendipity Software - Veripress User Manual - Version 5.3
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Installing the Veripress 5.3 Upgrade
Current Windows file /folder security and permissions makes it necessary to install Veripress v5.3 in the root directory
of the hard drive, e.g., C:\Serendipity\ rather than Program Files, where earlier versions of Veripress were installed.

To upgrade:
1. Insertthe Veripress installation DVD and navigate to the windows folder.
2. Run the veripress32.msi (32-bit) or the veripress64.msi (64-bit) file.
3. [If necessary, change the installation directory to the root directory of the hard drive, e.g. C:\Serendipity\ and
click Next.
4. Follow the onscreen instructions to complete the upgrade.
5. Plug the Veripress dongle into an available USB port.
6. Startthe Veripress v5.3 Server and the Serendipity Client.

If the installation location did not require changing, the existing database should appear once the Server and Client
have restarted, reformatted and intact in the Workbench. The Client should open with the previous versions
configuration.

If the installation location was (or needed to be) changed, or in the event the existing database is not complete, the
database backup needs to be imported using the Archives application.

To import an existing database backup:

N

Open the Archives application from the Serendipity Client Application menu.

In Archives, select File menu > Open Archive.

Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives
window and display all database items from the previously backed-up configuration.

Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the entire
database.

Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected
Nodes.

The database items will be imported and appear in the Workbench for use.

For further information on Archives and backing-up databases, see the “Archives” section of this manual.
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Mac OS X - Upgrading to Version 5.3

Archiving Current Installations
To Archive a Database:

1.
2.

Run the existing Veripress Server and Serendipity Client.

Go to the Serendipity Client Application menu > Archives (This
application is called Archiver in earlier versions).

Select File menu > Perform Full Backup.

Alternatively, select Edit menu > Add to Archive (All) and add
all database items to the archive file, or right-click in the
Archives window and select Add to Archive (All) > Everything
from the contextual menu.

Once all database items have appeared in the Archives window,
select File menu > Save Archive to save the .sdb archive file to a
chosen location.

Close the Archives application when finished.

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:
1. Remove all SuperPro USB dongles.
2. Onthe DVD, navigate to the dongle/macosx folder.
3. Double click the Sentinel System Driver.pkg file to launch the installer.
4. Follow the onscreen instructions to complete the installation.
5. Restart the computer when finished.

Installing the Veripress Version 5.3 Upgrade

To upgrade:
1. Insertthe Veripress installation DVD and navigate to the macosx folder.
2. Run the Veripress.pkg file.
3. Select the drive and location to install the software. The installer will choose the current installation location
by default, which in most cases is /Applications/Serendipity.
4. Follow the onscreen instructions to complete the upgrade.
5. Plug the Veripress dongle into an available USB port.
6. Startthe Veripress v5.3 Server and the Serendipity Client.

If the installation location was not changed, the existing database should appear once the Server and Client have
restarted, reformatted and intact in the Workbench. The Client should open with the previous versions configuration.

If the installation location was changed, or in the event the existing database is not complete, the database backup
needs to be imported using the Archives application.

To import an existing database backup:

1.
2.
3.

6.

Open the Archives application from the Serendipity Client Application menu.

In Archives, select File menu > Open Archive.

Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives
window and display all database items from the previously backed-up configuration.

Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the entire
database.

Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected
Nodes.

The database items will be imported and appear in the Workbench for use.

For further information on Archives and backing-up databases, see the “Archives” section of this manual.
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Linux - Upgrading to Version 5.3

Archiving Current Installations
To Archive a Database:

1. Run the existing Veripress Server and Serendipity Client.

2. Go to the Serendipity Client Application menu > Archives (This
application is called Archiver in earlier versions).

3. Select File menu > Perform Full Backup.

4. Alternatively, select Edit menu > Add to Archive (All) and add
all database items to the archive file, or right-click in the
Archives window and select Add to Archive (All) > Everything
from the contextual menu.

5. Once all database items have appeared in the Archives window,
select File menu > Save Archive to save the .sdb archive file to a
chosen location.

6. Close the Archives application when finished.

Installing the Dongle Driver
The first step is to install the dongle driver.

1. Remove all SuperPro USB dongles.

2. Navigate to the dongle/linux folder on the installation DVD.
3. Double click the sntl-sud-7.5.1-0.i386.rpm file to install the driver.

Installing the Veripress Version 5.3 Upgrade

To upgrade:
1. Navigate to the linux folder on the installation DVD.
2. Double click the install.sh file and select “Run in Terminal”.
3. Aterminal window will popup and the installer will display the default installation directory.
4. Press Enter to install or type an alternative path then press Enter.

Note: If using an alternative install path, ensure the folder exists and that the current user has read/write/execute
permissions for the folder.

5. The terminal window will close when the installation is complete.
6. Plugthe Veripress dongle into an available USB port.
7. Start the Veripress v5.3 Server and the Serendipity Client.

If the installation location was not changed, the existing database should appear once the Server and Client have
restarted, reformatted and intact in the Workbench. The Client should open with the previous versions configuration.

If the installation location was changed, or in the event the existing database is not complete, the database backup
needs to be imported using the Archives application.

To import an existing database backup:

1. Open the Archives application from the Serendipity Client Application menu.

2. In Archives, select File menu > Open Archive.

3. Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives
window and display all database items from the previously backed-up configuration.

4. Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the entire
database.

5. Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected
Nodes.

6. The database items will be imported and appear in the Workbench for use.

For further information on Archives and backing-up databases, see the “Archives” section of this manual.
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Saving/Restoring the Veripress Database and ICC Profiles using the File System
An alternate method for backing up the existing database and ICC profiles is to copy the relevant file folders from
Veripress to another location before upgrading to version 5.3.

The database items are held in a folder called defaultss.dbd in the following locations:

Mac 0S X /Applications/Veripress/lib/defaultss.dbd/

Windows C:\Program Files\Veripress\lib\defaultss.dbd\ (For versions 3.5.09 and below)
C:\Serendipity\Veripress\lib\defaultss.dbd\ (For versions 4.0 and above)

Linux/Sun/SGI ~veripress\lib\defaultss.dbd\

The ICC Profiles are stored a folder called ICC in the following locations:

Mac 0S X /Applications/Veripress/lib/ICC/

Windows C:\Program Files\Veripress\lib\icc\ (For versions 3.5.09 and below)
C:\Serendipity\Veripress\lib\icc\ (For versions 4.0 and above)

Linux/Sun/SGI ~veripress\lib\ICC\

To restore the database and ICC profiles to an upgraded Veripress
1. First, ensure the Veripress Server and Serendipity Client are shutdown.
2. Copy and replace the backed-up defaultss.dbd and ICC folders into the relevant locations (see above) for your
install.
3. Start the Server and Client. All previous database items should now appear in the Workbench.

Important Note: Pagesetups imported from Version 3 archives will be automatically split into Media and Pagesetup
data types, but remain functionally linked. Version 5.3 archives cannot be opened or imported into previous versions of
Veripress.
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Running the Software

Once the software has been installed, launch the Server and Client to begin the configuration. The Server should be
started first and allowed to complete its initialisation process before the Client is launched. If the Client is started first,
it will attempt to connect to an active Server. If none are present, a Connect to Server window will open, waiting for an
active Server to appear on the network.

Important Note: For Mac OS X users only

The Veripress Server and Serendipity Client (for Mac OS X) are able to run in either 32-bit or 64-bit modes. Running
both in 64-bit mode is optimal for normal usage however, not all Spectrophotometer manufacturers have converted
their drivers to support 64-bit and will be unavailable for use in 64-bit mode.

New installations of the Server and Client are always in 32-bit mode by default.

Before starting the Server and Client
To switch the Server and Client from 32-bit to 64-bit mode:

1. Opena Finder window

2. Navigate to the Applications/Serendipity/Veripress folder.

3. Highlight the Serendipity Client application and select CMD+I or right-click and select Get Info from the
menu.

4. Tick the checkbox to disable Open in 32-bit mode

5. Repeat the above steps for the Veripress application.

Version: 5.3
Copyright: Copyright Serendipity Software Pty. Ltd.,

If the Open in 32-bit mode checkbox does not appear in the Get Info window it will 1964-3011
necessary to reset the Mac OS X Finder: tatel [x

™ Open in 32-bit mode
Locked

1. Opena Terminal window
2. Type or copy the following command into the screen and hit Enter (with no line breaks):

/System/Library/Frameworks/CoreServices.framework/Versions/A/Frameworks/LaunchServices.framework/Versio
ns/A/Support/Isregister -domain local -domain user -domain system -kill -r

3. The above command will make the Open in 32-bit mode option appear in the Get Info window.
4. Go to the Finder window, right-click, Get Info and disable this option for Veripress and the Serendipity Client.

Starting the Server

1. Plugthe dongle into an available USB port.
2. Launch the Server by double clicking the Veripress file in the installation directory, or the shortcut
desktop/dock icon.

The Server window will appear showing information about the Server software and the initialisation u\
process will commence.

Note: The Server will not initialise if a recognised dongle is not present on the computer from which it is run. If the
dongle is removed at any point while the Server is running, all job processing will cease and the Server will stop shortly
afterwards. Once the dongle is reconnected, close and restart the Server.
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Starting the Client
Once the Server has completed initialisation the Client application can be opened.

1. Launch the Client by double clicking the Serendipity Client file in the install directory, or the L '“
shortcut desktop/dock icon. Serendipity Client

The Client will connect to the active Server and display the default monitoring system - Jobs - on screen. From this
point, configuration of the system or loading a pre-configured setup can be done.

Choose Server Menu > Server Settings (Preferences).

Select the Colour Management tab.

Click on Change System Specials and select Reference-Lab (or your own specials) and click OK.
Click OK to dismiss the System Settings window and apply the changes.

Vi N

Manual Client Configuration

This section will explain how to setup a basic configuration in order to process and output a file for proofing and
monitor the job throughout the process. For detailed information on specific modules mentioned, see the relevant
sections of the user manual.

The default monitoring application - Jobs - opens with a factory standard layout, including the QueueManager,
Thumbnail and QueueStatus modules. System queues (Image, Render, Spool and AutoDetect) will be displayed in the
QueueManager.

There are four (4) sections that need configuring in order to process jobs. These are (in no particular order):

* ARIP where the jobs are polled;
* APagesetup and Media where jobs are processed; and
¢ An Output where the Serendipity Blackmagic Image or Remote Proof file is sent.

Note: Before a Pagesetup can be created first create a Media and an Output, as each Pagesetup must be linked to a valid
one of each.

To begin configuration:
1. Select Application menu > Workbench.

Output Configuration

2. Select Output from the data types list on the left and create a
new Output by selecting File menu > New. -

3. The Output name “Untitled” will appear in the items list,
highlighted for renaming. This is the name of the Output that
will appear in the Pagesetup. Rename and select the item.

4. Inthe Queue panel of the gray configuration area, select the
appropriate driver for use from the list of licensed drivers.

5. Inthe Destination panel, select a destination driver (i.e., the
connection method) for output of jobs and enter the
appropriate information, for example, a local folder destination.

6. Configure any collating or nesting requirements as needed. See
the Workbench > Output section of this manual for further
details on this option.

7. OPTIONAL - After a Media is created, it can be assigned to the —
Output via the Change Media button. See the Media section of
this manual for further information on Media functions.

8. Save the Output configuration when completed by selecting File menu > Save.
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Media Configuration
1. Select Media from the data types list on the left and createa |~ “= — e Z
new Media by selecting File menu > New. e
2. The name “Untitled” will appear in the item list, highlighted for
renaming. This is the name of the Media that will appear in the
Output and Pagesetup. Rename and select the item.
3. In the Output panel of the gray configuration area, select the
appropriate driver from the dropdown list of licensed drivers.
This should be the same driver as was selected in the Output
configuration (Serendipity Blackmagic Image or Serendipity
Remote Proof).
4. Configure the resolution, colourspace and any custom settings
required.
Set the Output ICC profile to your Press ICC profile.
6. Save the Media configuration when complete by selecting File
menu > Save.

v

Note: This Media configuration is the minimal setup required to get your proofing workflow functioning. For proofing
work, the Media will need to be correctly calibrated. For a complete HowTo guide for configuring a calibrated
Pagesetup/Media/Output, refer to the Support section of the Serendipity Software website.

Pagesetup Configuration
1. Select Pagesetup from the data types list and create a new Pagesetup by selecting File menu > New.
2. The name “Untitled” will appear in the item list, highlighted for renaming.
3. Rename and press Enter. Select the item.

4. Assign the Output created earlier to the Pagesetup via the
Change Media button. Select the Media in the popup window
that appears and click OK. Jobs will be processed using this
Media unless another is selected when submitting a job.

5. Apply any Colour Correction curves if required by selecting the
appropriate curve button in the Colour Correction panel. See the
Workbench > Pagesetup section of this manual for further
details.

6. Select the input ICC profiles for RGB and Press
(CMYK/Multicolour) respectively by clicking the RGB ICC Profile
and Choose ICC Profile buttons in the ICC Profiles panel.

7. Use the dropdown menus below each ICC profile to select the
Rendering Intent to be used for each assigned ICC profile.

Note: Veripress’ colour management system will match the proofer output to these assigned profiles once the Media
has been correctly calibrated, press (correction) curves have been assigned and the Always Use ICC option in the ICC
Profiles panel has been ticked. At this stage however, the assigned ICC profiles serve to inform the colour management
system which colourspace to use when processing jobs.

8. Configure any other sheet, effects, margins etc, as required in the other panels of the Pagesetup. See the
Workbench > Pagesetup section of this manual for further details on the options available.
9. Save the Pagesetup configuration when complete by selecting File menu > Save.
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RIP Configuration

If your Veripress install requires proofing RIP data, a RIP setup will need to be configured to poll the RIP jobs for

processing.

1. Select RIP from the data types list in the Workbench and create a new

RIP by selecting File menu > New.
2. A warning message will appear. Dismiss the message.

3. The RIP name “Untitled” will appear in the item list, highlighted for

renaming. Rename and select the item.

4. In the Driver panel of the gray configuration area, select the appropriate
RIP driver for the CTP RIP input from the dropdown list of licensed

drivers.

5. Configure the RIP driver options by enabling checkbox options and/or

choosing Custom Settings by clicking the Edit button.

6. Tick the Enable Polling checkbox in the Polling panel and enter a poll interval time, for example, 2 minutes.

Note: Some RIP drivers and polling methods require the use of a Job Genie in order for the Veripress RIP setup to
recognise incoming RIPped files. See the Workbench > Job Genie section of this manual for further details. Also, refer to
the Support section of the Serendipity Software website for tutorials on creating your own customised Job Genies.

7. Choose the method the RIP setup will use to connect to the RIP output folder from the dropdown menu in the
Polling panel, for example, Localhost. Enter any Hostname/IP details if required.
8. Enter the file path to the RIP folder in the Paths panel. To enter a path, click the New button below the panel.
Click Browse on the popup window and navigate to the RIP folder to be polled. Click OK to save the path.

9. Ifrequired, setup Stripe Paths.

10. Click the Test button at the bottom of the Testing panel to Save and Test the RIP setup. The Testing panel will
show a Polling OK result to confirm the RIP path is valid. Alternate messages will notify you if the RIP path is

invalid, or if no RIPped files currently exist in the selected folder.

This completes the basic configuration of Veripress. For information on how to see polled RIP jobs and submit them for

proofing, see the Modules > RIP Monitor and Serendipity Client Menu Items > Submit Menu sections of this manual.

Monitoring Jobs - Configuration

Once the base configuration is complete for the Media, Output, Pagesetup and (optional) RIP, a monitoring application

needs to be configured so jobs can be managed throughout the system.

There are two (2) types available - the Jobs (default)or the Monitor application.

Jobs
This is the default application, launched when the Client is started for the
first time.

The Jobs application has a pre-configured set of tabs available for
monitoring various processing throughout the entire workflow. The
default tab layout includes the QueueManager, Thumbnail and
QueueStatus modules. See the “Jobs” application section within this manual
for further information.

Any Outputs created in the earlier configuration will automatically appear
in the QueueManager module.

Non-interactive
DemoOny,,,,  (ew,

Serendipity Software - Veripress User Manual - Version 5.3



The RIP Monitor will need to be added as a tab in order to poll jobs:

In the Jobs application, select the Tabs menu > Add Tabs option.

A window will appear with various factory default layouts available for use in the Jobs application.

Select the RIP Monitor tab layout from the list. An example screen will appear to the right.

Click Add. The RIP Monitor tab will appear in the Jobs window.

Available RIP queues can be polled by selecting them from the dropdown list and clicking the Poll button three
(3) times consecutively.

6. Jobs appearing may now be submitted for processing.

Vi W=

Additional pre-configured Tabs may be added to the Jobs application as required. See the “Jobs” application section of
this manual for further information.

Monitor

The Monitor performs the same workflow monitoring functions as the Jobs application and was the default application
for this purpose in previous versions of Veripress, before the Jobs application was introduced. Monitor allows the user
to customise the size and layout of tabs and job management modules.

1. Select Application menu > Monitor to open a Monitor window. The &=
default view will include a Queues tab and a Logs tab. -
a. The Queues tab contains the QueueManager, Thumbnail | == ==
and QueueStatus modules.
b. The Logs tab contains the ClientLog and ServerLog
modules.

If you would prefer to have any new output queues automatically added to
the QueueManager for future use, enable the Auto Queue Order checkbox
via the Toolbar (spanner icon).

A RIP Monitor tab will need to be added to the Monitor in order to poll jobs:

1. Select Tab menu > New Tab to create a new tab for the RIP Monitor.

2. Rename the tab to RIP Queues or similar to differentiate it from the other
tabs.

3. Select Layout > Add RIPMonitor. A module window will appear for the
RIPMonitor.

4. The window may be resized and positioned by selecting Layout > Edit.

Select the window corner and resize it by dragging the mouse. Select

Layout > Use when done.

Click the spanner icon to expand the Toolbar.

6. If no jobs appear in the RIP Queue, click the Poll button three (3) times
consecutively.

7. Jobs appearing may now be submitted for processing.

v

Additional Tabs and Modules may be added to the Monitor as required. See the Monitor section of this manual for
further information.
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The Veripress Server

The Veripress Server runs on the machine where the dongle is installed. The Server handles the processing of all jobs

through the system and must be started before the Client is launched.

As the Server starts, it checks to ensure a valid dongle is installed on the machine and which modules are enabled
(licensed). The Server calculates the speed of the machine it is running on and checks the integrity of the database

before loading it.

Once the Server is up and running, a clock keeps track of the
duration the Server is operational.

Server Options
The window below displays the Server information and various
options once it is running.

Veripress Menu Options
¢ About - Shows information about the Server. Clicking
More/Less Info shows or hides valid dongle options,
including the versions of the current drivers.
*  Quit - Quit the Server application.

File Menu Options

Y. Tveripress
v U

Veripress version 5.3 (Build 25408) 32 bit
Copyright Serendipity Software Pty Ltd 1994 - 2012 All rights
reserved
Built: Oct 28 2011 16:39:38
NFR (not for resale) dongle detected
Dongle serial no: 4c367e57 0ad0

Listening for client connections on port 9100

Uptime: 00:00:01 ( Stop server ) Speed: 662.42

* Stop Server - Stops the Server from running without quitting Veripress.

¢ Start Server - Starts the Server if it is in a stopped state.
* Restart Server - Restarts the Server.

* Update Dongle - Allows users/administrators to update the dongle with activation codes to enable various
input/output licenses or software versions. See the Dongle Updater section for further information.
* C(lose - Closes the window. If the Server is running you are warned and asked to confirm Server shutdown.

Startup Options

¢ Start Server on Launch - The Server will start once the application is launched.
* Restart Server on Crash - Restarts the Server automatically after a crash.

¢ Start as Cluster Node - Starts the Server as a Cluster Node to be used by another Veripress Server for imaging

and rendering tasks.

Important: Do not use this option before reading further information in the Applications > Clustering section
of this manual.

Start in Safe Mode - This option starts the Server but ceases all job processing and RIP polling tasks. Safe Mode
is used for maintenance in the event a RIP queue, Pagesetup or other database item is corrupted, or is
functioning incorrectly. Once maintenance is complete, the Server will need to be restarted in normal mode.

Help Menu

Update Options - Configure a time for Veripress to periodically check for software updates.
Check for Updates - Choose this to immediately check for any software updates.

For further information on the automatic software update functions, see the Serendipity Updater section of this

manual.
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The Serendipity Updater

The Serendipity Updater provides a simple and convenient way of updating Veripress and standalone Serendipity
Clients.

[ YeNe) Software Update
The Updater tracks your current software installation status and
. . . There are software updates available for Serendipity
automatically checks for available software updates, bug fixes, A Blackmagic version 5.2.
maintenance patches and new drivers. ‘A’ Configured to update product installed in
- /Applications /Serendipity/bmagic

Select the items you want, then click install.

New updates are listed along with release notes, previously installed
updates are logged in the Updater, and notes can be viewed at any time. PR = )| Lpdate

Install Name A | version Date Posted size

]

. X N Calcheck update 1.0 25/01/11 8.15MB
Note: The Serendipity Updater requires access to the internet to

function. Updates are not downloaded or installed until initiated by the
user, as the Server and/or Client are shutdown as part of the update
process.

The following update functions are available in the Help menu of the Fixes a problem that can occur with CMYK calcheck charts caused by CMYK

chart patch values not being converted and saved with corresponding Lab

Veripress Server application and/or the Help menu of the standalone values. The result was extremely large AE values when measuring the

Calcheck chart due to L*a*b reference values registering as 0,0,0 in the

Sel‘endlplty Cllent' Calcheck application.
IMPORTANT INSTALLATION NOTE
° U date O t _ C f : f V : : d : ll To apply the fix to existing CMYK Calcheck Charts:-
p ptions - Configure a time for Veripress to periodically
- select the chart(s) in the Workbench 2
Check for SOftWare updates = click the Press ICC Profile button and choose a ICC orofile different to ¥
o Never - The software will not check for updates. nothom))

o When (Time/Day) - Configure a time and day to
automatically check for any software updates.
= Notify when updates are available - A message will appear onscreen when updates are
available to install.
*  Check for Updates - Choose this to immediately check for any software updates.

When configuring a time/day for checking for updates via the standalone Client Help menu, a restart of the Server is
required for any changes to take effect.

Note: The Serendipity Client installed on the Veripress Server machine is updated as part of Server updates and does
not gain access to the “Check for Updates” Help menu option. If Secure Mode is active, users can be configured to
receive an email when software updates are available. See the Accounts Admin section of this manual for further
information on email configuration.

800 Software Update 8006 Software Update
Check for Updates Check for Updates
When: [Every 18] 1 %) (Day ] When: | Never 4]
at 1200AM [ at 12:00 AM
# Notify when updates are available ™ Notify when updates are available
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The Veripress Dongle Updater

The Veripress dongle licenses the level (version) of software and enables the use of any input filters (RIPs) that have
been purchased. If any additional licenses are activated, the relevant dongle will require updating with the new codes in

order to access them. e T
The Dongle Updater is a built-in feature, accessed via the Server File Menu > Key Code 1 | B
Update Dongle option. Key Code 2

To avoid any abuse of the software, the dongle activation codes can only be
used once. Any updating should be completed by your relevant Server
administrator.

Important Note: Before updating any dongles, please ensure your Server is
in Stop mode.

Close

Updating the Dongle
Before updating the dongle, an email must have been received with the new codes. This will either be sent from
Serendipity Software directly, or via a Dealer of the product.

Two (2) codes are required for entry in order to update the dongle, referred to as Key Code 1 and Key Code 2.

The codes are located in the “Dongle reprogram string” field in the email and are separated by a space.

The first, long string is Key Code 1. The second, shorter string is Key Code 2.

To update the dongle:

1.
2.

Plug the current USB dongle into the computer and run the Server application.

Select the Server File menu > Update Dongle. The Server will stop. If there are any Clients open, a Connect to
Server window and/or disconnection message may appear.

A window will open for the Dongle Updater.

Enter Key Codes 1 and 2 into the relevant fields. It is best practice to copy and paste the codes to avoid any
keying errors. DO NOT copy the space between the codes.

Once the codes have been entered correctly, the Update Dongle button will enable. Click it.

A confirmation message will appear after the dongle has been successfully updated and a Server restart is
required.

Quit the Server application and restart. The dongle is now updated and any new filters or drivers will appear in
the Client for use.
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The Serendipity Client

The Serendipity Client is a graphic user interface (GUI) used for configuration, maintenance and monitoring of the
Veripress Server.

The Client can be installed and run locally on the same machine, or from any supported computer on the network using
TCP/IP protocol. There is no limit to the number of Clients that can be connected to the Server, and each Client will
have its own settings, specific to the user.

Once installed, the Client connects to a Veripress Server. Any Client can access the job management information and
view the current status. The configuration can be open to all users or protected via Secure Mode, which allocates
specific access for created users and user groups. For more information on how to setup access see the Secure Mode
section of the manual.

Look and Feel

There is a common theme and functionality to the Client. There are many ways to complete the same task, such as
configuring a Pagesetup from the QueueManager. Various options are available using the right mouse click to bring up
other contextual menus. This will vary depending upon the section of the Client interface being used.

Anywhere there is a chooser to select an item from the database, a search field will be indicated by a magnifying glass.
Entering text in the search fields filters the list, showing only the matching items. ) =)
The search can be inverted with CMD+SHIFT+I (Mac) or CTRL+SHIFT+I (Win) to - -
hide the matching items. The search box will turn black to indicate inverse A
searching. Pressing ESC will dismiss the search.

Search

There are two (2) main sections to the Client - The Workbench and the Jobs application.

* The Workbench is used to configure the various parts of the Server. This is used to create queues, setup input
paths and various calibration functions.
* Jobs (an application) is used for managing and viewing jobs as they pass through the system.

The Applications and Modules add functionality and provide tools for managing the Server and the jobs passing
through it. There are also various menu options containing system utilities and preferences.

Workbench

The Workbench is where the main software configuration takes place. RIPs, Medias, Pagesetups, Output paths, Colour
Sets and Colour Correction Curves can all be setup here.

When items are created or changed in the Workbench they are saved to
a database read by the Server each time at startup. The database can be
backed-up and copied to other (Version 5.3) Servers.

The Workbench is a split window. The Data Types list the database item
categories that can be selected for creation or editing. The items list
show the available database items within each Data Type. The gray area
shows the settings and options for each item.

The Data Types section has two (2) views - Browse & Search.

Browse allows the user to view and select any of the database items for display. The tab containing the magnifying glass
flips to a Search window, which acts like a filter, showing any items containing the search text.

e 00 Workbench - adn|
Browse & I Items. A Type Modified
% serendipity specials Special Colour Set  5/03/09 11:29 AM
Find items containing serendipity tiff output RIP 5/03/09 11:29 AM
_ % serendipity tiff separated Job Genie 23/10/08 5:04 PM
seren
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Menu Options

Applicat

Submit

File

Edit

Modules

Server

ion

Access all available Applications via this menu. Each application will open in its own separate window.

System Settings (Windows OS) - Access the System Settings (Preferences) for the Serendipity Client. This
option is available under the Serendipity Client menu for Mac OS X users.

Quit (Windows 0S) - Quits the Serendipity Client application. This option is available under the Serendipity
Client menu for Mac OS X users.

Files — Select files to send to a Media and Pagesetup for processing.

Files for Deimposition - Submit files directly for de-imposition, assigning the files to one or more imposition
signatures.

Files As Imposition - Submit files directly as an imposition, assigning the files to one or more imposition
signatures. This option is only available for Veripress/Blackmagic Softproofing Add-On and allows jobs to be
de-imposed on the fly (see Touch Console for details).

ICC Target - Submit an ICC Target to a selected Media and Pagesetup.

ICC Target without Colour correction - Submit an ICC Target to a selected Media and Pagesetup. All ICC options
and colour correction curves are disabled.

Test Prints - Select one or more Media and Pagesetups to send internal test prints for processing.

New - Create a new item in the database.

Save - Save changes to the database.

Duplicate - Make a copy of the currently selected item.

Revert - Reload the last saved version of the currently selected item.

Delete - Delete the currently selected item.

Print - Print the details of the currently selected item.

Get Info - Displays a popup window with two panels - General & Ownership. General displays the type, created
and modified dates for the selected item. Ownership displays the User and User Group permissions for the
item.

Show Orphans - Shows any item currently in the database not being used by a Pagesetup or RIP.

Add to Archive - Add the selected items into a new Archive window. See the Archives section for further
information.

Export as C5 Pack - Allows users to export Media files from the Workbench to a specified location for use with
the C5 application (Generally used with Blackmagic & Megarip products).

Export / Import Folders - Allows users to export or import the folder structure used within the workbench. It
will not import or export the contents.

Undo - Undo the last change. There are multiple undo options and this is configured via the Client Settings
section.

Redo - Redo the last undone change. There are multiple redo options, depending on the undo status and
configuration in the Client Settings.

Find - Opens a text box at the bottom of the Workbench panel to locate the search text on the screen.

Split Vertical/Horizontal — Changes the view to either Vertical or Horizontal split on the screen.

Show Type Column - Used in conjunction with Show Usage to display the type of data listed.

Show Modified Time Column - Displays the last modified time for the items listed.

Show Usage - Displays the items within the database the currently selected item uses, e.g., a selected Pagesetup
would show the Media and Output it currently uses.

Reverse Usage — Reverses the usage shown above. (Was called Show Referrers previously).

Organise Data Types — When enabled, this option will organise the Data Types in the Workbench list into
related categories. This is the default view.

Access all available Modules via this menu. A floating window will open for each separate module opened.

Server Settings - Access the System Settings or Preferences for the Veripress Server.
Connect to Server — Select a Veripress Server to connect to on the available network.
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* Resume/Pause Processing - Allows users to pause or resume all job processing and Output queues. Queues
will pause after completion of the current task.

* Accounts Admin - Allows an authorised administrator to create, modify and manage user accounts and groups.

¢ Chatterbox - Chat to other users connected to the same Server with this option. The Chatterbox window will
display the Client’s connected to the Server. A nickname may be entered in the Client Settings, otherwise the
machine name is used. If the user’s name cannot be selected, the user has selected the Away option and is not
available.

* Broadcast Message - This allows messages to be sent to all users connected with a Client to the same Server.
Selecting the Broadcast option displays a message window to type into and send. The message is displayed on
the users window for a short time and will automatically dismiss if it is not acknowledged by clicking OK.

* Download PPD - Download the Megarip PPD from the Server to the desired location. This saves having to get
the PPD from the disk. Use the PPD when installing a local printer. When installed, the Megarip PPD (Postscript
Printer Description) is selected as the printer driver when setting up a Published Pagesetup as a print (output)
destination for third party applications.

Window
* Bring All to Front - Shows any open window of the Client and can be selected to bring it to the front.
¢ Cycle Through Windows (CMD+" or CTRL+") - Cycles through the open windows within the Client.

Help
* Server Info - Provides information about the Server, including version, platform, speed, processors, hostname,
IP, product and vendor.
*  What's This - Select this and click on any part of the interface to display a short help description.

Contextual Menu (Right Click)
In addition to selected File menu options listed above, the following options are available via the contextual (right-
click) menu:

* New Folder - Folders are a great way to organise the data types list items. Folders are Client based, meaning
each user can have their own folders if desired.

* New Folder with Selection - Places any selected items into a new folder.

* Remove Folder - Removes the selected folder, placing items within the folder back in to the general item list.

* Open/Close Selected Folders - Expand or collapse the selected folders to show or hide the items within.

Note: Folders in the items list are internal to the Serendipity Client, used to organise database items. They are not
operating system file folders.
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Workbench Data Types

There are sixteen (16) data types (databases) within the Workbench that can be used and configured to accurately
process jobs. Each will be explained in detail. The data types are:

* Bookfilter - Allows for the polling and mapping of planning files for softproofing large multi-section or multi-
edition jobs. This is a standard feature for Veripress and available as a Softproofing Add-on for Blackmagic.

* (Calcheck Chart - Used to provide a validation check for a hardcopy proof or a monitor.

* (Camera - Setup a camera ICC profile for use with the SoftProof application when viewing RGB images.

* DotGain Curve - Used to compensate for or represent dot gain on the final output.

* (Gradation Curve - Used to adjust colour in a job by applying a curve to the individual process colours.

* [CC Tweak Set — Build up a library of colours that need “tweaking” for accurate output.

* Job Genie - A programmable file search filter used by some RIP input filters for polling and stitching together
jobs and publications.

* Media - Used to control configuration settings for Output, Colour Correction, ICC profiles and Output
Screening.

* Output - Determines where processed jobs are to be output.

* Pagesetup - Consists of modules to be configured to process and manipulate jobs for the desired output.

* Press - Contains the colour and dotgain attributes of a press. Used by the SoftProof application to show the
effects of printing a job on a particular press.

* Regular Expression - Used in conjunction with the RIPs for autoproofing jobs based on matching particular
rule sets.

* Replace Colour Set - Used to match and replace certain colours as they pass through the system.

¢ RIP - Configure a polling path and auto proof settings for RIP data proofing.

* Signature Group - Create or import signatures for de-imposition.

¢ Special Colour Set - Used to identify and match colours when jobs are polled and processed.

Data Types - User Interface and Context Menu
The Bookfilter, Media, Output, Pagesetup, Pagesetup Pools, Press, RIP and Signature Data Types have multiple
configuration panels or sections governing the different functions they control.

These data types have a row of buttons or tiles across the top of their configuration panels allowing the user to
instantly jump to the section named. If any of the panels are not required, they can be hidden by using the “X” in the top
right corner of each. To show any hidden panels, click on the panel name in the row and it will appear. Shift+click will
hide them again.

Publish Colour Correction ICC Profiles ColourKeys Input Screening

A contextual (right-click) menu is accessible in any of these individual sections, allowing the user to access the Find
function, Jump to another section, or change the background colour of the panel for easy identification.
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Bookfilter

The Bookfilter is used to setup an appropriate driver to read planning files to put finished publications

together, greatly improving the speed, efficiency and automation of softproofing in publishing press environments.

Bookfilter works similarly to a Job Genie based RIP queue in Veripress, but rather
than polling for RIP jobs, it polls for publication planning files. Publications in the
planning files are then displayed in the BookMonitor and may be selected for
softproofing.

Publications displayed in the BookMonitor can be expanded to show a list of
pages and filenames associated with each page as defined by the planning file.
The Bookfilter maps the page filenames to processed jobs in the QueueManager.

When the publication is selected for softproofing, the Bookfilter searches the
QueueManager for matching jobnames and collects them into a single

Book Driver: [ EAE P4 pagelist ]

Polling

# Enable Polling @ Language Encoding | Default B

poll menat: 10001 3

2m [ :o0s

[ Fast Polling ¥ Log Statistics

* JobCenie... )

Aac

Apply To: ™ Public:

publication. Any missing pages will appear as red in the page navigator.

Configuration Options

Driver

Polling

Paths

O Highest

ppppp
Jraid0/RIPdata/newspapers hans-mu.

Book Driver - Select the appropriate driver for the planning file format
used.

New ) (Delete Delete All

Enable polling - Enable or disable the polling of planning files.
Language Encoding - Set the encoding to match your system to display filenames correctly.
Poll Interval - Configure how frequently to poll the files. Setting the Poll Interval too short can flood the
network with polling requests (packets) causing it to slow down. Setting it too long can take a long time to
show stable files ready for submission.
Fast Polling - This will automatically poll two (2) more times as soon as one (1) automatic poll has completed.
It will not wait for the next scheduled Poll Interval before it polls again.
Log Statistics - Log the polling statistics in the Server log. The log message reports “Started automatic poll on
<date>" when polling starts and “Completed automatic poll on <date>" when finished.
Job Genie - Select a Job Genie to apply if required. A Job Genie may be used optionally to remap the Publication
and/or Jobnames in the polled planning file.
Connection - Specify the method used for polling. The options are:
o Agent - The Serendipity Agent is installed on the RIP where the files are located. This is used for
polling and submission of the files into Veripress.
o Hostname/IP - Enter the hostname or IP address of the computer where the files are located and
where the Agent is running.
o Localhost - This is used when the files appear locally to Veripress. This can be on its own disk or via a
mounted volume through NFS or mapped drive with NetBIOS.
o FTP - Uses File Transfer Protocol (FTP) to poll and transfer the files to Veripress.
o Secure FTP (SFTP) - Uses Secure File Transfer Protocol to poll and transfer the files to Veripress.
File Transfer Priority - Specify the priority to be used for transferring files to Veripress. Adjust from Lowest to
Highest or anywhere in between.

Specify the paths to the files residing on the RIP. The options available are:

Testing

New - Adds a new path to the Paths field. Selecting this displays another window to type the path or browse to
locate the folder containing the jobs. Browse will only work if the connection method has been specified and is
valid.

Delete - Deletes the selected paths.

Delete All - Deletes all paths from the list.

Once the configuration is complete, test the parameters are correct. The configuration must be saved before a test can
be done. If it is not saved, a prompt will appear to save and test. A test poll checks the connection, path validity and job
presence. Messages appear in the window to alert you to any problems or give confirmation of a valid configuration.
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Calcheck Chart

The Calcheck Chart data type is where charts are configured and stored for use in colour validation checks.
The charts are comprised of user-created or imported colour patches, along with target standards and tolerances.
These items are saved to the database and can be used and/or adjusted at any time. The Calcheck Chart is then assigned
to a Press and used in conjunction with the Displays
application to provide a validation check for a softproofing
monitor.

orginal Modified

Once the chart is setup, it normally requires no further
changes; the standards to be used are saved with the chart.

The window shows a list of the patches on the right and
colour information on the left. For each patch selected its Lab
values, delta tolerance and patch type can be adjusted. The
overall target preferences are specified in the lower half of
the left panel.

Toolbar Options

* New Colour - Create a new colour in the list with
default* values. Values and colour names can be adjusted as desired.

¢ Delete Colours - Deletes the selected colours from the list.

* Duplicate Colours - Makes copies of the selected colours. Use shift or control keys for multi-selection.

* Rename Colours - Pops up a renaming window, allowing for name changes on one or more colours
simultaneously.

¢ Import Patches from Files* - Import a patch set from a colour data file, such as those of colour standards or ICC
profile makers.

* Reorder Patches - Reorder the patches. Selecting this will display another window to select one or more
colours and drag them into a new order. Use the up and down arrow keys and shift or control to multi-select.

* Generate Patches from ICC - Select an ICC profile from which to create a set of patches. Selecting this option
displays a file chooser to select an ICC profile. A prompt will appear for the number of patches to generate. The
minimum number is 16 and maximum is 512.

* Add Colours From Library - Add colours to the currently selected Calcheck Chart from a Special Colour Set.

*Note: When creating or importing new colours, they are stored with the default tolerance settings. This is user
configurable and should be set before the patch set is created.

Patch Definition

On the left are a series of controls used to define each patch. Selecting a patch from the list
will load the colour into the colour match box at the top and load the Lab/CMYK values into
the respective fields. To change the value, simply type the new number into the relevant

L 78.88

a -2.63

field. b [33.13
e Lab (or CMYK) - The Lab (or CMYK) value for the selected colour. i
. AH Tolerance 2.50
* Aetolerance - Set the maximum Ae value for the selected colour. J =
* AH tolerance - Set the maximum AH value for the selected colour. Patch Type fommioell

¢ ACtolerance - Set the maximum AC value for the selected colour.
* Patch Type - Identify important patch types from the set. The options are:
o Paper - Select the patch that represents the paper being checked.
o Cyan/Magenta/Yellow/Black - Identify a patch for each colour from your set.
o Gray - Used to identify gray patches in the chart.
o Generic — Most patches are generic and are classified as generic if they don’t fall into one of the above

types.

Note: When generating patches from an ICC profile, the patches are automatically assigned the correct type.
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Target Standards
There are three (3) standards that can be used to compare against a proof.

‘Ae AH AC

These are Ae, AH and AC.

The first standard Ae is always enabled. The other two standards must be enabled for the results to appear on the
Calcheck. To enable, select the tab and tick the Target checkbox.

For each standard, specify the limits used for a pass and fail status. For Ae, also choose which of the Ae standards are to
be used - deltaE, CIE94 or CIE2000. Note: A Ae standard of CIE2000 is generally recommended when validating
monitors.

Important Note: The correct standard to be tested must be selected and saved with the chart. Only that standard will
be tested for a pass or fail. If you want to check another standard, change it here and save it again. For example, if you
are checking deltaE and you want CIE2000, you will need to change it, save and re-measure.

The limits are:

* Average - For all the patches in the chart that will be measured by Calcheck, the average must be below this
value for a pass.

* Maximum - This is the default value used when creating or importing patches. This value is only used for
assigning maximum tolerance for the import. When the target is measured, the tolerance set per patch is the
one used to determine a pass or fail status.

¢ Standard (Std) Deviation - The standard deviation across all the patches must not exceed this value.

The Calcheck will only report a pass if all of the measured patches in the target chart are within tolerance.

¢ Patches Per Strip - Specify how many patches are printed per line, allowing the use of existing target standards
such as the Fogra Media Wedge.

Spectrophotometer
Use one of the supported online instruments to measure colours directly into the Calcheck Chart.

To measure colours:

1. Select an instrument from the dropdown menu and click on Activate. The device must be connected and turned
on.

2. Follow the on-screen instructions, as some devices require calibration before measuring.

When complete, click the Turn Off button.

4. If the Lab text option is chosen, you will be prompted to choose a file to import. The format must be Lab values,
space or tab delimited and no header information.

w

Note: If importing characterisation data from one of the ICC profile packages or colour standards, use the Import
Patches From Files option.

Patches

This section of the Calcheck Chart window displays the patches in the [o.— ... .

. . I 01 56.97, -22.34, -27.03 3.00 250 4.00

set. Each patch shows its respective colour, name and Lab values. |E===« acsnanm 20

There is also a patch type and the tolerances for each standard. The o s oramoem 60 250 00

. . I s 53.22,44.38,-0.48  3.00 2.50 4.00

tolerances are assigned when the patches are created or imported and |E===»  soxaae o oo

are based on the settings on the left. % w6  aoo

11 81.68, -0.01, 3.00 6.00 2.50 4.00

12 77.73,-3.08,47.98  3.00 2.50 4.00

A tolerance setting can be altered by selecting the colour and entering a new value in the relevant box.

— The Chart type can be altered via the dropdown menu above the patches and
Chart type | Lab 3 ' a Press ICC Profile will appear if allocated. The Press ICC Profile button only
becomes available for CMYK chart types.

Search

Above the patches list is a search box. Enter a string to filter out any patches not required and locate those that are. All
fields within the panel are searched. The search can be inverted using CMD+SHIFT+I (Mac) or CTRL+SHIFT+I (Win).
The box will appear black when the inverted search is enabled.
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( Camera
' The Camera data type is used to define an RGB (or Camera) ICC profile colourspace for use when viewing RGB
images in the SoftProof application. Users can configure whether the default Camera profile or image embedded ICC
profile is automatically selected and applied to an RGB image when opened in SoftProof. See Applications > SoftProof >
SoftProof Settings for further details.

Colour Management

Colour Management

("4 Camera ICC Profile .. ) None

Colour Management Renderng et elive G
¢ Camera ICC Profile - Select the ICC profile to assign.
* Rendering Intent - Select the rendering intent to be used.
¢ Black Point Compensation - Enable/Disable Black Point
Compensation.
¢ Calcheck Chart - Assign a Calcheck Chart for Camera colour verification checks using the Displays application.

e
Calcheck Chart None

DotGain Curve
A DotGain Curve can be used to compensate for or represent dot gain on the final output. In this section,
curves can be created for application to a Pagesetup in order to change the output.

The curve may be applied for two (2) reasons:

¢ After the initial calibration you may find that the resultant output is either slightly
too dark or slightly too light. A DotGain Curve can be applied to the process or
specials (or both) to make the print lighter or darker; or

* Torepresenta press or printing process dot gain on the proof.

Toolbar Options

* Trace Saved Curve - A green line appears, showing where the curve was last saved
to see where the curve has been edited.

* Invert Curve - Invert the selected curve. An inverted curve can be used to compensate for the colour
characterisation or platesetter dotgain curves output by a platesetter RIP, returning jobs to a linear state for
proofing.

* Dotgain Table - Enter values manually to adjust or create a curve.

¢ Import from CSV - Import values from a CSV file. The file must contain exactly 23 values for each colour as
defined in the Dotgain table editor.

Note: The Process and Special DotGain curves only apply to CMYK input jobs. RGB jobs will not be affected.

A Gradation Curve

A Gradation Curve is used to adjust colour in a job by applying a curve to the individual process colours. The
Gradation Curve can be applied to a Media either as a Linearisation Curve or
as a Correction Curve. A Linearisation Curve is normally applied as part of the
early calibration stage and this is recommended. A Correction Curve is applied
if a small amount of fine-tuning is required after normal calibration
procedures.

Toolbar Options

* Trace Saved Curve - A green line appears, showing where the curve
was last saved to see where the curve has been edited.

¢ Invert Curve - Inverts the selected curve.

* Gradation Table - Enter values manually to adjust or create a curve.

* Preview Curves - Displays a window with all curves in their respective colours to assess them in relation to
each other. This is updated dynamically as changes are made.

* Lineariser - Loads a Linearisation Curve directly into the Lineariser application.
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‘ ICC Tweak Set
Build up a library of colours that need “tweaking” (adjusting) for accurate output with the ICC Tweak Set data
type. A tweak set alters colours during the ICC mapping stage from input to output profile and is selected on a
per Media basis.

The ICC profiles are not edited in any way and the tweak set can be selected as desired. Each colour requiring alteration
is selected and adjusted by adding to or subtracting process colours from it, or making it lighter or darker. An accurate
visual representation is shown on the screen and the point in the colourspace can also be viewed. Colours can be
created manually or by entering the CMYK or Lab values, or input automatically using an online Spectrophotometer.

The interface is split into two parts - the left side shows the input values and the right side shows where any
adjustments (tweaks) have been made.

Options

* Colourspace - Choose between Input Profile or Lab input. If the profile selected is RGB, the sliders will change
to RGB. If CMYK, the sliders will change accordingly.

* Influence - Choose the area around the specified colours to be affected. This is determined as a scale of 1 to 5,
with 1 being the least influence and 5 the greatest.

* Tweak Value - Use the CMY sliders to add or subtract from the colour being adjusted.

* Rendering Intent — Choose the rendering intent that the colour is to be altered in from either Perceptual,
Colourimetric or Saturation. This must match the rendering intent of the Pagesetup for the mapping to work.

* New Tweak - Create a new tweak in the rendering intent selected.

* Copy - Available via the right click menu. Used to copy the selected tweaks.

* Paste - Available via the right click menu once an item has been copied. Used to paste the copied tweak from
the clipboard to the rendering intent selected.

* Change White Point - Change the white point of the paper. Select the button and enter the X,Y,Z points. If a
Spectrophotometer is connected, the white point can be measured directly into the system.

¢ Zoom - Zoom in and out of the Lab colourspace to see the point you are tweaking in relation to the whole
space.

¢ L-value - Move up and down the L-value to see the point you are tweaking in relation to the lightness. Reset the
value by clicking the ReCentre button.

* [ICC Profiles - Choose the input and output profiles you are using to tweak. These must match the ones selected
in the Media, as they are stored with the tweak set and are used during the mapping process.

* Spectrophotometer - Choose an online Spectrophotometer to read values directly into the tweak set. Once
selected, press the Activate button to connect and take measurements. If the device is being used by another
application (including a Serendipity application), it will fail to connect. Quit or disconnect all others first.

Original Tweaked

Tweak Point Adjustments.

Colourspace | Input Profile 2] Influence © 1-5 5 @
- o 100 [ Cyan Red o [
M 0 8] Magenta Oy Green 29 [
% © 100 [} Yellow Bue o [
K © o [ Darker Lighter -30 [3)

(“Perceptual | Colori Lab Slce View

NN

Zoom ©

New Tweak

L-value ("ReCentre )
Change White Point...
ICC Profiles
("4 Choose Input Profile... ) match/NewSample_Press_K2.icc
("4 Choose Output Profile... ) printers/PX9500_0714.icc
Spectrophotometer (offline)
['CGATS / 150 12642 file %) (Activate )
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Job Genie

Plate separated, single-bit screen TIFFs have become predominant in print industry workflows. The TIFF

Based (Generic) input filter is designed to poll jobs from RIPs that produce 1-bit TIFF files; one file for each
process or spot colour plate of a particular job.

While the TIFF Based (Generic) input filter has a limited intelligence and can recognise standard filenames, such as
Jjobname_plate.tif, it will not understand or be able to correctly poll a filename like /371P1S1CCyan.tif.

The Job Genie utility allows for the configuration of a TIFF Based RIP input filter to poll and recognise any filename
convention, no matter how unique or complex, and stitch the 1-bit files into single jobs. Job Genie can also be used to
rename files to have more user-friendly onscreen names, or group files together into a single publication.

The configuration window is split into two (2) sections. The column on the left allows you to enter a Task (see Tasks
below). The main panel displays the five (5) tabbed sections requiring consideration when setting up each Task. After it
is created, the Job Genie is selected in a RIP queue using an input filter such as TIFF Based RIP (User Configurable) to
poll the chosen directories for the defined filenames.

Tasks

A Job Genie is made up of one or more user-defined tasks. Each task specifies how the job filenames are collected; how
they are defined and grouped; how the job names will be displayed in the RIPMonitor; and if the jobs will be proofed as
a publication when submitted for processing.

Important Note: More than one task may be required to collect all the files in a given path if the naming varies. Jobs are
constructed in the order of the tasks. Once a Jobname is matched by a given task, it is removed from subsequent
searches, so the order of the tasks is very important. To change the order of a task, select it with the mouse and drag it
to the desired position in the list.

Interface Options
* Log - Enable or disable to display the matching process in the ServerLog for the task selected. This can be
useful to debug problems where configurations are not matching files properly. It is best to turn logging off for
a Job Genie that is functioning correctly to avoid the ServerLog becoming too large or cluttered.
¢ Add - Add another task to the list.
* Duplicate - Copy the selected task to a new one.
* Delete - Delete the currently selected task.

Tabs - (1) Collect Files
This tab specifies how the files are sorted and collected by the input filter. One or more search parameters can be
entered, with each one comprising of an Action type, a Match criteria and a search
String.

It is not necessary to enter anything in this first tab if all the files in the RIP input
filter path are valid for collection and proofing.

As with tasks, each collection action is performed in order. Once a file has been
excluded by a task, it is not looked at again so the order of the actions is very
important.

Action Options )

* Ignore Files - Do not include any files matching the definition specified | =~ G
when the input filter collects the ready for sorting.

* Ignore Directories - Do not look in directories matching the definition specified when collecting files ready for
sorting.

* Descend Directories - Only look in directories specified by the definition when collecting files ready for sorting.

* Include Files in Directories - Include all files in the definition specified directories when collecting files ready
for sorting.

* Include Files - Only collect files as specified by the definition.

Note: Of the above actions, Include Files in Directories has precedence over all other actions. If this is matched, files and
directories at the same level are ignored. Files and directories within the directory matched are then subjected to a
search, governed by any other specified action.
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Definition Options
* Ending With - Any file or directory as specified in the action with a name ending with <this text>.
* Beginning With - Any file or directory as specified in the action with a name beginning with <this text>.
* Containing Text - Any file or directory as specified in the action where a name contains <this text>.
* Named - Any file or directory as specified in the action explicitly named <this text>.
* Add - Add the action and definition specified to the list of files to collect.
¢ Apply - Apply any changes to the currently selected action and definition in the list.
* Delete - Delete the currently selected action and definition from the list.
* Filename Length - Specify a minimum and maximum filename length when searching for any files for sorting.

Note: The Add, Apply and Delete buttons are only available if there is a change to an existing entry. If actions are not
added or applied to the list before a save, the list is not updated.

Tabs - (2) Filename Break Down
Most job filenaming conventions contain common elements defining the job’s name, section, page or publication; and
specific file markers or unique elements identifying things such as plate colour.

This tab allows you to specify the construction of a filename. This is done by
breaking it down into parts and giving each part a user-defined name. Once all
parts of the filename are identified, they can be grouped together to make a
complete job.

Options

* Case Sensitive Matches - Used to match case when the criteria for
matching contains user specified input. For example, Part contains
specific words, Match to separator and the Truncate option. If any of
these are used and Case Sensitive Matches is selected, only those
characters matching the specific case entered are matched.

* Read Direction - The direction in which the filename is read. Click the
arrow to change read directions.

* Parts - This is a block diagram showing the breakdown of the job. Each part is given a name and identifies a
section of the filename. Clicking the Read Direction arrow changes the order of the parts to show which part is
going to be read first. If creating a new Job Genie, parts will not appear in the diagram until they are created.

* Add - Add parts to the list.

* Apply - Update the selected part with changes.

* Delete - Delete the selected part from the list.

* Part Name - Specify a name for the part you are about to describe. Meaningful names are useful when choosing
the groups later.

* Part Contains - Specify from the list what the part will contain. Choose from:

o Any Character - The part can contain any valid character.

o Numbers Only - The part may only contain numbers.

o Hexadecimals Only - The part must only contain hexadecimal characters (0-9, A-F).

o Specific Words - Specify a word or characters in the text box that the part must contain.

* Match - Choose what point in the filename you are going to match to. This may be a specific separator or end of
string, for example, read along the filename until this point, looking for valid part matching specified above.
Choose from:

o To Separator - Enter a character in the text box to specify as a separator, i.e., continue reading the part
until you reach this separator.
o To End of String - Match everything from this point to the end of the filename (string).
To Numeric Separator - Match everything from this point until you find a number.
To Non-Numeric Separator - Match everything from this point until you find anything that is not a
number.
To “.” (full stop) Separator - Match everything from this point until you find a full stop.
To “-“ (hyphen) Separator — Match everything from this point until you find a hyphen.
To “_” (underscore) Separator - Match everything from this point until you find an underscore.
To “$” (dollar) Separator - Match everything from this point until you find a dollar sign symbol.
To “” (space) Separator - Match everything from this point until you find a space.
Number of Characters — Match the number of characters specified in the text box. A further option is
available if this is selected:

= Truncate from Character - Choose a character to identify in the filename and remove all
characters from the point onwards. For example, if you have a large number of 0’s in a group,
you can choose to remove those 0’s from the group so they are not displayed.

o O

O O O O O O
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Note: The To Separator and Truncate from Character options allow multiple entries separated by commas, where each
entry searches for a match, i.e., you can specify “To Separator a, b, c” where if any of the separators a, b or c are matched
it is valid.

Separator Options

Separators are the characters that determine the end and beginning of a part. For example, with cyan.tif the full stop
between cyan and tif is the separator. As this is part of the filename, you still need to decide what to do with this
separator. There are three (3) options:

* Discard Separator - Ignores the separator.
* Include Separator with this Part - Includes the separator with the part being described.
* Include Separator with the next Part - Includes the separator with the next part described.

Example: With a filename such as job.cyan.tif where we parse the name in the forward direction, we describe the first
part as name to separator full stop (.) and the next part as plate to full stop (.)

Discard Separator creates the two parts as job and cyan.

Include Separator with this part (for name) would produce a part as job.

Include Separator with next part (plate) produces a part as cyan. This is only used if the separator is a character you
want to display in the RIPMonitor, such as a page marker.

The most commonly used option is Discard Separator. In the above example, if the option Include Separator with Next
Part was used, we could not identify the colours, as it will be called .cyan

Tabs - (3) Jobname + Plate
This tab allows you to configure which parts should be grouped together to complete a job and which part identifies the
plates of the job. You can specify how the plates are described and control specific mapping.

Job Grouping
*  Only group files in the same directory as job - Check this box to group filenames together in a directory. Files in
different directories will not be grouped.

This is used when job directories are created containing all the plates.
Sometimes the filenames vary for the name of the job, but because
they are all placed in one directory per job, they can be grouped
together.

* Group files with parts - This displays the parts created in Tab (2) -
Filename Break Down. Select the part or parts that make up the job
name by clicking the tiles onscreen.

In most cases, the file part defined as the plate should not be chosen,
as this would group files with the same plate together, rather than
combining the different plate files into one job.

Plate Identification
This tab is where you define which part created in Tab (2) - Filename Break Down is the plate part and how it is
written in the filename.

* Plate Part - Select the part of the filename that describes the plate colour from the dropdown list. The list
contains the part created in Tab (2).

Plates are:

* Defined by words - The plate names are complete names, for example, cyan, pantone 252.
* Defined by numbers - The plates are defined by numbers, for example, 0 is cyan, 1 is Magenta etc. If this is
selected, two other options are available:
o Starting Plate Number - Enter the number the plates start at. This is usually 0 or 1.
o Plate Order - Choose the plate order between KCMY+specials or CMYK+specials.
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¢ Map Letters C, M, Y, K to Process Names - If the plates are named with just letters, for example, cyan is
represented as ¢, selected Defined by words and choose this option.

¢  Strip leading zeros from colour names - Sometimes colour names have multiple zeros before the plate number.
This option can be used to remove these.

Plate Mapping

You can map plate names so they appear correctly in the RIPMonitor and are able to be matched to colours in the
System Specials colour set (see Server Settings - Colour Management). A list of plates requiring mapping can be
created.

* Case Sensitive Mapping - Select this if the mapping should check for case.

* Add - Add the mapping to the list.

* Apply - Apply changes to the currently selected mapping.

¢ Delete - Delete the currently selected mapping from the list.

* Prefix number literals with user text - Add a prefix to numbers you are polling. For example, if the colour is
called 254, you can prefix the word pantone in front of the number, making the special plate become pantone
254.

Tabs - (4) Publication + Pages

This tab is where parts can be identified from the Filename Break Down as a Publication and a Page. This can help with
autoproofing, as a job can be automatically filtered and gain all the attributes available to publications, such as grouping
in the QueueManager and the Pages pane in SoftProof.

* Page numbers are:
o Defined by words - Attempts to assign page numbers from letters.
o Defined by numbers - Attempts to assign page numbers as
numbers. Numbers must be greater than 0.
o Defined by sequence 14, 1B, 2A, 2B - Attempts to assign page
numbers in sequential order.’
* Page number part - Select the part that identifies the Page number from
Jobname, Colour, Extensions or None.
* (Case Sensitive Mapping - Select this if the mapping should check for case.
* Publication Part - Select the part that identifies the Publication part from
the previously defined filename parts.
When files are submitted for processing via the RIPMonitor, all jobs with a
common Publication Part will be submitted to the QueueManager as one publication and will be viewable (and
softproofed) as such. None means no Publication Part is being used.
o IN / OUT - Map Publication abbreviations to full names (if required). For example, smh IN becomes
Sydney Morning Herald OUT.
* Section Part - Select the filename part defined as the Section Part from the dropdown menu. The default is
None, meaning the Section Part is not being used.
Many publications, such as newspapers, are made up of a composite of separate sections. The pages of these
sections often use a filename convention where the page numbers represent the number within the section -
not the page number within the whole publication. The Section Part makes it possible to proof a publication
made up of multiple sections and to offset the pages of each section appropriately to allow viewing of the
complete publication in the correct page order.
o IN / OUT - Unlike the Publication Part where remapping is optional, if used, the Section Part requires
you to input the section names (although IN and OUT can be the same) and a Page Offset value for each
section.

vvvvvvvvvvvvvvv

Note: Using Publication and Section Parts with Bookfilter

In the case of a Job Genie being created for a Bookfilter poll, the Publication and Section Parts can be used to re-map
publication and section (or edition) filename parts into more coherent or user-friendly names for display in the
BookMonitor. The Page Offset function of the Section Part is not used - it is simply for renaming.
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Tabs - (5) Display

The Display tab allows you to configure how the Jobnames are displayed in the
RIPMonitor. Click the Parts tiles to add the filename parts to the Jobname, Publication
Name and (optional) Section Name strings. Parts can be entered in any order.

Any other text to be shown in the RIPMonitor can be entered as part of the string.

For example, clicking a part named Page will show <Page> in the string. This will
display the page number only in the RIPMonitor. It may be useful to add “Page:”
before the <Page> part so the RIPMonitor will display as “Page:1”.

Display Specification - Shows the parts created in Tab (2).
Jobname String - Shows the string that will be displayed in the Name column s i
of the RIPMonitor and QueueManager. You can enter any valid character or
use filename parts.

Job Directory - (Buttons) Allows you to enter the job directory into Jobname, Publication and/or Section String
fields.

Publication Name String - Shows the string that will be displayed in the Publication column of the RIPMonitor
and QueueManager (in Publication view). You can enter any valid character or use filename parts.

Section String - Shows the string that will be displayed in the Section column of the RIPMonitor. You can enter
any valid character or use filename parts.

Check the Serendipity Software website (http://www.serendipity-software.com.au/support/howto/workbench) for
HowTo’s on creating Job Genie’s.
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Media

The Media data type contains all of the settings controlling the output of jobs as they pass through the
Veripress colour management system (CMS) for proofing. Settings configured here are those directly related

to the Output device, Colour Correction, ICC Profiles and Output Screening.

A Media can be one of several assigned to a Pagesetup, which controls the input screening, resampling, rendering
effects and intents of incoming jobs. All jobs are submitted to a combination of Pagesetup and Media destinations.
When submitting, the user selects the Pagesetup to be used, at which point a list of compatible (user-created) output
Media types in the database become available for selection. A default Media is assigned to a Pagesetup, so if a job is
submitted without a specific chosen Media, the job will output to the default Media settings. An Output data type can
optionally have a Media type assigned to it, in which case only jobs submitted to the Output using the assigned Media
will be processed. All other jobs are held in the QueueManager until the assigned Media is removed from the Output, or

the held jobs’ Media type is assigned to the Output.

Output

*  Output Driver - Select the desired output driver from the
available list. Those available will depend upon the options
enabled on the dongle. The selected driver affects the options
made available for Resolution and Colourspace.

* Resolution - Select or enter the desired resolution (DPI).
Colourspace - Select the output colourspace as desired. The
selections will change depending upon the chosen output driver.

* Media Width/Length - Sets the width and length of the Media.

Output

Output Driver: ( Serendipity Blackmagic Image |+
Output Sertings. Custom Settings
eiiong 720.00 Compression type None

Colourspace: | RGB 2] ZIP compression level 1

Embed ICC profile - disabled
Media Width: 610.0 mm

Media Length: 0.0 mm
(JCutSheet: [Custom 3]
Total Sheets: 0
Printer Margins
Left: 0.0 mm
Top: 0.0 mm
Right: 0.0 mm

Bottom: 0.0 mm (edit

Jobs of greater width and length will be held in the QueueManager until an appropriate Media, or new width

and length values are assigned.

Note: Media Width/Length values override the width/length settings in the Nesting section of the Output,
meaning jobs will not nest until within the width/length settings of the Media to which they were submitted.
* Cut Sheet - Enable this if the Media being output to is Cut Sheet. The media to be used is selected from the

dropdown menu.

o Total Sheets - Enter the number of cut sheets loaded. Jobs will stop printing to the Media and be held
in the QueueManager when MediaStatus has tracked that the assigned number of sheets have been
used. A Total Sheets value of zero (0) assumes an unlimited sheet availability for tracking. Sheet count

is reset using the Reset Counter button in the Usage panel.

* Custom Settings — These options will vary, depending on which output driver has been selected.

Usage
The Usage panel shows the amount of media used based on the values
entered for Media Length (above).

Used126mof LSOm@% [ ReeCouner

Logged Period: 22/05/09 350 PM - 25/05/09 9:43 AM
Printed: 13 Jobs (423437.47 mmr’)

* Usage Meter - Bar showing the amount of media used. Text under the bar shows the exact amount as “Used X

Units of Total Units” (percentage %).

* Logged Period - Time period (date and time, from and to) the Media has been tracked since the last reset.
* Printed - Number of jobs and total printed area of jobs tracked since the last reset.

* Reset Counter - Reset the usage count for the Media.

Colour Correction

¢ Correction LUT - Select a Correction LUT to be applied in the form of a o oredon )
Gradation Curve. You can preview the curves, edit them or create new curves.

Colour Correction

(" A Correction LUT ... ) None
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ICC Profiles

ICC Profiles are used to match colours from one device to another, for example, a Press to an Inkjet. It does this by
mapping an input to an output colour.

*  Qutput ICC Profile - Select an output profile. This is the printer |

Output

or other output profile and is used to convert the Lab data into (% ChooseICC Profie ) pson-7800-cmyk-semimatter-720dpl.cc
the output colourspace. This output could be RGB, CMYK, (A Choose ICC Tweak Set . ) None

CMYKOG, or N-Colour depending on the output device chosen Devie ik
and the detected colourspace. S
*  Output ICC Tweak Set - Select a Tweak Set from the available
list. Lists can be previewed, edited or new ones created.
* Device Link Profile — Select a device link profile. If the job passing through does not match the colourspace of
the Device Link Profile, the standard input and output profiles selected will be applied.

None

Upload ICC - This option is available on all of the ICC choosers and is used to upload an ICC profile from a local or
network folder location to the internal Veripress ICC folder.
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Output
The Output data type determines the output format of processed jobs and where they are sent to for printing

(or file output). The Queue panel sets the output driver used and allows auto-cleaning of job Output queues. The printer
connection or file destination is configured in the Destination panel. The Collating section has options for Nesting and
Duplexing. Maintenance allows for automatic printer maintenance

functions to be configured.

Queue

. [ Serendipity Backmagic Image ]

Output Driver - Select the desired output driver from the
dropdown list. Those available will depend upon the options
enabled on the dongle. The selected driver affects the options
in a Pagesetup and Media pointing to it.
Change Media - Select this to optionally assign a Media to the
Output. A chooser window will appear with Media displayed
matching the Output driver type. The options as set in the
selected Media are displayed for view, can be edited or a new
Media can be created.
Status - Choose whether the Output queue is Active or =
Inactive. This can also be controlled from the QueueManager.
AutoClean - Configures Veripress to automatically delete jobs from the Output queue based on time and
or/number. Options include:

o Job History - Keep Most Recent - When enabled, set a number of jobs. Veripress will keep that number

of most recent printed jobs in the Output queue, automatically deleting any excess jobs.
o Job History - Keep Jobs Newer Than - When enabled, Veripress looks at the time signature of printed
jobs and deletes any jobs in the queue older than the specified (days/hours/min) time.

AutoPause - Select a time duration the queue should pause after processing a job. Used for double-sided
plotters so there is a pause in sending the next job, giving the plotter time to turn a sheet ready for the back
side to be printed, or time to load another sheet.

Destination
The Destination determines the method of delivery of the output job to the final destination. Depending on the
destination driver selected, there may be some additional options available.

Destination Drivers

Bonjour/Zeroconf - Select this to output to a Bonjour/Zeroconf network destination. The local network is
polled for Bonjour/Zeroconf devices. Choose Edit and select the appropriate destination from the dropdown
list.

Command/Script - Select a script or command to be run once a job has completed.

FTP - Send your completed job to remote machine using FTP.

Local Folder - Choose a local folder to send the output file to. Enter the path or select Choose to browse and
select a folder. The folder must exist and have write permissions.

Local Print Queue - Print to a local print queue. Use this to print to a Windows printer on another machine. In
the path location enter \\machine\printer where <machine> is the name of the Windows machine with the
printer attached and <printer> is the exact name of the printer. The printer must be shared.

LPR Port - Use LPR to print jobs to printers accepting it. Enter the Hostname/IP address of the printer and the
path. Not all devices require a path to be entered. This is a good option for Epson printers with a network card.
This method is faster than TCP/IP printing for these devices.

Nowhere - This is used for internal testing purposes or for softproofing workflows. Files created by the print
driver are not sent anywhere; they are left in the default raster location. A print time for simulation can be
entered.

Secure FTP (sftp) - Send the job to a secure server using FTP.

TCP/IP Port - Print to a networked device over TCP/IP.
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Collating
Collating is a method of gathering various outputs and grouping [cum
them together. sl Aomac Nesig 8 At o When Nesig

Copies Maximum Wait Time.

Nesting

* Enable Automatic Nesting - Set the queue to nest jobs °
automatically when the configured conditions (such as ) oo U
Maximum Wait Time) are met. e Wit 6100 Minimum ol Heighe. 66

* Auto Rotate When Nesting - Enable auto rotation when okt pomm pemm e pomm
nesting occurs. If this is enabled, make sure the option in the
Pagesetup is set to None. There is no need to spend processing time rotating a job if it is rotated at nesting
time.

* Copies - Specify the number of copies you want to nest. For example, if you have 7 jobs making up a nest and
enter 5 in the copies field, you will get 5 copies of the same 7 jobs nested and printed.

¢ Maximum Wait Time - Specify how long to wait before nesting begins. Once reached, nesting will begin and
any job waiting to nest will be nested into a single job. The start time is determined by the first job that appears
waiting to nest.

* Minimum Paper Coverage - Specify the minimum paper coverage to be reached by jobs waiting to nest before
nesting will begin. Once reached, any waiting jobs will be nested into a single job.

* Maximum Jobs - Specify the maximum number of jobs in a nest. If there are more jobs in the queue than the
number specified, that number of jobs will nest and the remaining jobs will stay waiting to nest until the
criteria is met again.

* Media Width - Specify the media width. This is required for nesting to work.

* Gap Between Jobs - Enter the size of the gap between jobs in the nest.

* Minimum Total Height - Specify the minimum total height of a nest, i.e, if the combined height of the jobs
waiting to nest reaches this value, nesting will begin.

* Maximum Total Height - Specify the maximum total height of a nest, i.e,, if the combined height of the jobs
waiting to nest reaches this value, nesting will begin.

Note: If a Maximum Height is set, the Nesting algorithm will look at all the jobs waiting to nest and fit the most jobs
between the minimum and maximum heights. If the available jobs can not cover the defined Paper Coverage (if set) of
paper without exceeding the maximum height, jobs will not nest. If no Paper Coverage minimum is set, any job that
would make the nest exceed the maximum height will be left in the queue - the other jobs will be nested. Any single job
exceeding the Maximum Height will also not print. If a job is too large, either the nesting parameters and/or the
printing media but be changed. This makes it possible to effectively and efficiently nest using Cut Sheet media.
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Pagesetup
A Pagesetup consists of many configurable modules to manipulate your job for the desired output. This is
where the Input Screening and ICC Profiles, Render Effects, Colour Keys and other Colour Management options are

setup.

Output

* Change Output - Selects the Output method and assigns its configured
properties to the Pagesetup. ’

Output
( Change Output ... ) Image Output

& Change Media ... ) My Media

* Change Media - Select the default Media settings and assign its properties R
to the Pagesetup. If a job is submitted to the Pagesetup without a specific SR ore—
Media, the job will output using these default Media settings. | P
*  Output Settings: ERA

o Antialiasing - Choose from 2x2, 3x3, 4x4 or None. Antialiasing is
designed to smooth jagged edges and is used when the Output
does not have sufficient resolution to display edges smoothly. The values increase the amount of pixels
used for Antialiasing. The default setting is None.

o Priority - Assign a priority to a Pagesetup. The lower the number, the higher the priority. Numbers can
be negative for a higher priority. The default is 0. Jobs waiting to Image or Render will process
through a higher priority Pagesetup over jobs submitted to lower priority queues.

o Auto Publication Name - Create unique publication names for each job passed through the Pagesetup.
Use this feature for duplexing from PDF or PS files. Submitting a multi-page document as one job will
allocate all pages with the same publication name.

o 16 Bit Processing - Enable or disable 16-bit processing for jobs submitted to the Pagesetup.

Note: Veripress V5 is able to accept files submitted in a 16-bit format. The files are normally processed and rendered in
standard 8-bit colour, which for many workflows is sufficient for proofing. 16-bit processing improves render quality
and can be useful for finding artifacts within a job. When enabled, files submitted to the Pagesetup in 8-bit are upscaled
to 16-bit for processing. 16-bit mode requires more system memory for imaging/rendering jobs and produces larger

output files.

Publish

Allows Pagesetups to be published on a network as a Drop Folder, or as a network print destination for output from
another software application. To Publish a Pagesetup, it is necessary for the Serendipity Megarip PPD to be installed on
the same system on which the Veripress Server runs (Server menu > Download PPD).

* Publish DropFolder - Allocate a folder where files can be dropped in for processing. Valid File Types include
Postscript, PDF, JPEG, TIFF Image, Serendipity Blackmagic Image, EPS,

PNG Publish
* Location - Select a folder as a DropFolder. The folder must exist and SRUENEEED
have read/write permissions. ) Location ... ) Default Defauit
* Default - Reset the DropFolder location to the default one (Serendipity N o
Veripress installation directory/drop/<”"Pagesetup Name”>) TCP Port: [ Activate port number
* Printers - Choose to publish the Pagesetup as a network print Flow Control: (] Hold After Imaging (] Hold After Rendering
destination, allowing third party applications to print directly to it.
o Mac - Enable to publish the Pagesetup as a Bonjour/Zeroconf network destination for Mac OS X and
Linux. This option also publishes the Pagesetup as an AppleTalk destination, where the Pagesetup
name is used as the printer name.
Note: When adding a new printer through System Preferences on Mac OS X, select the Bonjour address
(pagesetup name@computer name) as the printer and Serendipity Megarip PPD as the driver.
o Windows - Choose to publish the Pagesetup as a Windows local printer port destination. See the

Serendipity Software website for details on how to create the Windows printer.

* TCP Port - Choose to publish the Pagesetup to a TCP Port, allowing it to be setup as an IP printer destination,
or as a destination for other Veripress Servers.

(e]

Activate Port Number - Enter the TCP port number the Pagesetup will publish to. It is necessary for
the port number to be 10000 or over and for each Pagesetup to have a unique port.

Note: When adding a new printer through System Preferences on Mac OS X, select IP printer, HP
Jetdirect - Socket for the protocol. The address should be in this form - computername:10063. Select
Serendipity Megarip as the driver.
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When adding a new printer through Windows:

1. Select Create a New Port - Standard TCP/IP Port.
Enter the computer’s network name in the Host ID field.
When Windows requests additional info for the port, select Custom Settings.
Rename the Port Name if desired.
Set the Protocol to Raw and the Port Number to the one set in the Pagesetup to be published.
Select Serendipity Megarip as the driver. If the driver is not already installed, choose Have
Disk and get the driver (megarip.inf) from the Serendipity Installation DVD, found in the
drivers/win/’OS Version’/ directory.

oGk W

* Flow Control - Select whether to hold the submitted file after Imaging or Rendering in order to prioritise jobs
or make rendering attribute changes before releasing. Options include:

(e]

Hold After Imaging - Hold jobs submitted to the Published Pagesetup after imaging has completed.
Held jobs can be released to continue processing via the QueueManager toolbar or contextual (right-
click) menu.

Hold After Rendering - Hold jobs submitted to the Published Pagesetup after rendering has completed.
Held jobs can be released to continue processing via the QueueManager toolbar or contextual (right-
click) menu.

Nest - When enabled, this option will nest jobs submitted to the Published Pagesetup according to the
criteria defined in the Output used by the Pagesetup/Media.

Note: The Nest function only requires that the Output used has nesting parameters defined. The
Output itself can have nesting disabled for normal use. This makes it possible to create multiple
nesting or non-nesting Published Pagesetup’s to print via the same Output.

Colour Correction
* Replace Colour Set - Select a Replace Colour Set from the list of available sets. You are able to preview the set,

edit it, or create a new one.

* (Cyan/Magenta/Yellow/Black DotGain Curves - Select a C, M,Y or K DotGain
Curve to be applied. You are able to preview the curves, edit them or create
new ones.

* Specials DotGain Curve - Select a DotGain Curve to be applied to the Special
Spot Plates only. One curve affects all Special Colours the same way. You can
preview the curve, edit it or create a new one.

* Device Linearisation Curve - Select a Device (platesetter) Linearisation Curve
to be applied. You can preview the curve, edit it or create a new one.

ICC Profiles

Colour Correction
——————
@ Replace Colour Set ... ! None
S —
® Cyan DotGain Curve... ) None

® Device Linearisation Curve ... None

* Always Use ICC - Enable this to always use the assigned ICC profiles for jobs submitted to the Pagesetup (and
Media). If this is not enabled, the ICC profiles selected are only used in colourspace conversion.

* Honour Embedded ICC Profiles - Enable this to use an ICC profile embedded in a submitted TIFF, JPEG or EPS
file as the input match profile. When enabled, embedded file profiles will always take precedence over any
Match ICC assigned to the Pagesetup.

Note: The TIFF Image output driver has an option to embed an ICC profile into TIFF files that are output by Veripress.

* Black Point Compensation - This setting is designed for use when

processing input from large gamut sources such as photographs and RGB
images. Black Point Compensation enhances shadow details in these
images; assists when viewing shadowed areas in non-ideal or everyday '
lighting conditions; and prevents flooding in CMY gray areas.
This setting only functions when using colourimetric intents, and when
Always Use ICC is checked. | =
Black Point Compensation should not be used for normal CMYK proofing
jobs, which are generally well within the gamut of an output device (Inkjet
printer).
* Intent - Select the rendering intent to use. Options include:

o

icc Profiles

™ Always Use ICC
™ Honour Embedded ICC Profiles

(4 RGBICCProfile ... ) monitors/sRGB_v4_ICC_preference.icc

Rendering Intent: [ Perceptual 2]

(% Choose ICC Profile ... ) ~fogra-altona-testsuite/ISOcoated_v2_eciF39.icc
Rendering Intent: | Relative Colourimetric ]

() Print Calcheck

Perceptual - All colours are moved proportionally to each other so the eye perceives the colours to be
correct (i.e., colours out of gamut move into gamut, and those in gamut move proportionally to those
out of gamut).
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o Relative Colourimetric - Those colours out of gamut are moved into gamut, and those in gamut are left
untouched.

o Absolute Colourimetric - The colours are left alone so those out of gamut cannot be reproduced.
Adjusts the white point of the media to match that in the input ICC profile.

o Saturation - Those colours out of gamut move into gamut, but all colours increase in saturation as a
result.

* Retain Pure Black - When ICC profiles are used, all colours, even solids, are made up of a mix of different
colours. Selecting Retain Pure Black uses only black for areas containing just black. When enabled, the
following options become available:

o All - Uses black ink only in all areas defined as Black.
o Text - Uses black ink only in elements defined as Black text. This can improve the clarity and
sharpness of the text.

Note: This option is not always suitable for use with printers using light black inks, as many of these inks tend to have a
non-black hue.

* RGBICC Profile - Select an RGB Input profile. This is used to convert input data from RGB to Lab and should be
a scanner or digital camera profile.

* Press ICC Profile - Select a Press profile. This is a Match profile and is used to convert input data from CMYK to
Lab. This can be a multicolour profile or CMYK. If you select a multicolour profile, an additional option will
become available - Press Inks.

o Press Inks - For multicolour press profiles you must specify the plates used in the ICC and the order of
those plates. Selecting this option displays a Special Colour Set chooser, allowing you to select a pre-
defined set or create a new one.

Important Note: For multicolour profiles to work, you must create the same colour names used in the ICC and have
them in the same order. The order for the ICC is specified during ICC creation. This is independent of the actual press
order. Change the order by dragging the colours around the set. The order is specified as the Colour (left column), order
descending.

* Upload ICC - This is available on all of the ICC choosers. If the ICC profile is located somewhere other than the
default ICC folders, you can use this function to upload it to the Server ICC folders in order for it to be used. As
this is a Client-side option, you can use this function for moving ICC profiles from the machine they were
created on to the Server. This can be either on the LAN or WAN as a remote machine.

*  Print Calcheck - Select this to attach a calibration strip to every job passing through this Pagesetup.

o Device - Choose the device you will use to measure the strip with. This creates the chart for the correct
device.
o Chart - Choose the chart for use from the popup window of Calcheck Charts.

Note: The Calcheck Chart is a Data Type in the Workbench. This is where you create the chart. Use the Displays
application to measure it and produce a report.

ColourKeys
Merge some plates and separate others from a single job submission with ColourKeys. For example, merge the CMYK
plates together and print the 3 specials as separate jobs, or you can create progressive proofs with C, CM, CMY, CMYK,
CMYKS], etc.

Colourkeys

* Enable ColourKeys - Select this to turn the module on.

* Plates - Shows a list of available plates.

* Add - Adds the selected plates to the Plate

¢ Combinations list. sk

* Progressive - Used to make progressive proofs. After adding the first plate
to be used in the proof, click the Progressive button one or more times to
cumulatively add plates to the Plate Combinations list. The progression will
start with the first plate on the Plates list by default if a first plate is not
selected.

* Deselect - Deselects any plates currently selected in the Plates list.

* Remove -Removes the selected Plate Combination from the list.

* Remove All - Clears the Plate Combination List.
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Input Screening
Input Screening determines how the screening on the input data is handled. There are two (2) choices - Preserve and
Descreen.

* Preserve - Preserves the dots from the incoming data so the same dots on the final job are shown on the proof.
Further choices are:
o Real Dot Technology - Used to preserve the dot structure.
o Fast-2 - Similar to RDT but a faster method.
o RDT Smooth 1, 2 and 3 - This is RDT with progressive levels of smoothing.

Note: Fast-2 should be used where the dot structure is not very important. It will preserve the dot but is a quick, low
quality method. The sharpest dot structure will be achieved using RDT, however you will sometimes get introduced
moire, caused by the head weaving of the printer, the resolution and the screen ruling of the original file.

* Descreen - Descreens the incoming data with either:
o D-Dot - Removes the dots; or
o Fast - Quick descreening algorithm

Note: D-Dot is used where the output job is being sent to a photocopier or similar device, with a front-end RIP that
applies a screen of its own. If you did not remove the dot, the job would be double screened, producing poor output. Use
Fast for all other methods when the incoming screening is not to be preserved.

* Plates and Plate/Type - Override the descreening mode selected with other modes for the plates. This is
needed so that, for example, if RDT is used for all plates except Black (which uses RDT Smooth-2) you will
avoid getting moire.

Postscript / PDF Options
The following options are only used when the incoming data is Postscript:

* Use Bounding Box for Page Size - Some Postscript jobs do not place a page size in the job information.
Checking this will use the bounding box as the page size.

¢ Simple RGB to CMYK Conversion - This is a compatibility mode from older versions of the product. Images are
converted from RGB to CMYK quickly using a basic method. The colour is not very accurate and is not
recommended for contract proofs.

* Fail on RGB Images - Causes a job to fail if it contains RGB images. If
this is not checked, the jobs will process but RGB images will be
. . |_l Use Bounding Box For Page Size
lgnor(:"d and n0t prlnted' |_I Simple RGB to CMYK conversion
¢ Antialiased Subsampling - Used to assist in the rendering of some CJFail on RGB Images
|_! Antialiased Subsamplin
fonts' |_! Disable PDF autose:ara?ion
* Disable PDF Autoseparation - Turns off autoseparation for PDF files. @Render inRGE
e Render in RGB - Allows Postscript file data to be processed in an se CMYKsimulation from POF for unknown colours

Postscript / PDF Options

RGB rendering mode, with a wide gamut suitable for digital
photographic proofs/prints.

* Use CMYK simulation from PDF for unknown colours - Allow the CMYK simulations from PDF files to be
substituted for unknown spot colours.

Note: An Unknown Specials colour set can now be assigned in the Server Settings. This allows unknown special/spot
colours included in PDF or Postscript jobs to be automatically added to the set.

Resampling
Configure the method for sampling incoming data and changing the resolution from the input to that of the output. The
options are:

* Nearest Neighbour - The fastest method but less accurate. Choices are made as the closest pixels from input to
output and can result in jagged edges or stepping effects.

* Bilinear - A medium quality sampling method and can take longer than Nearest Neighbour. Bilinear takes the
weighted average of 4 pixels from input to output. Best for use with screened data.

* Bicubic - High quality sampling method which takes longer to calculate than Bilinear. Bicubic uses the
weighted average of 16 pixels from input to output. This is the default option for any new Pagesetup’s created.
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Filtered - Serendipity’s own sampling method, giving the highest quality. It takes longer to process than
Bicubic and uses an averaged area from input to output. This setting provides better resampling for contone

data, such as Postscript and PDF.

Logo

Position your own company logo, sign-off slugline or colour bar for checking consistency
anywhere around the job. The logo passes through the same colour management as the job
and can therefore be verified. The file is not rotated during output (except if Auto Rotate
When Nesting is enabled). If the logo file is positioned along the left or right sides, the EPS
file should be created in the appropriate orientation.

* Enable Logo - Turn the Logo effect on or off.
* Dimensions - Enter the print dimensions of the Logo.
* Logo File - Select this to choose your Logo file.

Logo

] Enable Logo

Width:  100.0 mm

Height: 11.0 mm

e
("3 LogoFile ...

Effects
M Enable Effects

Available Effects
Border 1.04
Centering 1.01

Effects

Applied Effects
Centering 1.01
Border 1.04

Various effects may be applied to jobs passing through the
Pagesetup. Effects are applied in the order they appear here. Some
effects have separate attributes for customisation and can be edited
once they are in the Applied Effects column.

Convolution matrix 1.02
Cropmarks 1.01

Edge detect 1.01
Margins 1.01

Mirror 1.00

Negative 1.00

Add

)
Remove All

The Effects are:

Pagenumber 1.09
Rectangle 1.02

Border - Place a border around the job. Line width and colour can be specified.

Centering - Centre the job in the specified page area.

Convolution Matrix — Design your own filter effect according to a pre-defined mathematical operation known
as convolution.

Cropmarks - Place crop marks around a job. Line width, length and clearance can be specified.

Edge Detect - Remove all content and just leave the edges.

Margins - Specify margins around the job.

Mirror - Mirrors the job.

Negative - Renders the job as a negative.

Pagenumber - Place the page number in the middle of the page as a watermark. Scale factor and opacity can be
configured, and choose between page number of the job or the page number of the signature (when using De-
Imposition).

Rectangle - Draw a rectangle around the job inset at the desired distance, line width and colour.

Registration Marks - When enabled, this effect will add registration marks at each corner of the submitted job.
Line width, Inner and Outer Radius are all configurable.

Signature Decorations - Place page lines (from the signature) and page numbers on the job. Further options
are available. Choosing lines for pages will print a line around the page. Lines for spreads will print a line
around paired pages (spreads).

Slugline - Place job information on the job. There are a number of options available via the Edit button. If you
are using a narrow format paper and the full slugline doesn'’t fit, select Custom Slugline and turn all options on.
This will show an item per line. Within Custom, fields selected will only be printed if they are relevant to the
job.

Unsharp Mask - Apply an unsharp mask to the job. The Unsharp Mask affects the edges within an image and
can be controlled with the available parameters. The radius tells us how large an area to affect around the
edges. The larger the radius, the greater the effect and the longer it takes to process. If the preview resolution
is high, a given radius will have less effect than if the resolution is lower. If the detail is quite fine, a smaller
radius should be used. Higher radius values can also cause halos at the edges. The threshold gives a level that
should be affected where 0 affects more of the image and 255 very little. The amount states the size of the
change, where a higher value is a greater change at the edges.

Watermark - Place a watermark across the job. The scale of the watermark is proportional to the size of the
job. 100% represents the same size as the job in the smallest direction. If the stretch option is selected,
horizontal and vertical sides are stretched to the scale amount. The watermark will be scaled in an anamorphic
manner.
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Media Effects Wedi Efects
The attributes here allow you to manipulate the job in various ways: I - o %0 O a0 e
Flttlng Method Hv::::: T [ Vertically (] Horizontally
o None - Fitting method is turned off. D —
o Fit Width/Fit Height/Fit Width & Height - Shrinks Heigh Factor: 00000
jobs to fit within the set dimensions; proportions are
maintained. O Auto Crop Cwirer
o Scale Factor - Scales jobs by the amount specified. I ot e
o Tiles - Tiles a job that is larger than the width & Right: (0.0 mm Right: 0.0 mm
height specified. If required, an overlap can also be e somn em o

entered. Useful for large posters or billboards.
o Best Fit Width/Best Fit Height/Best Fit Width & Height - As Fit, but will shrink or enlarge jobs to
fit/fill dimensions entered while maintaining proportions.
o De-Imposition - Can be used to take an imposed file like an 8UP, de-impose it into 2UPs or singles and
print it on a smaller printer; or produce a single page PDF file. If this option is selected, a further
Signature Group button becomes available for selection.

Note: If the Fit or Best Fit options are chosen and the width & height fields are left at 0, the Fit will default to the media
width and height as defined in the Media assigned to the Pagesetup when printing (see Media for details).

Rotation - Choose from None, 90, 180, or 270 degrees. Automatic rotation may also be selected to best fit the
job using the media width and height specified.

Note: Auto Rotation is very useful for saving media, but if a job is rotated, it takes longer to process - the larger the job,
the longer the process time. Rotation takes place at the beginning of the Rendering phase and will affect cropping,
margins and so on. If you are auto-rotating when nesting (See Nesting in the Output section), it is advisable to have
Sheet Auto Rotation turned off, otherwise the job rotation will be calculated twice, again increasing the process time.
Increasing system memory can also improve processing times.

Centring - Choose between Vertically or Horizontally.

Use this if you need to centre a job at any time. In particular, you may need to use it when printing to a double-
sided printer to help match the front and back sides.

Accuracy Correction - Compensate for media stretch or paper feed errors by specifying a correction amount
for width and height.

Cropping - Crop the job in all directions. When specifying cropping, you will need to take into account any
rotation that has been applied, as cropping takes place after rotation.

Auto Crop - Enables auto-cropping to remove blank area around an image. The crop stops at the first coloured
pixel encountered in the file image.

Margins - Specify a margin around the job. You may have to specify a margin to shift a job over or compensate
for a printer’s set margin. As with cropping, take rotation into account.

Effects - Mirror or Negative your job by enabling either option.

Note: The Mirror and Negative effects in the Sheet panel differ to those in the Effects panel in that they apply the effect
at the Imaging stage of processing.
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. Press

The Press data type is used to emulate the properties of a press for softproofing. Each Press configuration can be
assigned a press ICC profile, dotgain curves, press sheet dimensions, the number of ink keys, ink and paper
characteristics; all combining to produce accurate onscreen softproofs.

The Press can be switched on-the-fly while softproofing to instantly show how a job will look if printed on a different
press or on different stock.

Dimensions Size [1016.0mm x 7620 mm

Enter the size of the printable sheet area of the press rieiss B 8
and its number of Ink Keys. The Key Width is calculated oy esermm

from these values.

Colour Management
This panel is where the Press ICC profile is assigned, along with any process CMYK, spot colour or device (platesetter)
dotgain curves required to reproduce the colour performance of the press.

* Replace Colour Set - Select a Replace Colour Set to be applied. CIM”:%\ one

* Press ICC Profile - Select a press ICC. This can be one created —ETET—
on your press or a printing standard ICC which is used as the (@ CyanDotGainCarve ) None
target or match profile. —® Vagenta DotGain Curve .. ) Nere

¢ CMYK DotGain Curves - Select individual C, M, Y, or K DotGain S oo Do e ) e
Curves to be applied. %\ :

* Specials DotGain Curve - Select a DotGain Curve to be applied (& Dovice TremreationCorve ) Litho
to any special or spot colours. (% CacheckCran ) None

* Device Linearisation Curve - Select a device (platesetter) P -
DotGain Curve to be applied. e

¢ Calcheck Chart - Select a chart to verify the SoftProof’s
calibration status.

* Paper Colour - Three (3) options are available:
o None - Do not change the paper colour;
o ICC Profile - Use the white point from the press ICC profile and apply as the paper colour; or
o Custom - Enter your own value for the paper colour or use a Spectrophotometer to measure the paper
white directly into the configuration.

Ink and Paper
Configure the ink and paper properties of the press to simulate their effects in the SoftProof application. This helps to
produce more accurate proofs, allowing you to build up a library of paper and press combinations.

¢ Maximum Ink Weight - Enter a value for the maximum ink weight. This value is used by the InkKeyViewer to
show excess ink.

¢ Stretch Factor - Enter a compensation factor to allow for stretch. It can be used for distortion simulation or
anamorphic scaling, where one direction will distort more than the other.

Note: The easiest way to calculate stretch is to draw a rectangle 1m x 1m and print it. Measure the rectangle and enter
the value. If the size is 98cm, enter 0.98. If the size is 102cm, enter 1.02.

* Back Page Opacity - Enter a value between 0 and 100%. This controls the amount of show through of the back
page through the front page when reverse page viewing in SoftProof.

* Back Page DotGain Curve - Select a DotGain Curve to apply to the back page when using the Show Back Page
option in SoftProof.

* Top Page - Choose Even or Odd. This is used to determine which page backs onto which, so the correct back
page is shown when requested.
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Regular Expression
The Regular Expression data type is assigned as a filter to an auto-proofing RIP queue. Here, the user
constructs a set of rules whereby only files with a particular naming structure will be submitted for auto-proofing.

Expressions

Similar to the Job Genie, the Expressions (search tasks) are entered = = = T
. ' . . . xpressions gnore items |5 using | all of the following |§

and displayed in the left list. Each expression is made up of one or | Feeset || O uing

begins with total

more strings used to match or ignore files. doss notconain orick

The Expressions are handled in the order they appear in the list. If the
first expression matches a job name and that expression rule is to
ignore items, the job is not passed to the next expression for further
consideration. Expressions can be reordered by selecting the item and
dragging up or down the list as required. T

Duplicate )

a— ( - N
Delete does not contain m

List Options
* Add - Adds a new expression to the list.
* Duplicate - Makes a copy of the currently selected expression.
* Delete - Removes the currently selected expression.

Match
This is where you specify what you want to match and the rules to apply. You can enter one or more strings to match
and apply different rules to each.

Match options:

* Match Items - Matches the strings entered. If no other expressions exist, the job is submitted for auto-proofing.

¢ Ignore Items - Ignores anything that matches the strings entered. If a job name matches, it is ignored and not
submitted for proofing or passed to other expressions for further matching.

¢ Any of the Following - The match is true if any string match conditions are met. If you have two or more match
strings in the one expression and either of them match a job name, the Match Items or Ignore Items rule is
applied.

¢ All of the Following — The match is only true if all string match conditions are met.

String
Enter the string to match in the text field at the bottom of the screen. This is a job name or part of a job name. The
match depends on one of the following conditions, selected with the string:

* Contains - The job name contains the entered string.

* Begins With - The job name begins with the entered string.

¢ Ends With - The job name ends with the entered string.

* Is-The job name matches the entered string exactly.

¢ Does Not Contain - The job name does not contain the entered string.

* Does Not Begin With — The job name does not begin with the entered string,.
* Does Not End With - The job name does not end with the entered string.

¢ Is Not - The job name is not the entered string exactly.

Match String Options
¢ Add - Adds the match string to the list.
* Apply - Apply changes to the selected match string in the list.
* Delete - Removes the currently selected match string from the list.
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Replace Colour Set
. The Replace Colour Set is used to match and replace certain colours as they pass through the system. You can
match and replace process or spot colours and choose to match by name or position. Colours can be created
directly or imported from popular desktop applications, or a Special Colour Set.

There are a few uses for the Replace Colour Set. It is used to create a
digital blue line, which replaces all colours with varying hues of blue
allowing traps to be easily seen. It can also be used for replacing
special colours where the name varies, such as Pantone 101C and
Pantone 101CVC.

nnnnnnnnnn

N| EN| NS

Toolbar Options
* New Colour - Creates a new untitled colour in the list. Click
on either the Match Plate or Original name to change it.
* Delete Colours - Deletes the selected colour/s.
* Duplicate Colours - Makes a copy of the selected colour/s.
* Rename Match - Rename one or more Match Plates using a
popup Find and Replace tool.

[N

* Rename Original - Rename one or more Original
replacement colour names using a popup Find and Replace
tool. 5 Chaae)

* Add Colours From Library - Select one or more colours
from a Special Colour Set within Veripress to be added to the Replace Colour Set.

Alternatively, this window may be opened by double-clicking on an empty area of the list panel; or double-click
on a selected colour in the list to open the Add Colours window and replace it with the chosen colour.

¢ Import Colours From Files - Import colours from compatible third party applications, CGATS/ISO 12642 files
or previously exported colour sets. N-Colour swatches will not import unless an N-colour ICC profile with
matching process colour channels is first assigned to the Special Colour Set. If CMYK swatches are imported to
an N-Colour set, extra colour channels with 0% values will be added to match the colour space.

* Export Colours To File - Export the colour swatches to a CGATS/ISO 12642 file. If the set contains a mix of
CMYK/N-colour and Lab colours, you will be prompted to export either CMYK/N-colour or Lab colours. The file
standard limits exported colours to one colourspace.

* Export Colour Set To File - Export the entire Replace Colour Set to a file. If the set contains a mix of CMYK and
Lab colours, you will be asked whether to export CMYK or Lab.

* Preview Set - Opens a popup window listing all the Replace Colours in the set with colour properties and
replacement method.

* N-Colour Profile - Assign a multi-colour ICC profile to the Replace Colour Set.

Note: If an N-Colour multicolour ICC profile is assigned to the set, users will have the option to adjust colours in an Lab
or N-Colour colourspace as defined by the ICC profile (e.g., Lab or CMYKOG). Colours for each Replace Colour Set can
only be defined in Lab and/or a single other colourspace. If no N-Colour profile is assigned, colours are adjusted using
either Lab or CMYK values.

All the Toolbar options can be accessed via the contextual (right-click) menu available in the colour list panel.

Replacement Method Tabs
There are five (5) tabbed panels where colours are created or imported when making a Replace Set. Each tab performs
a specific replacement function.

Tab 1 - Process
Specify any of the Process CMYK colours you want to be replaced. Each of the process colours listed in the panel has:

* A swatch box showing the replacement for the process colour (left). Double-click this box to import a
replacement colour;

* An editable naming field for the process colour; and

* A Reset button for the colour of the process plate (lower right) and a Cancel button to switch off replacement
for that process colour (upper right).

Process colour replacement is set to Off for all 4 colours by default.
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Tab 2 - Exact
When using the Exact replacement method, only incoming colours precisely matching the Match Plate name will be
replaced with the new colour. Matching is not case sensitive.

Tab 3 - Partial
When using the Partial replacement method, any incoming colours are replaced with the new colour if any part of the
name matches the Match Plate name. Matching is not case sensitive.

Tab 4 - Position
The Position method replaces any incoming Special colour in a particular plate position with the new colour.

The Exact, Partial and Position panels have a Search box at the top right used for locating colours in the replacement
list. The list itself has a series of sort columns detailing properties of each replacement colour.

Colours can be selected and dragged to another position within the list. This is useful in Position replacement where the
plate position is important.

The order of the columns can be changed by dragging them to the desired location and the headers are configurable via
a context menu. The available columns are:

* Match Plate - Shows the replacement colour swatch. The Exact or Partial name in this field is the one to be
matched to the incoming colour being replaced. In the case of Position replacement, the name shows the plate
position. Click on the name to change it.

* Values - Shows the colourspace values of the replacement colour.

¢ Original Name - The original name of the replacement colour in the Match Plate swatch. Click on the name to
change it.

* Space - The colourspace of the replacement colour plate.

* Mode - The Paint Mode of the colour: Overprint, Knockout, Primer, Opaque or Transparent.

* Tint - The tint or intensity of the colour.

¢ DotGain Curve - The name of the DotGain Curve applied to the plate (if any).

*  Weight (g/m?) - The Press Ink Weight of the colour in g/m? (if assigned).

Tab 5 - Remaining
Allocate one colour to replace Special Plates that are not matched by anything else. This only replaces special colours
and not CMYK process colours. This panel has a similar interface to the Process panel.

Colour Adjustment Panel
View and adjust the colourspace values and plate properties of a selected colour.

The name of the colour selected is shown at the top. A window displays the Original colour and Modified colour as
adjustments are being made. A correctly calibrated monitor with an assigned Match ICC profile will display an accurate
representation of the colour/s.

Available adjustment options are:

* Colourspace - Choose between Lab or CMYK (or multicolour if an N-Colour ICC profile has been assigned to the
Replace Colour Set). The sliders change accordingly for making adjustments to the Lab or CMYK/N-Colour
values. These can be entered directly or fine-tuned using the up/down arrows.

¢ Paint Mode - Choose the Paint Mode for the colour. The diagram shows the Paint Mode, Opacity and Tint of the
selected colour. Choices are:

o Overprint

Knockout

Primer

Opaque (adds an opacity % slider)

Transparent

* Tint - Adjust the intensity of the colour by adjusting the slider, entering a tint value or using the up/down
arrows.

* DotGain Curve - Choose a DotGain Curve to apply to the colour.

O O O O

Note: A DotGain Curve applied to a replacement colour takes precedence over global Process or Specials DotGain
Curves assigned to a Pagesetup. The Pagesetup curves are ignored for the colour.
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Driver

This panel is where the driver used to poll and interpret the incoming file format is =
selected. The driver must match the type of RIPped file to be polled. Options available in
other sections of the RIP configuration may change depending on the RIP input filter
selected.

Weight - Optionally assign an Ink Weight (in g/m?) to the selected colour. This weight is used in the
InkKeyViewer (SoftProof) and in Calculate Ink Weights (QueueManager).

Spectrophotometer - Choose a supported Spectrophotometer to read colour values directly into the Special
Colour Set.

RIP

Different RIPs store their files in different formats and in different locations. The RIP data type is used to
configure how and where Veripress polls for these RIPped jobs.

Driver N

RIP Driver: | TIFF Based RIP (Generic) ]

™ Right Reading ™ Positive

RIP Driver - Choose the RIP driver (input filter) from the list of supported RIPs.
The list of available drivers will depend upon the bits enabled on the dongle.

Custom Settings - Depending on the driver selected, there may be specific parameters requiring setup for a valid
configuration. Use the Edit button to set up these parameters.

Polling

Polling is the method used to look for files. The configuration for polling the RIPped files is set up in this section. When
you poll, Veripress looks in the specified location (defined under Paths) for files matching the RIP driver selected. A list

is compiled and sent back to Veripress for display in the RIPMonitor. It takes  [romns N
three (3) successful polls before a file is shown in the RIPMonitor and the files :f‘”f‘“‘"”:"ﬁ" —— :“'“" — 9
must be stable (not changed since the last poll). (1 FastPlling (1 Log Sttt 1 lgnre Mod T
Connecti ion
. ) Method: Localhost %)
The available options are: ——
Lowest € = - - Highest
L]

Enable Polling - Turn polling on or off.
Poll Interval - Configure how frequently to poll for files. The Poll Interval should be set according to your
specific requirements. Setting the Poll Interval too short can flood the network with polling requests (packets)
causing it to slow down. Setting it too long can take a long time to show stable files ready for submission.

Fast Polling - This will automatically poll two (2) more times as soon as one (1) automatic poll has completed.
It will not wait for the next scheduled Poll Interval before it polls again. Files may appear incomplete in the
RIPMonitor if there has not been sufficient time between polls for a job’s complete set of plates to finish the RIP
process.

Log Statistics - Log the polling statistics in the Server log. The log message reports “Started automatic poll on
<date>" when polling starts and “Completed automatic poll on <date>" when finished.

Ignore Mod Time - Ignore the modification time on the file. Useful for Harlequin RIPs that update the
modification time on the file when moving the job between the Held and Active queues.

Job Genie - Assign a selected Job Genie to the RIP. This options becomes available when using a TIFF Based RIP
(User Configurable), PDF or Postscript input filter. If used, only files defined as valid by the Job Genie will
appear for submission in the RIPMonitor (see the Job Genie section for further details).

Connection
The connection specifies the method used for polling. The options are:

Agent - The most efficient connection method. This option connects to a Serendipity Polling Agent installed on
the system where the RIP files are located.

Localhost - Polls a directory path on the computer where the Veripress Server is installed.

FTP - Uses File Transfer Protocol (FTP) to poll and transfer the files from the RIP to Veripress.

Secure FTP (SFTP) - Uses Secure File Transfer Protocol to poll and transfer the files from the RIP to Veripress.
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File Transfer Priority
This specifies the priority to be used for transferring files from the RIP to Veripress. You can adjust from Lowest to
Highest or anywhere in between.

Sometimes a high priority can affect the RIP performance, especially on older RIPs. This can cause problems, such as
RIPs pausing. If this happens, reduce the priority level.

Paths
Specify the paths to the RIPped files residing on your RIP. This may be a single path or multiple paths and can be made
up of striped paths. The path structure is dependent upon the RIP driver selected. The options available are detailed
below.

* New - Adds a new path or stripe path to the Paths field. Selecting this displays another window to type the
path or browse to locate the folder containing the jobs. Browse will only work if the connection method has
been specified and is valid.

* Delete - Deletes the selected paths.

* Delete All - Deletes all paths from the list.

Most RIP drivers use recursive polling, i.e., they will poll down the directory structure into sub directories from the top-
level directory specified in the path. The more sub directories to be searched, the longer it takes. Specify the path as
close as possible to your files for quicker results.

Stripe Paths

Some RIPs place jobs on different drives, but in the same location. They can add more drives to a RIP, giving it a new
mount point, for e.g., E:/RIPJobs, F:/RIPJobs and G:/RIP]Jobs. These all have a common path of RIP]Jobs, but are “striped”
across 3 drives, therefore specify the drives (E:, F: and G:) in the Stripe Paths and the path (/RIP]Jobs) in Paths.

Note: This is important for RIPs sharing plates from single jobs across multiple drives, for e.g., Cyan & Magenta on E
drive and Yellow & Black of the same job on F drive. If this is not setup as a stripe, the plates will not be stitched
together.

AutoProofing

Jobs can be submitted manually from the RIPMonitor as desired. Alternatively, you can configure the RIP to have jobs
submitted automatically via the AutoProof facility. This way any new job that appears, if stable and meets the specified
criteria, will be submitted for processing. The options available are listed below.

¢ Enable AutoProofing - Turns AutoProofing on or off.
* Printing - Specifies how the jobs are to be printed. Options are:
o Copies - Specify the number of copies to be printed. Default is 0.
o Use Pagesetup - Print to the selected Pagesetup.
o Choose - Select an existing Pagesetup or create a new one if necessary.

Criteria
You can select certain conditions that must exist before a job is automatically submitted. The options are:

* Delay (seconds) - The length of time to wait to see if a job changes prior to submitting. A job may change as
other plates are RIPped and added to the job. A suitable amount of time needs to be specified in order to
ensure a complete job is submitted.

¢ Minimum Plate Count - Specify a certain number of plates that must exist before a job is submitted for
AutoProofing.

*  Must Have - Select which process plates must exist in the job before AutoProofing.

* Filter - Select a filter to use for AutoProofing. See the Regular Expression section for further information on
Filters.

* Delete Jobs From RIP After AutoProofing - Delete jobs after a successful AutoProof. This is only available when
jobs are locally hosted (Localhost polling). This may be used when a temporary file is created, for example,
when adding halftone dots to unscreened data.

* Hold After Imaging - Places the job on hold in the Rendering queue after imaging has successfully completed.

* Hold After Rendering - Places the job in a held state in the Output queue after rendering has successfully
completed.

Job Filtering
This is only available when the RIP driver is set to poll imposition RIPs. You can specify if AutoProofing should be
carried out on All Jobs or just Imposed Jobs.
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Testing

Once the configuration is complete, you can test the parameters are correct. The configuration must be saved before a

test can

be done. If it is not saved, you will be prompted to save and test. A test poll checks RIP connection, Path

validity and job presence. Messages appear in the window to alert you to any problems or give confirmation of a valid
configuration.

can then be submitted for de-imposition from the RIPMonitor and
separated during processing into smaller groups or individual pages to
fit the media, or to view a publication in its intended form.

The interface has a toolbar with various options and a series of five (5)
panels used to configure the Signatures. A display panel shows the
layout of the selected signature(s) to the right.

Toolbar

Signature Group
Import or create groups of Signatures, defining the page, sheet
and size parameters of press impositions. The imposed files

sssss

Options

Group - Groups two or more pages together. Pages must be the
same size and alignment. The Group button is only available when valid pages are selected.

Ungroup - Ungroup a group of pages. Only available when a group is selected.

Suppress Pages - Suppress the selected page or pages (marks it as not for print).

Auto Paginate - Automatically allocates page numbers to the signature. This will include any page currently
suppressed.

Offset Page Numbers - Offsets the selected page numbers by the desired amount. Enter the offset value to be
added to or subtracted from the page numbers.

Edit Page Numbers - Edits the page number of those selected. Tab moves to the next selected page. The page
numbers can also be edited by clicking on the page.

Pair Pages - Automatically pairs the pages along the long sides. The pages must match, the headers must be in
the same position and they must be joined (no gaps). If there is a gap, the manual pair option must be used.
After pairing you may need to use the Close Page Number Gaps option. See below for further information.

Pair Pages Horizontally - Pairs pages in the horizontal direction.

Pair Pages Vertically - Pairs pages in the vertical direction.

Rotate Selected Signatures - Rotates the selected signatures by the amount chosen. The options are:

o 90 Degrees Clockwise

o 90 Degrees Counter Clockwise

o 180 Degrees
Rename Signatures - Selecting this displays a rename box to search for and replace names. Options are:

o Find - Enter the characters to find in the list.

o Replace With - Enter the text to insert in place of the characters found. You can use any valid
characters, including spaces. If nothing is entered, the characters found are deleted if one of the
rename options is selected.

Ignore Case — Choose whether your match is case sensitive.

Wrap Around - Continue from the top of the list when the bottom is reached.

Rename All - Rename all items that are found.

Rename Selected - Rename the selected signatures if the characters are found.

Rename Current - Rename the currently selected signature if the characters are found. If more than
one signature is selected, the first one in the list is checked for a match and renamed if true.

o Find Previous - Searches backwards.

o Find Next - Searches forwards.

o Prefix With/Append - Two options allowing you to add characters before or after the names.

Import Signatures - Import a signature made by another application. The available types are:

o DynaStrip - Files are usually named with a sheet number and a .dsf extension.

o Preps - Files are Prep Templates.

o Krause - Files usually end in a number, such as jobname.001.

o ]DF - Files usually have a .jdf extension.

o Facilis - Files are usually named with a .dai extension.

Selective Import - Enable this to choose or alter any/all Signatures from the source file prior to import. The
following options are available:

O O O O O
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o Group Pages - Group the pages together as they are imported. The pages must be the same size and
align for grouping. The diagram shows a pink line around individual pages when they are not grouped
or around all pages when they are grouped. Pages must group for pairing to work.

o Inclusive - This option attempts to group pages with parameters/alignments differing by very small
amounts.

o Rotation - Choose to rotate the signatures during import.

o Offset Page Numbers - Offset the page numbers of those signatures imported by a number.

Imported ]DF files generally need to have the Offset Page Numbers set to 1, otherwise the first page
will begin at 0. This can be changed after import if necessary.
* Top Align / Left Align - Optional ways of viewing the interface, depending on your display and preferred
layout.
¢ C(Close Page Number Gaps - Use this to close the page numbers after pairing. When pairing a large publication,
the lowest page number of the pair is used as the resultant paired page number. This usually produces gaps in
the page numbers. Close Page Number Gaps closes the gaps so pages are sequential.
* Import Language Encoding - Select the appropriate language encoding for the signatures so the names can be
displayed correctly in the native language. This is set from the contextual menu (right click).

Signatures o
This panel lists all of the Signatures in the group. The Plate, Sheet, Grid and Page options for 6 U
the selected Signature are shown in the configuration panels on the screen. o
6-59
Signature Options: ggz
10-55
* New - Creates a new untitled signature. ,““T T
* Delete - Removes the selected signatures from the list. ( Duplicate

* Duplicate - Makes a copy of the selected signatures.

Signatures can be multi-selected or dragged and dropped to another position in the list (for de-imposition purposes).
When multiple Signatures are selected, all will be shown in the display panel. The Plate (if in use), Sheet and Pages
settings can be edited to make mass changes to all selected Signatures.

Display Panel
Signatures selected from the list are displayed in this panel, with all Plate, Sheet and layout properties as defined in the
configuration panels visually represented. If multiple signatures (or pages) are selected, differing parameter values will
be shown by bold, underlined field titles in the configuration panels.

The display panel is interactive and is used to: P4 B B4

* Select one or more individual “pages” within a signature for editing in
the Pages panel;

* Select pages for grouping or ungrouping, pairing, or page offset; 3 bl 2
* Show where pages of multi-selected signatures fit within a publication F3 Fa e
in a bottom Page Navigator panel. Pages belonging to the signatures are ST o o[BI 5 ATl oCa ol
shown in green; pages from non-selected signatures are shown in red; YB3 2 ) O e B
ss[ 56l 571 s8l sol 6ol 61l 62| 63/ 64l 651 66 i1

doubled-up pages are shown in purple. Selecting all signatures makes it
simple to check the integrity of the Signature Group.
* Select a page from the Page Navigator to highlight which signature it belongs to.

When viewing multiple signatures, the thumbnail sizes can be increased or decreased with the cmd+/- keys (Mac) or
ctrl+/- (Win).

Plate
Turn the Plate options on or off by selecting the Use Plate tick box.

The Plate settings are:

*  Width
* Height
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¢ Centre Offset - The value to offset the centre by. This is dependent upon the gripper position.
¢  Gripper Size
¢ Gripper Position

The plate width and height will alter the press Sheet size if the plate size is larger. If the plate size is smaller, the press
Sheet size is not affected. A plate size larger than the sheet size will appear with a red line outline within the signature
preview panel.

Sheet
Enter the dimensions of the press sheet in this panel. The options are:

*  Width
* Height
¢ AutoFit - Changes the press sheet size so the pages fit.

Grid
This panel is where the grid of pages that make up the imposition signature is defined or edited. The options are:

* Xand Y Position - This sets the top left position of the selected group or page in respect to the top left of the
press sheet.

* Page Size - Select the size of the single page selected from one of the G":Mmm p—
pre-set page sizes or choose Custom. - -
* Page Width - Enter the width of the single page selected. The pre-set aretitss EEN)
page sizes automatically complete this field. v (i =
* Page Height - Enter the height of the single page selected. The pre-set Columns 1 5
page sizes automatically complete this field. el
e Orientation - Select the orientation of the selected page between e q
Portrait or Landscape. ) (— ) —
¢ Columns - Enter the number of columns for the signature.

* Rows - Enter the number of rows for the signature.

* Gutter X and Y - Enter the size of the gutter for the signature. If you select a gap first, the value is applied to the
selected gutter only. If you wish to apply a value to All, Even or Odd, you need to select it from the pull down
menu first and then enter the value. Press Enter to apply the value.

* Delete - Deletes the selected pages or groups.

* Duplicate - Duplicates the selected page or group. This is positioned at top left (X=0, Y=0).

* New/Place - Creates a new page or group. Selecting this changes the button to Place. Enter the page attributes
as desired and click Place to position the page or group. If you change your mind, press Esc to cancel.

* Number - Enter the page number of the selected pages.
* Top Bleed - Enter the amount of top bleed to apply to the selected pages.
* Bottom Bleed - Enter the amount of bottom bleed to apply to the selected pages.
* Left Bleed - Enter the amount of left bleed to apply to the selected pages.
* Right Bleed - Enter the amount of right bleed to apply to the selected pages.
* Page Head - Select the position for the head of the currently selected pages. As you choose, the diagram shows
the change. The page head is indicated by a line and folded corner. Choose between:
o PageHead Up
o Page Head Down
o Page Head Left
o Page Head Right
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Special Colour Set

Veripress uses special colour sets to identify and match colour plates when jobs are polled and processed.

Special colours can be created manually, or imported from one of several popular applications. A library of
sets can be built up for use in different proofing situations.

Colours can be created in Lab and a CMYK or N-Colour colourspace, read directly into the system using an online
Spectrophotometer, or imported from a CGATS file. Each colour can have its ink Paint Mode or Press Ink Weight set and
have an individual DotGain Curve assigned to it.

The interface includes a Toolbar with general creation and
import options; a panel showing the list of colours in the Special
Set; and another to adjust the properties of a selected colour.

Toolbar Options

¢ New Colour - Creates a new untitled colour in the list.
Click on the name to change it. B : st 228

¢ Delete Colours - Deletes the selected colours.

* Duplicate Colours - Makes a copy of the selected
colours.

* Rename Colours - Rename one or more colours using a
popup Find and Replace tool.

* Add Colours From Library - Select one or more colours
from any other Special Colour Set created within
Veripress.

¢ Import Colours From Files - Import colours from
compatible third party applications, CGATS/ISO 12642
files or previously exported colour sets. N-Colour swatches will not import unless an N-colour ICC profile with
matching process colour channels is first assigned to the Special Colour Set. If CMYK swatches are imported to
an N-Colour set, extra colour channels with 0% values will be added to match the colour space.

* Export Colours To File - Export the colour swatches to a CGATS/ISO 12642 file. If the set contains a mix of
CMYK/N-colour and Lab colours, you will be prompted to export either CMYK/N-colour or Lab colours. The file
standard limits exported colours to one colourspace.

* Reorder swatches - Change the order of the colour swatches as they appear in the list.

Note: Swatch order can be important as a Pantone plate being matched from a number will be assigned the
first colour when matching the number in the set list.

* N-Colour Profile - Assign a multi-colour ICC profile to the Special Colour Set.

930, -8.12,-15.9
6022, -10.95, -31.85
6275, -6.88,-12.15
72:54,-0.22, -21.88
74.66,-4.78, -8.26
79.94, -6.98, -14.32
81.30,-3.34,5.50
84.55,-5.57,-9.14
86.92,-2.86,-2.77
2237,-1161, 1257
18.70, -16.02,-12.28
2030, -13.27,-2.10

)
ple order) 1) CAdivare )

Note: If an N-Colour multicolour ICC profile is assigned to the set, users will have the option to adjust colours in an Lab
or N-Colour colourspace as defined by the ICC profile (e.g.,, Lab or CMYKOG). Colours for each Special Colour Set can
only be defined in Lab and/or a single other colourspace. If no N-Colour profile is assigned, colours are adjusted using
either Lab or CMYK values.

All Toolbar options can be accessed via the contextual (right-click) menu available in the colour list panel, as well as:

* Print - Prints the colour list of the Special Colour Set, with colour swatches and details for each colour (see
below).

Colour List Panel
This panel has a Search box at the top right for locating colours in the set list. The list has a series of sort columns,
detailing properties of each special colour.

The order of the columns can be changed by dragging them to the desired location and the headers are configurable via
a context (right click) menu. The available columns are:

* Colour - Gives a visual representation of the colour.

* Name - The colour plate name (used to match the colours). Click on the colour name to change it.
* Space - The colourspace of the plate.

* Values - Shows the colourspace values of the colour.

* Mode - The Paint Mode of the colour (Overprint, Knockout, Primer, Opaque or Transparent).

* Tint - The tint or intensity of the colour.

¢ DotGain Curve - The name of the DotGain Curve applied to the plate (if any).

*  Weight (g/m?2) - The press Ink Weight of the colour in g/m? (if assigned).
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Double-clicking on an empty area of the list panel will open an Add Colours To Library window, allowing you to add
colours to the set. Double-clicking on a selected colour in the list will open an Add Colours From Library window,
allowing you to replace it with a chosen colour.

Colour Adjustment
View and adjust the colourspace values and plate properties of a selected colour.

The name of the colour selected is shown at the top. A window displays the Original colour and the Modified colour as
adjustments are made. A correctly calibrated monitor with an assigned Match ICC profile will display an accurate
representation of the colours.

Available adjustment options are:

ColourSpace - Choose between Lab or CMYK (or multicolour if an N-Colour ICC profile has been assigned to the
Special Colour Set). The sliders change accordingly for making any adjustments to the Lab or CMYK/N-Colour
values. The values can also be entered directly or fine-tuned using the up/down arrows.
Paint Mode - Choose the Paint mode for the colour. The choices are:

o Overprint
Knockout
Primer
Opaque (Adds an Opacity % slider)
Transparent
Tint - Adjust the intensity of the colour by adjusting the slider, entering a tint value, or using the up/down
arrows.
DotGain Curve - Choose a DotGain Curve to apply to the colour.
Note: A DotGain Curve applied to a special colour has precedence over global Process or Special DotGain
Curves assigned to a Pagesetup. The Pagesetup curves are ignored for the colour.
Weight - Optionally assign an Ink Weight (in g/m?) to the selected colour. This weight is used in the
InkKeyViewer (SoftProof) and in Calculate Ink Weights (QueueManager).
Spectrophotometer - Choose a supported Spectrophotometer to read colour values directly into the Special
Colour Set.

O O O O
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Modules

Modules are informational windows used for managing jobs as they pass through the system and to monitor Server and
Client activity. Modules are arranged and utilised in a pre-configured format in the Jobs application; are able to be
added and configured to a tabbed window as part of a Monitor layout via the Layout menu; or started up individually as
standalone windows from the Module menu.

There are twelve (12) modules to choose from:

* BookMonitor - Similar to the RIPMonitor, this module displays a list of Books compiled via the Bookfilter.

* C(ClientLog - Displays a log of Client messages that may be generated during normal Client operations.

¢ (lusterStatus — Monitors the progress of Imaging and Rendering tasks on the Server and any active Cluster
Nodes.

* DropZone - A place to drag and drop files for processing.

* MediaStatus - A window showing the current calibration status of a Media data type and a progress bar
showing the amount of media (e.g. Paper) used.

* QueueManager - View and manage jobs after they have been submitted for processing.

* QueueStatus - A progress meter showing the current status of active jobs on the selected queue.

¢ RIPMonitor - Displays the files polled using RIPs configured under the RIP data type within the Workbench.

* ServerLog - Displays any system, error and polling messages from the Server.

* Status - Shows the disk status (usage) of the Server processing areas.

¢ Thumbnail - Displays a thumbnail of jobs as they image or render.

e VirtualPress - Available within the RIPMonitor module. Allows for the assignment, alteration and management

of plates to polled RIP jobs.
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BookMonitor
The BookMonitor module displays the publications polled from planning files using the BookFilter data type. The
publications can be expanded to show a list of pages and filenames associated with each page.

The module allows for quick viewing of large multi-section or multi-edition publications, such as newspapers. When
View Original, Rendered or FlipBook are selected for a publication in the BookMonitor, it searches the chosen queues in
the QueueManager for filenames matching those in the page list and assembles them on-the-fly for proofing in the
SoftProof or FlipBook applications. The Page Navigator in both applications (SoftProof & FlipBook) will show any pages
missing from the publication (those that have not yet arrived from the RIP).

) [ Toggle Bookfilter Polling ¥ Show Bookfilter Menu

Toolbar Options
* Expand/Collapse Jobs - Expand or Collapse the selected | wo« (=umie 1#) (rolingoFF 13
publications to list individual pages. Double-clicking a |~
publication in the display panel will also expand/collapse the

page list.

* Poll - Poll the selected BookFilter for any planning files. Once
polled, a list of the available planning file publications will be
displayed.

* Toggle Bookfilter Polling - Enable / Disable

¢  Show BookFilter Menu - Enable / Disable a dropdown menu.

* Show Bookfilter List - Enable / Disable eSS S >

* View Original - Opens the Imaged Preview of the selected B
publication in SoftProof.

¢ View Printed - Opens the Rendered Preview of the selected publication in SoftProof.

* View FlipBook - Opens the selected publication in FlipBook.

* Queue Order - Select this to choose the Output queue in the QueueManager the Bookfilter will search for
matching Imaged or Rendered job pages.

* (Calculate Ink Weight - Open the Ink Weights calculator window for the selected publication.

Note: Books (publications) can be opened in one of two ways. Selecting the Book title, then View Original/View
Rendered will open the Book at the first available page. Expanding a Book, selecting a specific page, then View
Original /View Rendered will open the Book at the chosen page.

View Options
The following sort columns can be selected using the contextual (right click) menu on the sort column header bar in the
Display panel:

¢ Name - The name of the Publication / Page sourced from the planning file.

* Section - Lists the section part of a page as defined in the Bookfilter JobGenie (optional)

* Page - The page number of the page file as defined in the planning file.

¢ Date - Date / Timestamp of the planning file

* Date of Issue - The publication date of the publication/page as defined in the planning file.

The order of the columns can be changed by clicking and dragging them to the desired position, or by using the
Configure Headers option under the contextual (right click) menu. The columns can be manually resized by dragging
the header divider bar to the desired width, or resized to fit content by double-clicking the divider bar.

The contextual menu also has options to Edit BookFilter, change the Colour Scheme of the BookMonitor window, pick
Font Options and choose the Language Encoding of the incoming poll data.
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ClientLog

The ClientLog displays any messages that pop up during normal Client
operation. There are different levels of message, from informative to
serious errors. All messages are held for a user-determined length of

time.

Fetch back log - Displays the log for the time specified. For
example, it retrieves and displays the last 4 hours of messages.
Choose the time from the pull down list.

Trim older lines - Trims the log based on the time selected in
Fetch back log. If this is set to 60 minutes, the log file is trimmed
back so only the last 60 minutes remain.

Export - Export the log to a file.

Note: When you export the log file you can choose to export everything in view or select entries to export. Use the
filtering options and Fetch back log choice to limit the view before exporting. Selecting export displays a chooser,
allowing you to enter a name and select the location to save the file. You can choose to save the file as html or as a tab
delimited text file.

Filtering Options
You can choose which messages to display in the log and which to hide by ticking checkboxes for one or more of the
following filters. All messages are saved to the log, even (if filtered.

Question - Used for messages that ask questions, for e.g., “Job contains unassigned colours. Do you want to add
them to VirtualPress.”

Information - Used for messages that tell you something, for e.g., “Job has a duplicate plate.”

Warning - Used where the message has a higher importance and (usually) the Client failed to do something,
but operation can continue, for e.g., “Failed to save new password. Old password will continue to be used.”
Critical - Used for serious errors that will most likely affect operation, for e.g., “Failed to load rendering .dll.”
You will normally be required to take action to rectify these errors before continuing.

Search - You can search the log for jobs or messages. Enter the text of characters you want to search for and
the ClientLog only displays the lines that match the search.

Display Options
The following sort columns can be selected using the contextual (right click) menu on the sort column header bar in the

log:

Type - The level of the message reported. For e.g., Question; Information; Warning or Critical.

Date - The time the message was reported.

Source - The module or application that reported the message.

Summary - A summary of the message that was reported.

Command - Internal command used to communicate messages to and from the Server by the Client.

Error - An error code reported by the Server. This is useful for de-bugging problems.

Action - The action taken by the user relating to the message. For e.g., the button pressed when the message

popped up.

The order of the columns can be changed by clicking and dragging them to the desired position, or by using the
Configure Headers option under the contextual (right click) menu.
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ClusterStatus
The ClusterStatus is a monitor allowing you to see the current Imaging and Rendering status of jobs on any active
Master Servers or Cluster Nodes:

®00 d = swdevel ipity-software.com.au:9100 - De...

Clustering - Open the Clustering application to manage the

Cluster. Soppelganger.wd._-sofvarecoman O o
Refresh - Update the status. focsnost e .
Increase Inset (+) - Increases the gap between the list items.
Decrease Inset (-) - Decreases the gap between the list
items.

Font Options - Change the size of the text.

DropZone

A DropZone is a place where you can drag and drop files for processing. The user selects Pagesetups or Pagesetup Pools
to add to the DropZone as a DropSpot. These DropSpots accept the same file formats as the DropFolder (Postscript,
PDF, JPEG, TIFF Image, Serendipity Blackmagic Image, EPS, PNG, PSD).

The available contextual menu options are:

Additional contextual menu options are available for individual DropSpots:

Add DropSpot - Select one or more Pagesetups/Media to add to the DropZone. Selecting this displays a chooser
window, showing all available Pagesetups/Media.

Reorder DropSpots - Displays a reorder window. Select one or more DropSpots
in the list and drag them to a new location, or use the up and down arrow keys to
move the position. Click OK when finished.

Increase DropSpot Inset (+) - Increases the size of the DropSpot.

Decrease DropSpot Inset (-) - Decreases the size of the DropSpot.

Font Options - Change the size of the text.

™ O O  DropZone - admi

a-tiff-98-dpi cmyk

Ez_79_B+K_Fle...mimate_090319

Remove DropSpot - Remove the selected DropSpot.

Edit Pagesetup - Edit a section of the selected Pagesetup, all sections or create a
new one.

Edit Media - Edit a section of the selected Media, all sections or create a new one.
Change DropSpot - Change an existing DropSpot.

Set Copies - Set the number of copies for every job dropped on the zone.

Set Colour - Select a colour from the list for the currently selected DropSpot.
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MediaStatus
The MediaStatus module’s function is to show how much of the media (e.g. Paper) has been used.

A meter is displayed graphically, detailing the percentage used. For the Usage meter to function, values for the Media
Length or the number of sheets loaded must be entered in the Output section of the Media data type.

Each Media displayed in the MediaStatus window has the following information:

Media Name

Usage Meter - Bar showing the amount of media used. Text under the bar states the exact amount used as a
percentage of the total units.

Reset Counter - Resets the usage count for the Media.

Logged Period - Time period (date and time, from and to) the Media has been tracked since the last reset. This
information is shown/hidden using the Show Extended Info option.

Printed - Number of jobs and total printed area of jobs tracked since the last reset.

A contextual (right click) menu has the following options:

Change Media - Change the selected Media for display in the status window.

Edit Media - Edit all or part of the selected Media. Copy it, or create a new one.

Media Order - Configure which queues are viewed by the MediaStatus window. Move Media between the
Available and Showing columns in the popup chooser.

Show Extended Info - Show/Hide the Logged Period and Printed information for the selected Media.

Metric Units — Toggle between Metric or Imperial units for measurements shown in the MediaStatus window.
This is enabled by default.

Increase /Decrease Status Width - Increase or Decrease the width or all Media panels in the window.

Font Options - Change the size of the text in the window.
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QueueManager

The QueueManager displays information about submitted jobs and the jobs’ current status. Queues can be viewed
simultaneously, showing job progress through Imaging (where the incoming file is interpreted and its resolution
sampled for conversion to the print resolution); Rendering (where colour management, cropping, rotation and effects

are applied for printing); and Printing.

The QueueManager also allows jobs to be
manipulated in a number of ways, such as
holding, promoting, deleting and re-rendering.

View Options
There is a lot of information available for viewing
about each job as it passes through the system.

The following sort columns can be selected using
the contextual (right click) menu on the column
header bar in the QueueManager display panel:

¢ Name - Job name.

TQueues | Pt Gallery_RP_Logs

‘‘‘‘‘‘‘‘‘‘‘

001022 Done golem__apdf 11May2010 Epso. -RCE  Eps

000242 Done golem..apdf 11May2010 Epso..-RGB Epso.OHTM Epso..OWTM 15936MB  6100cm  16.77em

000022 Done golom._apdf 11May2010 Epso -RCB Epso OMTM Epso.OMTM 15030M3  6100cm  16.77em ||

000043 Done golem. Lpdf 11May2010 HPCo phere HPCo.phere UserTest — 12343M8  1095cm  27.07%em ||
000202 Done golem...3).if 10May2010 Epson 7900  Epson7900 Epson7900  4520MB  384lem  2120em ||
000006 Nested Golem...3.f 10May2010 Epson 7900  Epson7900 Epson7900  36.0MB  38d0km  2120em ||

0000:00 golem... DAf 10May 2010 Epson 7900 Epson 7900 Epson 7900 45.35MB

000007 Nested golem...)4if 10May2010 Epson7900 Epson7900 Epson7900  36.93MB 3840  21.20m

000330 Done golem...Lpdl 10May 2010 Epso.-RCB  Epso_OHTM Epso.OHTM  1S48SMB  6L00cm  1677cm

000238 golem..3)if 10May2010 Epso -RCE  Epso OHTM Epso.OWTM 15735M8  3840cm  2120cm 4

>

* Process Time - Time taken to process the job.

¢ Status - The jobs current status.
* Source - The source of the submitted job.

Date - The date and time the job was
processed.

Media - The Media used to process the job.
Pagesetup - The Pagesetup used to process the
job.

Queue - The output queue the job was sent to
for processing.

Size - The size of the job (disk space used).
Width - The width of the job

Height - The height of the job.

DPI - The imaged resolution of the job.

Output Colourspace - The colourspace of the
output file.

Copies - When multiple copies of a job are sent
for printing, this column counts down the
number of jobs left to print.

Screening - The screening applied to the job.
Thumbnail - Shows a thumbnail of the job.

Job ID - The internal Veripress ID number for
the job.

Node - The Server or Cluster Node the job was
processed on.

Signature Group - The signature group used to
de-impose the job.

Signature - The signature within the group
used to de-impose the job.

Page - The page number of the job.

Publication - The publication name.

Notes - The number of notes saved with the
job.

Section - The section of the publication.

The columns can be manually resized by dragging the header divider bar to the desired width, or resized to fit content
by double-clicking the divider bar.

Toolbar Options
Queue Order - Configure which queues are viewed by the QueueManager - Available & Showing.
Render Queue Thumbnails - Enable or disable thumbnails for the Render Queue in the Thumbnails view of the

QueueManager.

Show Idle Queues - Show/Hide entries in the QueueManager for idle processing queues.
Group by Queue - Enable/Disable the grouping of jobs by Queue before other column sorting is applied.
Show - Show certain jobs in the QueueManager. Select any or all of the options to filter jobs. Choose from:

o Jobs - Display all jobs as text line entries.

o Thumbnails - Display all jobs as thumbnails. This is the same as the Print Gallery mode.
o Publications - Only display jobs belonging to a publication.
For any of the above display modes, further filtering is available:
= Active - Jobs currently processing.
=  Waiting - Jobs with a status of Waiting,.

= Done - Completed jobs.

Search - Find jobs that are in the queue. All jobs matching the search text will be displayed. All elements of the
jobs are searched against, not just the name, so this can be a useful filtering tool. The search can be inverted
with cmd+shift+] (Mac) or ctrl+shift+] (Win). The search box will turn black to indicate when the inverse

search is selected.
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There are a number of actions that can be performed on a job. Options become available when one or more jobs are
selected. Only actions valid for the job status are shown. For example, the action to Nest Now is only available if the job
has a status of Waiting to Nest.

The following are available in the Toolbar or by selecting job(s) and right clicking to access the context menu:

* Job Info - Shows information about the currently selected job. The Job Info contains all details of how the job
was processed and displays a thumbnail preview of the job and its configuration. Right clicking on the window
and selecting Print can print the Job Info to a system printer.

Note: Job Info & thumbnail can also be displayed by double clicking on the job. If multiple jobs are selected, double
clicking will display info about all in the window. Holding the control key (Win) or command key (Mac) will allow the
font size to be adjusted via the mouse wheel for easier viewing.

* Job Ownership - Displays two panels - General and Ownership - showing the type, created and modified dates
of the job plus the user and group permissions (See Accounts Admin/Secure Mode for more information).
* Modify - Allows various attributes of the job to be modified. These include:
o Name - Change the name of the job.
Publication Name - Change or add a publication name.
Page Number - Change the page number of the job.
Copies - Change the number of copies of a job.
Change Media - Change or assign a Media associated with the job.
o De-Imposition - Change or assign a Signature and Signature Group to a job.
* Reprint - Displays a window to reprint a job or jobs.
* Cancel - Cancels the currently processing jobs.
* Delete - Deletes the currently selected jobs.
* Hold - Holds the currently selected job. Only available when the status is “Waiting”.
* Release - Releases a currently selected Held job.
* Retry - Retries a failed job.
* View Errors - Views the errors of the selected job if the status is listed as Failed.
* Rush Jobs - Moves the currently selected jobs to the top of the current queue for processing next. The status
must be listed as Waiting. Jobs currently being processed will be completed first.

O O O O

Note: Rush Jobs will move the job up the current queue only. If the job is in the imaging queue and Rush Jobs is
selected, the job moves to the top of the imaging queue. Once complete, it will move to the bottom of the rendering
queue. You will need to Rush Jobs again to move it to the top of the rendering queue.

* View Original - Views the Original/Imaged file for selected jobs in the SoftProof application.

¢ View Printed - Views the Printed/Rendered file for selected jobs in the SoftProof application.

* Render Again - Submits the selected jobs to the rendering queue for processing. Only available when the status
is “Done”.

* Move to Pagesetup - Moves the selected jobs to another Pagesetup. This will send the jobs to the rendering
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one prior
to submitting the job.

* Copy to Pagesetup - Copies the selected jobs to another Pagesetup. This will send the jobs to the rendering
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one prior
to submitting the job.

¢ NestJobs - Submits the selected jobs to be nested. This sends the job to the rendering queue to re-render for a
nest. The Collating section of the Output is used for the nesting parameters.

* Nest Now - This is available when the selected job has a status of Waiting to Nest. Only one job needs to be
selected and all jobs with a Waiting to Nest status will be nested.

* Duplex Now - Duplexes any job that has a status of Waiting to Duplex. Only one job needs to be selected and all
jobs with a Waiting to Duplex status will be duplexed.

¢ View FlipBook - Opens the selected job or publication in FlipBook. If the selected job is part of a publication, all
pages will be shown.

¢ Select Publication - Selects all the pages/jobs in the QueueManager belonging to the same Publication as the
selected job.

* Refresh All Queues - Updates the queues.

¢ Export - Export data from the selected job. The available formats are:

o CIP3 - Exports job information to a file in CIP3 format at the selected resolution. You can also select
the orientation before exporting. Further options are:
= Version 2.1
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=  Version 3.0
= Rotations
=  Surface - Choose front or back.
=  Compress Preview - Choose if the preview should be compressed. Some presses are unable to
handle files in compressed format.
o PDF - Exports the selected job in PDF at the resolution entered. Further options are:
=  Compressions - JPEG, ZIP or LZW. For JPEG and ZIP you also have control on the level and
quality of compression.
o Postscript (separated) - Exports the current job as a separated PS file.
o Tiff Multichannel - Exports the current file as a multichannel Tiff.

* (Calcheck Job - Launches the Calcheck application to check a job’s calibration status. The jobname is stored and
the results can be exported or printed. Measurement results from the Calcheck are stored in the Job Info.

¢ (Calculate Ink Weight - Displays the Ink Weights window with the selected job’s ink weights and coverage
shown.

* Pause/Resume Printing/Processing - Pause or Resume the output queue of the selected job at their current
stage of processing or printing (Imaging, Rendering, Nesting or Printing). Incomplete jobs in paused queues
will display in red.

* Change Output Media - Change the Media assigned to the output queue for the selected job. Once re-assigned,
all jobs held awaiting the new Media will begin processing.

* Auto Queue Order - When enabled, any new queues will be automatically shown in the QueueManager.

Configuration Options
The following options are available from the right click (contextual) menu within the QueueManager window:

*  Queue Colour - Select a colour for the currently selected Queue for easy identification.

*  Queue Order - Organise the queues into your preferred order, or adjust any settings.

* Joblist View - View the queue in Joblist mode. This is the same as selecting Show > Jobs.

¢ Publication View - View any publications in the queue. This is the same as selecting Show > Publications.

* PrintGallery View - View the jobs as thumbnails. This is the same as selecting Show > Thumbnails.

* Edit Output - Edit the Output and not the job. For changes to be effective, resubmit the job for printing or
rendering, depending on the attribute changed.

* Edit Media - Edit the Media the job was processed with. For changes to be effective, resubmit the job for
imaging or rendering, depending on the attribute changed.

* Edit Pagesetup - Edit the Pagesetup the job was processed with. For changes to be effective, resubmit the job
for imaging or rendering, depending on the attribute changed.

¢ Edit RIP - Edit the RIP of the source file (where the job was submitted from if a configured RIP). For changes to
be effective, resubmit the job or refresh polling.

* Edit Signature Group - Edit the Signature Group used for de-imposing of the currently selected job. For
changes to be effective, resubmit the job for de-imposition.

Important Note: When editing any of the items from here, you are editing the queue for all future jobs, not just the
currently selected job.
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QueueStatus

The QueueStatus module is a progress meter that shows the current status of active jobs on the selected queue. The
look and feel can be adjusted for the QueueStatus module and the queue it is monitoring. The options are available by
right clicking on the window.

Note: Not all options listed are available on all QueueStatus windows. Some are only available while the job is in
progress.

* (Cancel Job - Cancels the currently active job and is only available when a job is active.

* JobInfo - Displays info about the currently active job.

* Pause Printing/Processing - Pauses the queue so no further jobs will process. Any job currently active in the
queue will finish. The text in the window changes to red, showing it to be in a paused state.

* Resume Printing/Processing - Takes a queue out of a paused state so any waiting jobs can be processed.

Note: The Pause/Resume function can be toggled using the tick box to the left of the progress bar. This
function also affects the Output for the queue, changing the status to Active/Inactive. Inactive Output’s are
displayed in red in the Workbench > Output > [tems list.

* Change Queue - Choose which queue the status window will show.

¢ Edit Output - Edit the output or create a new one. You can only edit if the queue is showing an output. If the
queue is set to Spooling, Auto Detect, Imaging or Rendering you can only make a new output.

*  Thumbnail - Turns on/off a mini thumbnail on the printer queues only, which gives an indication as to how
much of the current job has printed.

* Font Options - Change the size of the text.

*  Queue Order - Select which queues to view. Selecting this presents a chooser window showing two lists — The
Available queues on the left and the Showing queues on the right. To move queues between lists, select one or
more and drag from one list to another. Alternatively, double click to move between lists. The order of the
queues in the Showing list determines the order of display. Queue Order can be used to show multiple Queues
in a single QueueStatus window.

* Increase/Decrease Indent - Increases or decreases the size of the QueueStatus in view.

Double clicking the QueueStatus window displays a floating QueueManager window showing that queue. This has the
full functionality of the standard QueueManager.
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RIPMonitor

The RIPMonitor displays the RIPs that have been configured under the RIP section of the Workbench. Jobs that have
been successfully polled are displayed and can be expanded to show any associated plates. These jobs can then be
submitted to a Pagesetup/Media for processing.

View
* Toolbar - Contains job handling functions and
viewing options.
* Jobs - This is the large window to the right and
displays all successfully polled jobs from the selected

RIP.
¢ RIP List - A list of all the configured RIPs, allowing
the user to select each in turn to display any jobs.

This is on the left side of the window and can be
shown or hidden as desired. Active RIP queues are displayed in black; inactive are red.

¢ RIP Menu - This is a pull down list at the top of the window of RIPs configured and shows the current selection.
Hiding the RIP Menu will also hide the Polling On/Off drop down selector.

Note: If you only have one RIP configured it is better to hide the left RIP list and top RIP menu as there is nothing else to
display. This will provide more room to view your jobs.

Toolbar
Queues Pt Ganery | RiP L0035
1 Expand Jobs ) Collapse Jobs ) Submit... Submit For Deimposition... ) Submit As Imposition... Submit As Asset... VPress... B‘ Group By Job (" poll MToggIe RIP Polling @Show RIP Menu
™ Show RIP List

* Expand/Collapse Jobs - Show/Hide the plates associated with the selected jobs. Double clicking a job will also
expand or collapse the plate view for the selected job.

¢ Submit - Submits the selected jobs for processing. This pops up a chooser to select which Pagesetups and
Medias to send the job to.

¢ Submit for De-Imposition - Submits the jobs for de-imposition. This pops up a choose to select which Signature
Group will be used to de-impose the job and which Pagesetup/Media combination will be used.

¢ Submit As Imposition - Submits the job in it's original form, but attaches a Signature Group via a popup
chooser to allow the job to be deimposed on-the-fly using the De-Imposed Pages button in the Veripress
SoftProof Touch Console (See the “Touch Console” section for more information).

* VPress - Adds the selected jobs to the VirtualPress. For further information see the “VirtualPress” section.

Note: The text in the Submit, Submit for De-Imposition, Submit as Imposition and VPress buttons will show in italics if
the job selected has unrecognised or unassigned plates. The plates will need to be assigned using VirtualPress.

* Group By Job - Keeps the plates in their respective job group when they are copied into the VirtualPress (see
below note).

Important Note: If you have multiple jobs selected for copying into VirtualPress, when this option is ticked they are
kept as their respective jobs. If this is un-ticked, all the jobs and plates selected are copied in as one job. This is useful if
you are polling a RIP and the plates are shown as separate jobs, with one plate each.

* Poll - Initiates a manual poll of the selected RIP.
* Toggle RIP Polling - Turns the polling on or off for the selected RIP. When the RIP is in the off state, the name in
the RIP list turns red.

Note: The RIP jobs list is cached and may require clearing. To do this, turn the RIP off and on again and click on the Poll
button three (3) times consecutively.

¢  Show RIP Menu - Shows or hides the RIP pull down list at the top of the window.
*  Show RIP List - Shows or hides the RIP list on the left.
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Context Menu Options
The following are available via the contextual menu (right click) from within the job Display panel:

* Edit RIP - This enables the user to edit the RIP selected. Choose to edit a single section or all sections of the
configuration. Alternatively, you can create a new RIP.

* Colour Scheme - Choose a colour for the module.

* Font Options - Choose the preferred font size.

* Language Encoding - Choose the language encoding for the operating system. This allows jobs to display
correctly in the RIPMonitor in the native language.

Display Panel View Options
The display panel columns can be configured to show specific information by right-clicking on the header titlebar. The
following are available for display:

* Name - Job Name (and plate names if expanded).

* Size - The size of the job (disk space used).

¢ Date - The data and time the newest plate belonging to the job was RIPped.

¢ Path - The directory path to the RIPped file for an assigned job plate. This information is visible when the
polled job is expanded.

* Publication - The publication name.

* Section - The section of the publication.

* Page - The page number of the job.

ServerLog
The ServerLog shows messages from the Server.

* Fetch back log - Displays the log for the time specified. For
e.g., it retrieves and displays the last 4 hours of messages.
Choose the time period from the pull down list.

* Trim older lines - Trims the log based on the time selected
in Fetch back log. If this is set to 60 minutes, the log file is
trimmed back so only the last 60 minutes remain.

* Export - Export the log to a file. Selecting this displays a window with further options as detailed below:

o Destination File - Choose the filename and location where the file is to be saved. Use the Browse
button to navigate to your preferred location.

o Message Lines — Choose to save all messages in the log window or only those that are highlighted. This
way you can save just a few lines if desired.

o Format - Choose the format to save the file in, either html or plain text. The plain text file is saved with
tab characters between the columns.

o Cancel - Revert to the Server window without saving any changes.

o Save - Save the file based on the settings selected.

*  Configure Filter - You can filter messages in the log. Choose between the following options:

o Completed Jobs - Shows messages about completed jobs.

o Polled Jobs - Shows messages about polled jobs.

o Errors - Shows errors from the Server.

¢ Search - You can search the log for messages. Enter the text of characters you want to search for and the
ServerLog will only display the lines matching the search.

Display Options
* Module - This is the function that the Server used.
* Routine - This is the operation inside the function.
* Date - The time the Server called the module.
* Message - The message resulting from the routine.
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Status
Status shows the current disk status (usage) of the Server processing areas, such as spooling, temporary directories and
DropFolders. Editing the ss.conffile in the installation directory under the “etc” folder can change disk locations.

The available options are:

* Update - Checks the disks and updates the view. Spool I
¢ Preferences - Sets the Status window preferences. A further option
available is:
o Update Interval - Sets the time between updates.

Print &

Process &

¢ Colour Scheme - Changes the colour of the Status window. OSTemp W
* Fontoptions - Change the size of the text. Dropfolders
Thumbnail

This module displays a thumbnail of jobs as they are imaging and rendering. Thumbnail progress is updated at the
same time as the Imaging or Rendering QueueStatus is updated.

The following options are available from the contextual menu (right click):

¢ Show Imaging - Show the Imaging thumbnail, denoted by “gears” in each inset.

* Show Rendering - Show the Rendering thumbnail, denoted by a “paintbrush” in each inset.
¢ Normal Thumbnail - Displays the default size thumbnail.

¢ Large Thumbnail - Displays a large thumbnail.

*  Small Thumbnail - Displays a small thumbnail.

Each active Thumbnail module may only show either Imaging or Rendering, not both. The module window displays as
many Thumbnail insets as there are simultaneous Imaging/Rendering tasks configured in the Server Settings.

VirtualPress

VirtualPress gives users the ability to manage the plates of the job. You can drop plates, change plate colours and merge
plates from other jobs. If a job contains an un-allocated plate (i.e., no colour), use VirtualPress to allocate a colour,
unless a Replace Colour Set is selected containing the plate.

* The History keeps jobs that have been imported into
VirtualPress. Any changes or additions are kept so the R I —
jobs can be resubmitted at any time without having to O 11 Dol s masing (ol ater e
recreate the changes. The history is held while the
Client is running. Once the Client has quit, any history
is purged. A 'Submit' button to the bottom left of the = o

New

Virtual Press allows multiple VPress History items to S

be selected and printed simultaneously. B Csme.

Submit. ) Reorder Plates... ) Clea ( Clear All Dismiss

Tint
100%
100%
100%
100%

*  Quick Submit shows a pull down list of the configured
Pagesetups. Clicking this button submits the selected job to the Pagesetup shown. The option to Hold After
Imaging or Rendering is also available.

¢ Edit Plate Colour displays a colour editor, allowing you to change the colour attributes for this plate only. The
edit is not stored anywhere and does not affect the Special Colour Set. This option is also available when right
clicking on a plate.

* Choose allows you to select a colour from the colour libraries. This is only available for special plates. You can
also double click the plate in the list to choose a colour from the libraries.

* Reorder Plates allows you to change the order of the process plates. Plate position is used for Overprint,
Knockout, Opacity and Transparency simulation. The order of the list dictates the order the plates are merged
and can affect the job where plates have attributes such as Opacity. The button will appear in italics when the
order has been changed from the original.
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Applications
The applications available within Veripress add functionality to the Client and provide additional tools for managing
the Server and your jobs.

There are twelve (12) Applications available, including the Workbench and Monitor. All are accessible via the
Applications menu in the Client. Some can be launched via other Applications or Monitor Modules.

The available Applications are listed here with further details on each following:

Archives - Make partial or complete backups of your Workbench configurations.

Clustering - Allocate and manage Imaging and Rendering tasks across multiple computers and networks.
Densitometer - Measure and display density readings taken with a Densitometer or Spectrophotometer.
Displays - Create ICC profiles for system monitors for accurate onscreen colour softproofing.

FlipBook - Display a publication as a 2D or 3D virtual book.

Jobs - Display jobs before, after and during processing and allows users to manage jobs through the system to
plot their progress with a pre-configured user-interface.

Monitor - Display and manage jobs as they pass through Veripress (see the “Monitor” section for more
information).

Press Agent - Interface with press console controls to load/reload softproofs.

SoftProof - Proof jobs onscreen.

Spectro - Display, compare and/or save colours measured using a Spectrophotometer.

Touch Console - Use a touch screen to load, manage and proof jobs within the SoftProof application.
Workbench - The principal configuration tool for Veripress (see the “Workbench” section for more

information).
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Archives
The Archives Application allows you to make backups or archives of your Workbench configurations. Individual items
or complete systems can be archived for safekeeping. Stored items can be loaded into the Archives Application for
adding to the Veripress database. This can be used for copying a database to another Server, or for recovery from
failure or corrupt configurations. You can configure the Archives

ity-software.com.au:9100 - NFR (not for resale)

Application to automatically backup your settings on a regular basis.

Epson 7880
None

1440.00 by 1440.00 dpi
amvk

None

0

off

Important Note: Archives cannot be back-ported to previous
versions, i.e., version 5 archives cannot be used with version 3.

» @ £95 720dpi Pagesetup

Version 3 archives can be used with Version 5 however, and will be sl

Epson Stylus Pro
7880/9880/7450/9450,
PX-7500N/9500N Options.
Stylus Pro 7880 / PX-7500N
Premium Semimatte Photo Paper
250 Roll)

» © €75 Test Signature copy  RIP
Epson 11880 x
son 11880 Fogradd  Pageset

automatically allocated to their respective databases when loaded.

Roll Paper

Roll

File Menu Options
* Open Archive - Open a previously saved archive. Browse and
select an archive (.sdb file) to load. You can also load an
archive by dragging the database into an open Archives
Application.
* Save Archive - Saves the archive to a (.sdb) file.
* Close Archive - Closes the currently opened Archive.
¢ Perform Full Backup - Adds all Workbench data types to a new Archives Application window. Once done, you
are prompted to choose a name and location to save the file. Once saved, the Archives Application window is
dismissed automatically.
* Automatic Backup Preferences - Configure the frequency, time and location that a system backup is performed.
The options are:
o What Day - Choose a day of the week, every day, every number of days or never.
o  What Time - Choose the time the backup is performed.
o Location - Choose the location the archive should be saved to.

A check is performed when the Client is first started and every hour afterwards to see if a backup should be performed.
The Client must be running for a backup to take place. The table below gives you a guide as to when a backup would
occur in different scenarios.

Auto Backup Time Client Started Client Quit Time Backup Performed
Monday 2am Monday 9am No When Client is started - 9am
) Tuesday Tuesday 12:30pm
Tuesday 12:10pm 9:30am No
Everyday Tuesday o Whle; 2C(l)lent is s}:ac;‘ted -
12am Midnight 8:20am -clam each day
The following
Thursday
Wednesday 11pm 8:30am No Wed at 11:30pm
Sunday 10pm Monday 8am Friday 5pm Never

Edit Menu (and Context Menu) Options

* Add to Archive (All) - Select everything or all of a particular data type, for e.g., All Pagesetups.

* Add to Archive (Selection) - Select individual items from the database to add to the Archive. Selecting the type,
for e.g.,, Gradation Curves, displays a chooser with all the Gradation Curves allowing you to choose one or more
to add to the Archive.

¢ Add to Database - Choose to add items from the Archive to the database. You can add the whole Archive or
selected items.

* Remove from Archive - Remove the selected items from the Archive.

* Collapse - Collapses the selected items if they are expanded.

* Expand - Expands selected items if the item contains references (denoted by a ‘+’). For example, a Pagesetup
will contain at least a Media, an output and ICC Profiles. Expanding the Pagesetup will display the other items
connected with it.

* Open/Save/Close Archive - Open, save or Close the Archive as mentioned previously.
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Clustering
Clustering is the ability to share the workload of processing jobs across multiple devices. Slaves or cluster nodes can be
installed on other machines on the network and jobs can be sent to them from the Master for processing.

The Clustering application allows you to add and manage these cluster nodes. They can be enabled for use in imaging,
rendering or both.

As a node device starts up, its speed is calculated. When a job is submitted
for processing, the Master machine has priority as no network traffic is
required. If the Master is busy processing another job, the job can be sent
to the fastest available node. The node processes the job and once
completed, sends it back to the Master. It is then ready to accept another
job. Nodes can be installed on any machine on the network.

xxxxxx

Running a Cluster Node requires a separate Veripress dongle. If you have extra Veripress dongles, any Server can act as
anode if it is started as a Cluster Node (see “The Veripress Server” section for more information).

Note: In this mode, the Server can only be used as a Node (slave) for another Server. It is recommended that the
database be backed-up and job queues cleared before a Veripress Server is started as a Cluster Node. This avoids any
conflicts with existing job IDs or settings.

Master Panel
This panel displays information about the Master Server machine.

* Product - The Veripress software in use.

* Version - The Server software version.

* Hostname - The network name of the Master Server.

* [P Address - The network IP address of the Server.

* Speed - The relative speed of the Server, calculated by Veripress.

* Processors - The number of CPUs in the Server machine.

¢ Platform - The operating system/kernel version of the software.

* Process Imaging/Rendering/Schedule Last - Check whether the Master Server is to perform any Imaging or
Rendering Jobs. The Schedule Last option allows nodes to have priority over the Master when jobs are
processing. This is advantageous when polling large RIPs, as it allows the Master to concentrate on gathering
the list of jobs and displaying them.

Cluster Nodes
This list shows nodes that are available and running on the network. Information about each node is displayed in the
window. Online nodes are displayed in green; offline nodes in red.

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the
Cluster Node panel. Columns can be reordered by dragging and dropping them into the desired order, or by using the
Configure Headers option in the contextual menu.

The sort options are:

* [P address - The network IP address of the Node. Checkboxes become available to enable the node and select if
it is to be used for Imaging and/or Rendering tasks. Once enabled, the Master handles the clustering in the
most efficient manner possible.

* Hostname - The network name of the Node.

* Speed - The relative speed of the Node calculated by Veripress.

* Platform - The operating system/kernel version of the Node machine.

* (CPUs - The number of CPUs in the Server machine.

*  Product - The Veripress software being used for the Node.

* Version - The Server software version of the Node.

* Processing Pool - Optionally choose a Pagesetup Pool (see the Workbench - Pagesetup Pool section) for which
the Node will perform image and render tasks.

* Image - Shows the number of simultaneous Imaging tasks that can be performed by the Node. Click on the field
to change the number.
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* Render - Shows the number of simultaneous Rendering tasks that can be performed by the Node. Click on the
field to change the number (see the Server Settings for details on Imaging and Rendering task settings).

Refresh - The Refresh button polls the network for active Nodes and registers any Nodes in the list that are offline.

Cluster Node activity can be monitored in the ClusterStatus module (see the Monitor Modules - ClusterStatus section
for more information).

Menu Options
The following options are available from a contextual (right click) menu within the Cluster Node panel:

* Add Node - Add a Cluster Node that cannot be seen. Sometimes Nodes on subnets cannot be detected. Enter
the hostname or IP address of the Node and add it to the list manually. The Node to be added must be running.

* Add Processing Pool - Select, change or remove the current Pagesetup Pool for which the Node performs
Image and Render tasks.

* Remove All Offline Slaves (Nodes) - Remove a Node from the list that has gone offline.

* Remove Node - Available for offline Nodes only. This option removes the selected Node from the list.
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Densitometer

The Densitometer application allows you to measure and display density readings with a supported
Spectrophotometer. When measuring a patch, the densities of all four process CMYK colours making up the patch are
read.

The Last Measured panel in the top half of the application window shows the density and dot percentage values for the
dominant process colour of the measured patch, with the values of the other three colours to the right. The values can
be recorded and saved to a file if desired.

Note: The Densitometer application is a utility allowing you to use a Densitometer or Spectrophotometer that does not
have a display to read values. This can be as a one-off reading to compare densities, or you may want to read values and
export them for plotting on a graph. There is no requirement to use this for the normal operation of Veripress.

Densitometer/Measurement/Paper Options
*  Yule Nielsen Number - Enter the YN number for the paper you are reading (if known). The default is 2.0.
* Densitometer - Choose one of the supported instruments from the available list.
* Instrument Default Density Standard - Select your desired density standard from the available list.
* Activate/Deactivate - Connect or disconnect the chosen device.
* Add - Add the measured values to the list. This appears after the Densitometer has successfully connected.

To being measuring:

1. Select a Densitometer from the dropdown list and click the Activate button.
2. The status field is shown when the device connects without error.
3. Follow any instructions when prompted - Calibrate, Measure Cyan Solid, etc.

Measure Targets

In order to read percentage tint values of any plate, you must first read the paper white and the solid density value for
that colour. The Measure Targets menu or contextual (right click) menu allows for measuring the solid reference
densities for the process colours and the paper white. With these values stored, colour percentages can be calculated
and displayed. Measure or update an individual Solid density or Measure All Targets.

Colour List
This is a list of readings taken if the Add is enabled. Each reading is appended to the list and the values measured are
displayed. The columns can be resized or reordered as required by dragging the header to the preferred position.

The columns are:

* Name - The name of the colour read. Defaults to “Untitled” but can be changed by selecting the name and
entering a new one.

¢ Colour - Shows the dominant colour read, i.e., the one with the highest density value. This may not be the
colour you perceive it to be, but the contents making up the colour are recorded and the colour is calculated
and shown.

* Density - The density value for the colour. This is the highest density read from C, M, Y and K. It shows the
density of the colour stated in the Colour column.

¢ (Cd/Md/Yd/Kd - The C, M, Y and K densities of the colour read.

* Dot% - The dot percentage of the colour shown in the Colour column.

* C%/M%/Y%/K% - The C, M, Y and K percentage values for the colour measured. If any of the % columns are
blank, the reference paper white or solid density for that colour has not been measured.

Export
You can export the values from the Colour List to a file. The available options are:

¢ All - Saves all entries in the list.
* Selected - Save the selected entries in the list only.

Selecting either of these options displays a window allowing you to choose the values to be saved. The choices are:
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¢ Name - Save the name of the colour.

* Colour Density - The highest density reading regardless of colour.

* (Cyan/Magenta/Yellow/Black Density - The density reading of the chosen colour. For e.g, if Cyan is selected,

the Cyan density for each reading is taken. This is the value displayed in the Cd column of the list.
* Colour Percentage - The percentage reading of the highest density read as displayed in the Dot% column.

* (Cyan/Magenta/Yellow/Black Percentage - The percentage reading of the chosen colour. For e.g., if Cyan is
selected, the percentage of Cyan for each reading is taken. This is the value displayed in the C% column of the

list.

The percentage values must be present for the values to be exported. If they are not, the exported file will show a 1%

value in place of the reading.

* Order Values - Choose whether to export the file in CMYK or KCMY order.

* Separate Values With - Choose to separate the values with either a tab character or a space.

* Cancel - Cancels the Export action.

¢ Export - Displays a file chooser allowing you to enter a name and select a location to save the file to.

Table 1 - Supported Density Standards

Density Standard - Status
Instrument E I T Default
DTP41 v v v v
DTP34 x x x v
DTP22 v v v v
DTP20 v v v v
Spectrolino x x v v
EyeOne x x v v

Not all instruments support all density standards.

This table is not a complete list. Consult your instrument user guide for more information.
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Displays

The Displays application uses a supported Spectrophotometer to calibrate and create an ICC profile for a selected
monitor or light booth. Suitable graphics monitors can be calibrated to match a chosen print gamut, allowing colour
accurate softproofing of print material and can be verified at any time to ensure correct colour output.

Creation of a profile is very simple, requiring a supported instrument and a few minutes of time. The
Spectrophotometer is placed on the screen to be calibrated. A series of adjustments are made to the screen gamma,
white point and brightness (if available). Measurements are taken, from which an ICC profile is created and saved in
Veripress and the operating system as the native display ICC profile.

Note: The Displays application creates a profile for use with the Match ICC profile assigned to the monitor in Server
Settings. Ensure the correct match profile is set before creating the monitor profile (see the Server Settings — Colour
Management section for details).

The Displays interface comprises of a function list (left) and a multi-purpose display area (right) that will change
depending on the function selected.

The function list is made up of the following selectable items:

Calibration
iMac ¢ Calibration - Lists each connected display available for calibration.
Calcheck *  Calcheck - Lists each connected display available to calcheck.
iMac * History - Lists the calcheck history (reference only) of each connected display.
History * Ambient - Measure the ambient and white point of the light source.
Mac . Sight Booth - Appears only when a light booth is connected and will list each connected
evice.

Ambient
Light Booth
Just Normlicht

Calibration
The Calibration function displays currently connected monitors and their calibration status.

By clicking on the Calibration header, each connected monitor shows the following
details:

=
. i ) e ) ) i . Display iMac
¢ The name of the Display and its identification number (in a multi-display Pixels 1920 x 1200
. Resolution 93.78 x 95.25 DPI
env1ronment). ICC Profile iMac-070911.icc
*  Pixels (width/height). Status OK
. Last Calibrated 7/09/11 1:09 PM
° ReSOIutlon (DPI) Calibration Expires Never
¢ ICC profile. Hardware Calibrati

¢ Calcheck Status.

¢ Last Calibrated (time).

¢ (Calibration Expires (time period).

* Hardware Calibration (supported or not for the particular display).

By clicking on the Display name, calibration options and settings available for the monitor are shown. These include:

* Brightness - Only available if hardware calibration is supported and selected for the monitor (see below).
Choose to set the brightness level in either:
o Candela - Brightness in cd/m?

O 16000 [:} cdfm?

o Setthelevel from 0-100% O o [ S Y
o Measure - Click to use a connected O (vesure )

Spectrophotometer to measure and display the [ 5 5

brightness (cd/m? and white point (K) of the seooe

monitor. Follow any onscreen instructions for the cans

selected instrument. The reading is constantly TﬁL@ o
updated, allowing the user to manually adjust the ‘ :
brightness using the monitor’s own controls. This option is only available if the Use Software
Calibration option is selected or is the only mode available (see below).
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White Point - Select the white point temperature for the monitor. Choose from:
o Custom - Type in the field provided or use the slider to enter a custom temperature in Kelvin (K).
o D50 - Sets the white point to D50 (5003 K/Horizon Light).
o D65 - Sets the white point to D65 (6504 K/Noon Light).
o Native - Sets the Displays application to use the monitors native white point.
Gamma - Select the gamma correction to be used for the monitor.
o Custom - Type in the field provided or use the slider to enter a custom gamma value between 1.0 and
2.6. The Custom button will auto-select if a non-standard gamma setting is chosen. Note: If either 1.8
or 2.2 are chosen, the 1.8 or 2.2 buttons will auto-select.
o 1.8 - Select this to set the gamma correction value to 1.8. This button will auto-select if 1.8 is chosen
via the Custom field/slider option.
o 2.2 - Select this to set the gamma correction value to 2.2. This button will auto-select if 2.2 is chosen
via the Custom field/slider option.
Options
o Use Hardware Calibration - When supported, this option uses the monitor’s own internal hardware
for calibration.
o Use Software Calibration - Calibration is performed using the Displays application software.
Instrument (offline/online) / Instrument Name - Displays the currently activated instrument.

o Instrument - Select from the list of supported e : :
Spectrophotometers to use for display calibration. Y Seeren et e S
o Display Type - Select the type of display being |, P —

calibrated from LCD, CRT or RAW.
Monitor Identification Number - Click to popup an identification number in the centre of the screen for the
display to be calibrated.
Calibrate - Click this button to start calibrating the selected display to the chosen settings and create the
display ICC profile. Follow any onscreen instructions for your instrument. When calibration is complete, a file
chooser will popup to name and save the ICC profile. The profile will be saved as the operating system native
ICC profile for the display and will appear as the Native Profile in Serendipity Client Preferences > Colour
Management (see System Settings for more information).
Save Profile - Opens a file chooser (as above) to save or rename the ICC profile.
Information Panel - Appears while the ICC profile is being generated, showing the progress and final results of
the calibration process.

Calcheck
The Calcheck function displays Calcheck status summaries for all attached monitors, as compared to the values defined
in the Calcheck Chart assigned to the SoftProof Default Press and Camera setting.

Clicking on the Calcheck header allows users to quickly view whether a display is currently calibrated for softproofing a
particular press profile. See Applications > SoftProof;, Workbench >

Press for details. =
Note: If a Calcheck summary is blank, this means: T — L
A:: I
No Calcheck data exists for the monitor; e —
That the current Calcheck for the monitor was measured [ = =SS o
against a different Calcheck Chart than the one assigned to the |5 S
SoftProof Default Press; or o ——
No Calcheck Chart has been assigned to the default Press. - v
Softproof Calcheck Status e o —
Softproof : Default Press Instrument  Gretag |
Press M Auto SoftProof Press Massurement type | uate ¢

The top section of the display area shows:

Calcheck Chart

Morvtor Cameater (ofinel
InMrument | Cretag Eve-One 8] o @

Measurement 1y U.dse centre of screen 3] [ Measure

Press — The currently selected SoftProof default Press configuration.
Calcheck Chart - The Calcheck Chart assigned to the above Press configuration.
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The remainder of the display area shows the current Calcheck status of each connected monitor. Information includes:

* Process Colour/Gray/Paper delta values

* Average/maximum/standard deviation delta values
* Display name (top left)

* Timestamp of the last Calcheck (top right)

* Chart and Instrument used (bottom left)

* Overall Calcheck score (bottom left)

Note: In cases where multiple areas of a screen have been calchecked, the summary will display the worst results from
across all calchecked areas.

Clicking on a Display name under the Calcheck header (e.g., iMac) will allow the user to perform a Calcheck on the
chosen monitor.

The main part of the display area (white box) will show the detail or summary of the Calcheck as it is performed.

The top section above the main area has the following options:

e A All - Shows all of the A results measured, as defined in the Calcheck Chart. OAIT] e | AH | AC

* Ae - Shows all of the Ae results only. The Ae standard used
(DeltaE/CIE94/CIE2000) is selected in the Calcheck Chart (see Workbench > Calcheck Chart for details).
CIE2000 is a recommended standard to use for display verification.

¢ AH - Shows all of the AH results only.

¢ AC - Shows all of the AC results only.

¢  Summary button - Shows Calcheck summary results. X‘/

* Detail button - Shows results for each measured patch of the Calcheck Chart.

The lower section of the main display area contains the following:

¢ Screen Area buttons - These buttons enable the user to look at — _ : — e
results from one of the nine (9) defined areas of the monitor = |G| G| B | 2| Ca ) e | G |
screen. The buttons are grayed out (cannot be selected) if a
screen area has not been calchecked. Areas that have been checked will enable the button and show whether
the area passed (green) or failed (red) a Calcheck.

¢ Instrument (offline/online) / Instrument Name - Displays the currently activated instrument.

o Instrument - Select which supported Spectrophotometer is to be used for the Calcheck.
o Measurement Type - Select which area of the screen to Calcheck or Calcheck the whole (3x3 grid)
screen. The middle centre of the screen if the default option for standard Calchecks.

History
By clicking on the History header, users can see at a glance the Calcheck summaries for all attached monitors. This is
useful for keeping track of any changes in your monitor’s performance (i.e., drifting).

Information includes:

* Process Colour/Gray/Paper delta values

* Average/maximum/standard deviation delta values
* Display name (top left)

* Timestamp of the last Calcheck (top right)

* Chart and Instrument used (bottom left)

* Overall Calcheck score (bottom left)

801 77118
802 I W s6.62, 20.2: 2 st 05:
803 I I . 29.85.30.72_32.00,20.87.30.74 024

These summaries show Calcheck results for the monitor(s) in relation to
the Calcheck Chart used at the time of checking (shown at the bottom left of the summary). The summaries are
independent of the currently assigned SoftProof Default Press / Calcheck Chart although, in most cases they will match
the current Calcheck summaries (see above section).
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Clicking on a Display name under the History header (e.g., iMac) will allow the user to review past results of Calchecks
for the monitor. The window shows a sort list of previous Calcheck results, with the time and date the Calcheck was
performed and the Calcheck Chart used. Selecting a history item will display a summary or the detailed results.

Ambient
By clicking on the Ambient header, the option to select a supported —
Spectrophotometer becomes available to measure the ambient (cd/m?2) Iseumens 167 510,1:170.406, 2102050

and white point (K) of the light source, e.g., a light booth or room. pe—

nt = 154.72 cd/m?, Wi
5307

¢ Instrument (offline/online) / Instrument Name - Displays the
currently activated instrument.

* Measure - Select from the list of supported ambient-mode
Spectrophotometers to use for measurement.

Note: For some Spectrophotometers, after initial instrument calibration,
an ambient light filter will need to be attached before measurement.

The lower, white area displays constantly updated measurements.

Light Booth
By clicking on the Light Booth header (when available), any currently connected
light booths will be shown.

. . . Display Just Normlicht
Each connected light booth shows information on: S~
Resolution
* Name/Model ICC Profile
e  Driver Status
* Driver Version Last Calibrated
Calibration Expires
Clicking on a light booth name under the header will make calibration options RrivericlNamepiu=tuoctinso
. . Driver Version 1.02
available for the booth. These include: o
Hardware Calibration

* Brightness - Choose to set the brightness level in either:

o Candela - Brightness in cd/m? soahes
o Setthelevel from 0-100% e ;
* Instrument (offline/online) / Instrument Name - Displays the ot ‘ ‘
currently activated instrument. eument Greas cre-One =
o Instrument - Select which supported Coons)
Spectrophotometer is to be used for the light booth | i uminarceorss.16 com, untepoin ofsasss
calibration.

o Adjust - Click this button to calibrate the brightness of
the selected booth. Follow any onscreen instructions.

Note: For some Spectrophotometers, after initial instrument calibration, an ambient light filter will need to be attached
before placing it in the booth and commencing the booth adjustment.
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FlipBook

The FlipBook application is used to view a publication as a virtual book. In Veripress, a publication is defined as a group
of pages with the same publication name. This is a collection of book or magazine signatures that have been de-

imposed, but a publication may consist of any number of pages.

FlipBook allows you to load the publication and flip through

pages as you would with a real magazine or book. This enables Name: Publication 123016680 (Pages) | | StantPage: 3 [J TopPage: | OQfven @ Oud
you to check that the de-imposition has worked correctly, that
pages are in the correct order, orientation and if there are any <’3
duplicates. Larger views of the pages can be called up and the
whole publication can be exported to PDF or as a QuickTime
movie.
FlipBook can be opened in three ways: 9
1. From the Application menu of the Serendipity Client.
Publications can be dragged and dropped from the
QueueManager into the FlipBook window and will open
automatically.
2. From the QueueManager appllcatlon by SeleCtlng a ]Ob 19532 GOLF TEXT.JQb(IMPOSITION)PageSlII 19532 GOLF TEXT.job (IMPOSITION) Page 7
and choosing View Flipbook. The View FlipBook option ————— 3
is only available if the job has a publication name. 3 [Tl ] o] el ) 1) 16 ) 1s
3. From the BookMonitor application by selecting a

©® O O FlipBook<2> - i devel. ipit ftv om.au:9100 - NER (not for resale)

Publication Pagination

Publication title and choosing View FlipBook. If the
pages for the selected publication title have not been imaged or rendered in the QueueManager yet, the
FlipBook will open but will not show any pages.

The FlipBook window comprises of four (4) main panels - Publication, Pagination, Page View and Page Index.

Publication Panel
This panel contains the name of the Publication being viewed.

Pagination Panel

Start - Enter the page number for the starting page or use the arrows to select the first page number of the
FlipBook. If the first page loaded is page 1, you cannot alter the start page number. If the first page loaded is
greater than 1, you can enter a lower value as the start page number. This can be used if you are viewing a part
publication where the first pages have not been processed.

Top Page - Choose whether the top page of the FlipBook is Even or 0dd.

Page View Panel
This panel is where the FlipBook pages can be viewed. When a FlipBook is opened, the pages of the publication are
loaded and displayed in 2D (two-dimensional) view. There are various ways to navigate through the publication:

Clicking on the page of the image - If you click on the right page, you move forward through the publication.
Clicking on the left page moves backwards.

Clicking on the pages in the Page Navigator Panel - displayed below the Page View panel. The view jumps to
the page (pair) you select.

Space Bar - The space bar moves forward to the next pair of pages. Hold the shift key and press the space bar
to move backwards.

PageUp/PageDown - Use these buttons on the keyboard to navigate forwards and backwards through the
publication.

Arrow Keys - Use down or right arrow keys to move forward through the publication and left or up to move
backwards.

Scroll Bar - Moving the scroll bar below the image moves forwards or backwards through the publication.
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Page View (Contextual Menu)
There are various options available from the context (right click) menu:

* Open Publication - Opens a QueueManager showing all jobs processed in the system. Select a job or publication
job to load and click OK.

* Reload Publication - Reloads the current publication with files from the queue. This is used if additional files
have been processed as part of the publication, or changes have been made and the publication needs to be
updated.

* Choose Press - Select a Press configuration to apply to the job currently (and subsequently) loaded into the
FlipBook. (see Workbench - Press for details)

* Job Info - Displays the Job Info information about the currently selected page. (see Workbench -
QueueManager for details).

* Swap Page with - Swap the page currently selected with another page from the same (currently loaded)
publication.

* View Original - Opens and views the imaged file of the selected page in the SoftProof application.

* View Printed - Opens and views the rendered file of the selected page in the SoftProof application.

¢ View 3D - Toggles between a 3D or 2D view of the publication. Three dimensional viewing shows the page
turning as you navigate through. The turning speed can be adjusted FlipBook Settings.
3D mode adds 2 sliders on the right side of the Page View. The first alters the angle at which the 3D virtual
book is viewed, the second zooms the view in and out.

Note: The performance of the page turning may vary depending on the size of the thumbnail being viewed and the
performance of the graphics card.

¢ View as Calendar - Only available in 3D mode. Changes the flip axis to horizontal so pages flip up and down in
the same manner as a calendar.
* Export - Exports the FlipBook as a PDF. Select the resolution, compression type and quality. Choose between
exporting the whole book or a range of pages.
* Export as Spreads - Exports the FlipBook as a PDF but as spreads. The same options as above apply.
* Export as Movie (3D view mode only) - Exports the FlipBook as a QuickTime movie. After selecting this there
are three further options:
o Codec Type - Choose the preferred compression type from the menu.
o Quality - Choose the preferred quality.
o Keyframe Spacing - Choose how often a keyframe is saved.

The settings you choose will affect the size of the movie, the quality and the compatibility with other applications.
There are many Codec types available and not all work on all systems. Commonly used types are Apple MPEG4 and
H.264 avcl. Increasing the quality setting also increases the file size. This is also true for the keyframes. The more
keyframes, the better the quality but the larger the file size. Trial and error will provide you with the desired result.

* Render Queue Thumbnails - View the Rendered thumbnails in rather than the default Imaged thumbnails.

Page Index Panel
The Page Index displays a numbered box for each page making up the loaded Publication. It allows for direct navigation
to any page by clicking on it.

The page boxes are colour coded:

Light Green indicates the pages are loaded into the FlipBook and can be viewed. These show as dark

green when selected.
2 3

Purple indicates there are duplicate pages, i.e.,, they have the same publication name and page
numbers. Dark purple indicates the pages are selected.

Clicking on these pages allows you to select and view the alternative page:

I 10 1r 1r 10 =1 =T ir —

19532 GOLF TEXT.job (IMPOSITION) Page 7
19532 GOLF TEXT.job Page 007 (IMPOSITION 07)

22 3
38/ 3
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Light Red indicates the page is not in the FlipBook. This occurs when there are other pages

116 117 greater than the numbers displayed. This could be due to the imposition signature not yet being

rendered. As they render, you can simply reload the publication to update the pages.

The status colours are updated whenever Reload Publication is selected.

A bar directly above the Page Navigator displays the Job Name for each currently viewed page on the left and right sides
respectively. Pages with more than one version will show a dropdown to select which version to view. The Page
Numbers being viewed are shown in the centre of the bar.

Menu Options
The following are available from the FlipBook File Menu:

Open Publication
Reload Publication
Export

Export as Spreads
Export as Movie

Two other options are also available:

Edit Touch Console Ul - Opens an Edit Interface window allowing for the configuration of the buttons enabled
(and visible) for control of the FlipBook in the Main screen of the Touch Console (see the Applications - Touch
Console section for more information). Enable or disable buttons by clicking on them. Those disabled will
appear with a red cross and will be excluded from the Touch Console when using it to view a FlipBook.

The Toolbar has a Preview toggle to see how the Touch Console controls will appear and a Reset button to
restore and enable all buttons.

FlipBook Settings — Configure the FlipBook viewing options and press configuration.

View Options
o Allow Multiple Windows - Enable or disable. Allows multiple Publications to be opened and viewed in
separate FlipBook windows. If disabled, a newly opened Publication will replace the one currently
being viewed.
Page Order - Choose between reading left to right or right to left.
Flip Time (3D) - Select the speed for the flipping of pages when in 3D mode.
Render Queue Thumbnails - Enable or disable render queue thumbnails.
Show Borders (2D) - Enable or disable the borders when viewing in 2D mode.

O O O O

Press Configuration
o View or change the Press configuration FlipBook uses to display Publications.

FlipBook Settings FlipBook Settings

Comer) @ (Ganes) (0K

View Menu
These options are also available from the FlipBook View Menu:

View 3D
View as Calendar
Ink Weight - Opens the Ink Weights window displaying the FlipBook publication’s ink weights and coverage.
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Jobs

The Jobs application is used to display jobs before, after and during processing and allows users to manage jobs

through the system to plot their progress.

The Jobs application consists of an easy to navigate user-
interface, with tabs and layouts available for various
monitoring functions. Tab layouts may be added or managed
according to individual preferences and are saved at the Client
level, allowing different users to display information
appropriate to their location and workflow.

Jobs is the default monitoring application and will be run

automatically on launch of Veripress after the initial software
installation.

Menu Options

Tabs Menu

Job Queues

Show:

i

* Add Tabs - Add a new tab to the Jobs application window. Select from a list of factory default layouts. New tabs
can be imported for use via the Manage Tab Library option.

The factory default tab layouts available are:

o Job Queues (default loaded view)

o RIPMonitor - Adds a tab with the RIPMonitor module.

o Status and Drop - Contains the MediaStatus, Status, QueueStatus, DropZones and ClusterStatus

modules.

o Logs - Contains the ServerLog and ClientLog modules.
Jobs - Contains the QueueManager module with the Jobs view selected.
o Drop Area - Contains the DropZone module. Right-click to add any additional dropzones to the Drop

o

Area tab.

o ServerLog - Contains the ServerLog module only.

¢ Rename Tab - Rename the selected tab.

* Manage Tab Library - Add, remove or preview tab layouts for Jobs application.

* C(lose Tab - Close the currently selected tab.

View Menu
* Previous tab - Opens the previous tab window.
* Nexttab - Opens the next available tab window.

* Titlebars - Show or hide the titlebars for each module within the Jobs application tabs. This will show or hide

all titlebars in all tabs and is not limited to the currently selected tab.

Job Queues Tab

The default tab layout (Job Queues) for Jobs application contains the following modules:

* QueueManager

¢ Thumbnail - Imaging Preview

¢  Thumbnail - Rendering Preview
¢ QueueStatus - Imaging Queue

For information on each module, see the relevant sections of this manual.
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Monitor
The Monitor application is an alternative user-configurable version of the Jobs application, central to the Veripress
Client Interface (See Applications > Jobs). Like Jobs, it displays jobs before, during and after processing and allows users
to manage jobs through the system to plot their progress. The = —————————
Monitor provides feedback from the Server and Client via logs. |z
Modules can be added and configured to suit specific
requirements. See the Modules section for further information.

The Monitor consists of one or more user-defined tabs. Modules
are added, positioned and sized according to individual
preferences. Settings are saved at the Client level, enabling
Serendipity Clients on different systems or in different
departments to display information appropriate to their location.

The Monitor can be in one of two modes - Edit or Use.

Edit

This mode allows the user to move and resize modules on a tab.
The mouse pointer changes to a cross when in Edit mode. Resize a module by grabbing the corners or sides and
dragging to the preferred size. Click anywhere in the modules and drag it to the desired position. Modules close
together will snap-to each other.

While in Edit mode, all Monitor Modules have a contextual menu available (right-click) with the following options:

* Remove (Module) - Removes the module from the Monitor tab.

¢ Set Size For (Module) - Allow the user to enter a width and height (in pixels) for the selected module via a
resize popup.

* Duplicate (Module) - Duplicates the selected module. The duplicate has all the size, layout and configuration
options of the original.

* Use Layout - Switches the Monitor to Use Mode.

Use
This is the normal user mode. It locks the module sizes and position and allows you to configure the modules
preferences and manage jobs. Select this after Editing to use the configured layout.

Menu Options

Layout
¢ Edit - Switches the Monitor to Edit Mode (see above explanation).
¢ Use - Switches the Monitor to Use Mode (see above explanation).
* Dynamic Update - Enables or disables updates to the modules while in Edit mode.
* Show Titlebars - Shows or hides module titlebars.
* Add Modules - See the “Monitor Modules” section for further information on each module.
* Load - Loads a previously saved Monitor configuration.
* Save As - Saves the current Monitor configuration.
* Search Ul (User Interface) - Activates a search bar for finding buttons and functions in the current Monitor tab.
Note: Module Toolbar functions can only be searched if the toolbar is open.

* New Tab - Creates a new tab.

* Rename Tab - Renames the currently selected tab.

* Duplicate Tab - Duplicates the currently selected tab and all modules within it.

*  Choose Tab Colour - Select a colour for the currently selected tab.

* Choose Tab Image - Select an image for the currently selected tab background. Valid types are PNG and JPEG. It
is recommended a large image not be used, as it will take up memory.

* (lear Tab Colour/Image - Reverts to the default background colour.

* Remove Tab - Deletes the currently selected tab.

* Remove All Tabs - Deletes all tabs.

* Next/Previous Tab - Switches to the next or previous Monitor tab (right or left).

Reordering Tabs
Tabs can be moved to a new position by clicking on and dragging the tab to the desired place in the order. A red pointer
appears, showing the drop point between two tabs.
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Press Agent
The Press Agent application allows Veripress to be connected to a Press console through a network port.

After selecting the appropriate Press Agent Driver, a press operator can load or turn softproofing jobs/pages using
press console buttons.

Other options include interfacing with a press desk camera. The press operator turns a hardcopy page on the press
desk - Press Agent will use the page recognition data from the camera/console to automatically load the correct left and
right pages, or page spreads.

800 Press Agent - idevel.serendipity-softy 9100 - NFR (not for resale)

Fetch back log: [ al = Export... ) RN

Mes:
Start Configure Headers...

e v Press
e 4/02/093:56 PM  Start v Date
e 4/02/093:56PM  Stop. v Message

Log
The Press Agent window has a central Log panel to show
events/messages/commands received from the press console while

the Agent is active.

tart.
e 6/03/09 3:51PM  Stop.
e 6/03/09351PM  Start
s omniPage  6/03/09 3:51PM  Stop.

2909098

The following sort columns can be selected by using the contextual Gos ot ) CComowe.) ()
(right click) menu on the column header bar. Column order can be
changed by dragging and dropping the columns, or by using the Configure Header option from the contextual menu:

* Press - The Press console that generated the event/message/command.
* Date - The date and time of the event/message/command.
* Message - The event/message/command generated by the press console.

Log Options
* Fetch Back Log - Displays the log for the time specified. For example, it retrieves and displays the last 4 hours
of messages. Choose the time from the dropdown list.
¢ Trim Older Lines - Trims the log based on the time selected in Fetch Back Log. If this is set to 60 minutes, the
log file is trimmed back so only the last 60 minutes remain.
* Export - Export the log to a HTML or tab delimited text file.

Interface Options
* Press Agent Driver - Select the required Press Agent Driver from the dropdown list of supported press
consoles.
* Configure - Opens a Configuration pop-up for the selected Press Agent Driver. Available options vary
dependent upon the press console driver.
* Configure is not available while the Press Agent is running. Hit Stop if settings need to be changed.
e Start/Stop Button - Starts or stops the Press Agent.
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SoftProof
The Softproof application is used to proof a job on the screen. There are many tools available to check every aspect of
the job at any stage of production or processing. SoftProof can be used in conjunction with or instead of a hardcopy
proof. Using a calibrated monitor and configured press settings, proofs
can be viewed and verified onscreen with precise colour accuracy.

All job plates are shown and can be turned on or off, or changed as EPLL
desired. Colour attributes and plate characteristics can be changed to | S
see the effects of different printing processes, including paper types | BgEad
and the effects of show-through from the reverse side. The data can be =
exported to various file formats, including CIP3 and PDF. An Ink Key ¢ o

Viewer can display a job as it would be on the press, with the values for
each key shown. The ink weight can also be calculated and over-ink
areas identified. The proof can also be verified using the Displays
application to give a pass or fail status in accordance with colour
standards.

Layout
The SoftProof application consists of a large, central viewing window for jobs; a visual Tools menu on the left and a
View panel to the right; a Navigation Thumbnail at the top right; and a status bar along the bottom of the window.

Navigation Thumbnail

This thumbnail shows the entire image loaded for softproofing. The area currently shown in the
main viewing area is represented by a rectangle on the thumbnail. Mouse over and left-click to
view a new area of the proof.

Status Bar
This bar shows the information about the currently loaded proof, the SoftProof Press Setting and the current
calibration status of the monitor in relation to the

Press Setting (See Applications > Displays for more | softproof - Nested job 19078 (Printed preview) 50% & Auto Softproof Camera
information on screen calibration).

The left of the bar displays:
* Jobname (Original/Printed Preview) and current zoom level %

The right of the bar displays:

» Auto Softproof Camera @ Embedded ICC Profile: Adobe RGB (1998)

¢ Current Press or Camera settings, along with the
Embedded ICC Profile for the image (if applicable). Use the tick box to override the currently selected Press or
Camera profile and enable the embedded ICC profile.

Clicking on the Press or Camera profile button will popup a menu with the option to choose another Press/Camera
setting if available.
& |- Auto Softproof Camera | p

When Calcheck Managed is enabled (see Client Settings), the far right of the status bar will |¥ ¢ A:é‘;fl‘jtl‘ggm e
display a red cross or green tick, noting whether the current SoftProof display has passed a e
Calcheck against the Chart assigned to the currently selected Press. Choose Camera...

Hovering the mouse pointer over the cross or tick shows a tooltip (when Tooltips are enabled) displaying information
including:

Status: OK
application, Calibrate option). Eupires: Naver o

Filename:

* The Calcheck Chart assigned to the Press/Camera Settings currently used in | |fepe/mndviibrenColosine/profies/ivac
SoftProof and the current Calcheck status of the monitor.

* The ICC profile used by the monitor (normally created using the Displays IcC profle l
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Click on the Tick/Cross to popup a menu with the following options:

* (Calibrate - Begin calibration of the monitor using the current settings Bia,.bfm
and Spectrophotometer assigned in the Displays application. When Saicheck monites Medlaedaeys, PiOcoared V2. edl Fogradd )
calibration is complete, select an appropriate name for the ICC profile and click OK to save.

* (Calcheck Monitor - Begin a Calcheck of the monitor using the Calcheck Chart assigned to the current Press
setting. The pass/fail status may change as a result of the check. Detailed results can be viewed in the History

area of the Displays application

Tools

Pan - Navigate around the image by clicking and dragging the job around the screen.

¢ Zoom - Zoom in or out of the job. Clicking the mouse zooms twice the current percentage factor.
SHIFT+Click will zoom out half the percentage factor. Click and drag over an area to zoom it.

* Note - Create, manage and delete notes.

Measure - Take a measurement on the image. Use the shift key to draw straight lines.

* Crop - Crop an image and resubmit it.

* Guide - Display guide lines on the image to check for alignment. Change the orientation by pressing

SHIFT. ESC will remove the guides.

* Spectro - Take measurements of the job being viewed. A popup window will appear displaying the

Lab/Lch/XYZ/Density values at the point the Spectro cursor is onscreen.

A&

e

Veripress only - Additionally, the Spectro Tool gives the user the option to choose an instrument which can
be used to measure a hard proof. The measurement taken is compared to the softproof and the deltaE
displayed onscreen.

SoftProof Widgets
There are four (4) sliding widgets available from the left panel of icons in the SoftProof viewing window.

J These include:
[IH ¢ Channels
e Publications
‘-l ¢ InkKeys
o ¢  GetInfo
Channels Widget

The Channels Viewer shows the channels or plates of the job currently being viewed in SoftProof. Plates can be turned
on or off by clicking the relevant coloured checkbox to the left of the plate name
and can be reordered by clicking and dragging to a new position. The plate colour |4 — S—
and associated attributes can be changed by double-clicking a choosing another . :
Special Colour Set from the library, or edited for that SoftProof instance only.

o

B Magerta 16.86%
Yellow 93.73%

a

Backe 15.69%

* Name - The plate name. The checkbox indicates whether or not the plate is
displayed.

* Value - The percentage of colour at the point of the cursor in the window.
Total ink displays the total amount of ink at the point of the colour selector,
i.e., the sum of all plate percentages. For RGB it will show the relative RGB
values only.

The contextual menu (right-click) reveals additional options for non-RGB jobs only:

* Choose Plate Colour - Select a plate colour from a Special Colour Set for the selected channel. Double-clicking
will display the same Special Colour Set window.

* Choose Paper Colour - Select a colour from the Special Colour Set to use to simulate the paper colour. Once set,
the option to revert becomes available.

¢ Edit Plate Colour - Displays a colour editing window to edit the selected colour for the current SoftProof
instance only. The edits are not stored in a library.
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Apply a Replace Colour Set - Select a Replace Colour Set to apply to the job. Any plates matching the set will be
replaced.

Revert All Plates to Press Settings — Changes all plates back to the press configuration currently selected.

Apply Blueline Set - Replaces all colours with varying shades of blue to see any traps or bleed issues.

Publications Widget
When softproofing a job that forms part of a publication, additional controls and [&
. . . . ‘. P s
view options are available: o] [Coure
) Show Bach Puge
* Single Page - Display just the single page selected. Disabling this option il

enables the following:
o Show Back Page - Display the reverse side of a page through the el
page currently loaded, as if the final print was being held up to
the light. The Back Page Opacity setting in the Press Settings
controls the amount of show-through.
o Show Page Spread - View the spread of the selected page, for example, pages 2 and 3 as a spread.
Edit Imposition - When an imposition flat is loaded, changes can be made to the Signature Group here without
closing SoftProof. Any alterations can be viewed using Signature Overlay.
o Show Signature - Overlays the signature used to de-impose onto the image. This is only available if the
job has been de-imposed.
o Show Deimposed Pages - When an imposition flat is being viewed, SoftProof will show all available
pages when this is enabled. Each page from within the imposition may be previewed via the Page
Index tab.

Ink Keys Widget
The Ink Keys icon will display the Ink Key Viewer containing the loaded image in the SoftProof window.

At the bottom of the window will be a series of ink keys. Colour bars give a
graphical display of the proportion of each ink contained within the job across the

keys.

For each key selected, the relative percentage of ink for each of the plates is
shown. An information panel runs down the right side of the window. The top of
the panel shows information about the currently loaded Press Settings. Job view
and placement can be changed and ink weight can be calculated for any job.

0.029g

Colour checkboxes - Positioned above the image, these show the inks or
plates used in the job. Cllcklng on one will turn the gthers qff and leave the T — —
ticked colour on. SHIFT+Click allows for multi-selection of colours.
Double-click to show all.
Ink Keys - The keys at the bottom of the window show the inks selected to be viewed on a graph. The scale of
the graph varies, depending on the amount of ink in the job. Hovering over or clicking on an ink key will display
the key number and its ink values at the bottom of the information panel.
Press Settings - Shows the values for the currently loaded press. Click the box to show or hide the details. Press
settings used are selected in the Default Press panel of the SoftProof Settings.
Show Excess Ink Weight Area - Display areas exceeding the Maximum Ink Weight setting as defined in the
Press configuration.
Max Ink Key Value - Set the size of the ink keys to match your press. Ink values are calculated based on the size
entered. If the size is 100, percentages are displayed.
Sheet Placement - Show the job as positioned on the press sheet defined in the configuration. The job can be
centered (selecting the Centre checkbox), or offset from the left (X) and bottom (Y). De-selecting this displays
the whole job in the viewer and changes the ink keys to show total ink amounts for the job.
Ink Weight Calculator - Calculate the amount of ink required to print (x) number of copies.

o Print Run Size - How many to print.

o Ink Weight (g/m?2) - Enter the weight of the ink used in grams per square metre.

o Calculate - Based on the values entered for ink weight and print run size, the total weight of ink for

each colour will be calculated for the loaded job and displayed in the ink value area.

Contextual (right-click) menu options include:
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* Show Ink Key Table - Shows a separate window, listing the ink key values of all keys for each plate. These can

be printed using a local printer or exported to PDF.

¢ Export Tab Delimited - Exports the values for the keys and ink values to a tab delimited text file.

Get Info Widget

The Get Info icon will display job information about the currently viewed image in SoftProof -
how it was processed, what Pagesetup and Media were used and other useful processing
information. Click the icon again to hide the panel.

Loupe

The Loupe is available via the sidebar menu. Once opened, the Loupe will appear
with the default setting “Loupe to Mouse” enabled.

Loupe Options (accessed via the Spanner icon):

* Screened Pixel Readout (Veripress/Blackmagic Softproofing Add-On
only) - Toggles the HUD between crosshair point measurement of ink
percentages and a square for measuring area average dot percentages.
The square resizes depending on the zoom level to always cover an area
equal to a full halftone cell at the LPI defined in the SoftProof Settings.

* Screening LPI - Enter the desired value for screen ruling for SoftProof in
Lines Per Inch (LPI). The defaultis 150.

* Loupe to Mouse - This is enabled by default. The mouse pointer location
is used as the reference point for the Loupe display. This allows you to
position the Loupe off image and use the mouse to display the relevant
part of the image within the Loupe for proofing.

* Rulers - Turn rulers on or off. The rulers will appear in the Loupe
window with measurement units displayed. The rulers are centered or at
the mouse pointer location if held over the Loupe window.

The Loupe is moved around the SoftProof by left-click and holding to drag it.
The Loupe can be resized by clicking on the button with 3 lines (see image) and
dragging outwards. The mouse scroll wheel will also increase/decrease the

Loupe size when the mouse is positioned over the window.

A number of display and control options are available via the buttons at the
bottom of the Loupe window:

-\gmng and prod

and df

ucing quality
jesigns, and
2 is properly

MeNoO Loupe Options

Screened Pixel Readout
Screening LPI | 150

™ Loupe To Mouse

__ Rulers

+ (button) - Click to increase the zoom factor of the Loupe. The
zoom factor is displayed at the bottom centre of the Loupe.
Note: 100% = the resolution at which the proof was originally
imaged, i.e.,, 1 screen pixel is 1 job pixel.
- (button) - Click to decrease the zoom factor of the Loupe.
Spanner - Opens the Loupe Options window.
Eye - Displays the HUD (Heads Up Display) showing the CMYK
dot percentages at the centered crosshair or within the average
percentage box. If the image is RGB, the relevant R, G and B
values will be displayed.
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SoftProof Menu Options

File Menu

Open Files - Load an image file directly into SoftProof. Supported file types are Canon RAW format (CRW),
JPEG, PNG, PPM, Serendipity Blackmagic Image, TIFF and Adobe Photoshop PSD.

Open Jobs - Load completed jobs into SoftProof. The Imaged (Original) or Rendered (Printed) file may be
viewed.

Save - Save the preview as a Blackmagic Image File. This can be submitted or placed in a hot folder, or on a
DropSpot.

Export - Export data from SoftProof. The available formats are CIP3, PDF, Postscript (Separated) and TIFF
Multichannel.

Submit - Submit the current job to a Media and Pagesetup with any changes. This re-images and re-renders the
file. When submitting the image to be processed again with any relevant changes, the current image resolution
is submitted. If the resolution is restricted in the Server Settings, this is the resolution that will be used.

Edit Touch Console UI - Opens an edit interface window to allow the configuration of the enabled (visible)
buttons for control of SoftProof in the Main screen of the Touch Console. Buttons are enabled or disable by
clicking on them. Any disabled will appear with a red cross and will be excluded from Touch Console when
using it to view softproofs. The Toolbar has a preview checkbox to see how the Touch Console controls will
appear and a Reset button to restore and enable all buttons.

SoftProof Settings - Opens the preferences for SoftProof, allowing for configuration of default viewing
conditions. See below for further information.

SoftProof Settings
The SoftProof Settings allow you to select viewing preferences including how to load a job, and the quality and press

settings
(3) tabs

View Options

Window

On Load

used to produce accurate proofs. The settings window is split into three
- View Options, Default Press and Default Camera.

SoftProof Settings.

{-View Options | Default Press Default Camera |
Window
(] Allow Multiple Windows

Status Bar Size | Medium %

I Rulers
M Scrollbars

Allow Multiple Windows - When enabled, allows jobs to be opened and Bkt Ccponeo]
viewed in separate SoftProof windows. If disabled, each job viewed will — Tmf]j
appear in a tab running along the top of the same SoftProof window. If a

job is dragged and dropped into SoftProof from the QueueManager, it e ot e T =
will replace any open image in the viewing window selected.

Status Bar Size - Select the size of the status bar text from Small,
Medium or Large.

Rulers - Show or hide the rulers.

Scrollbars - Show or hide the scrollbars. (o) oD

Honour Embedded ICC Profiles - When enabled, this will honour any embedded ICC profiles when viewing the
image in SoftProof.

Rotation - Control the orientation of jobs when they first load. The option None leaves the job in its imaged or
rendered orientation.

Zoom Level - Select the default zoom setting. All fitting zoom modes calculate the size based on the monitor
resolution. This is set in the Colour Management tab of the Client Settings.

Publications

Image

Enable Pager Thumbnail - Enable or disable the thumbnail viewer when viewing a publication. When enabled,
a thumbnail of the page appears when the mouse pointer hovers over the page number box.

Back Page Rotation - Set a default rotation for a back page when using the option Show Back Page (see
Publications Widget above).

Resampling Algorithm - Set the resampling algorithm for jobs as they are viewed in SoftProof.
Screening LPI - Enter the desired value for screen ruling in lines per inch (LPI). The default is 150.
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Default Press
The default press tab allows you to select a Press configuration from the database to be ~_ S—

applied to the loaded job and for all subsequent jobs opened in SoftProof. The results of (g e ko

the press settings can be seen on the output job and should match the printed copy. == =

101.60cm

An information window shows the settings of the currently loaded Press setup.
Configurations are managed in the Workbench and contain information such as size,
number of keys and colour information.

9 calcheck chart
match /SOcoated v2_eciF39.icc

None
0,00

Default Camera
The default camera tab allows you to select a Camera configuration from the database to

be applied to any loaded jobs using an RGB colourspace. If Honour Embedded ICC

Profiles in the SoftProof Settings is unchecked and the RGB image contains an ICC =

profile, the default camera configuration will be used in its place.

An information window shows the settings of the currently loaded Camera setup.
Camera configurations are managed in the Workbench and contain information such as

the ICC profile to be used, rendering intents, black point compensation and Calcheck
Chart reference.

View Menu
Select menu items are also available as icons within the SoftProof window (see image).

* Tabs - Control the tabbed viewing of images in SoftProof.

o New tab - Opens a new, empty tab ready for a job. Use the Open Job option
or drag and drop a job from the QueueManager to view it.
Close Tab - Close the currently selected tab. ~
Next Tab - Loads the next available tab.
Previous Tab - Loads the previous tab. ty
o Show Tab - Show/hide the tabs listed at the top of the screen.

* GetInfo - Display information about the softproofed job and how it was processed.

* Show Page Boundary - Display a red line around the page area of the job.

O O O

¢ Show Notes - Display any notes attached to the job. [T Tools  Submit_Modules

* Screened Pixel Readout - Toggles the HUD between crosshair point measurement Tabs >
of ink percentages and a square for measuring area average dot percentages. The @ Get Info m
square resizes depending on the zoom level to always cover an area equal to a full (8 Show Page Boundary P
halftone cell at the LPI defined in the SoftProof Settings. v B Show Notes ®N

¢ Ink Weights - Opens a window displaying the ink weights (source and print inks) @ Screened Pixel Readout  *

. & Ink Weights o8l
for the job.

* Proof Colours - For use with RGB images only. Automatically select a Press Q
Configuration to display onscreen what the RGB image will print like using a @® Zoom In ®+
specific Press profile. The selected Press will appear in the status bar at the EZOom Out -
bottom right of the screen. Clicking the status bar button will allow you to adjust <3 ShowAll =0

. o & Show Actual Pixels ®1
which profile is used. [A Show Actual Print Size 882

¢ Zoom In/Out - Zoom in or out of the image. «= Fit Width 3

*  Show All - Fit the entire job into the SoftProof window. ¢ Fit Height ®4

* Show Actual Pixels - One pixel of the screen is equal to one pixel of the job. This is ~ 90 CW
shown at 100%. This view mode has the quickest load time as resampling for 90 ccw
scaling is not required. g’llnﬁn

¢ Show Actual Print Size - Show the print size of the job. ¥ Mirror

¢ Fit Width/Height - Fit the job to the height or width of the SoftProof window. ¢ Autocrop

e 90 CW - Rotate the image 90 degrees clockwise. @ Unsharp Mask

* 90 CCW - Rotate the image 90 degrees counter-clockwise. &I Full Screen F

* 180 - Rotate the image 180 degrees. v B9 Thumbnails oT

* Invert - Invert (negate) the image. 8 Page Index X

*  Mirror - Mirror the image. & Notes N

* Autocrop - Remove any whitespace around a job. There must be a completely [ Loupe L

clear area on any one side of the job.
*  Unsharp Mask - Apply an unsharp mask to the image. This will affect the edges within the image.
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*  Full Screen - Switch between full screen mode and window mode.

*  Thumbnails - Select the Thumbnails tab within the SoftProof window.

* Page Index - Select the Page Index tab within the SoftProof window.

* Notes - Select the Notes tab within the SoftProof window.

* Loupe - Display a virtual loupe on top of the loaded image. The loupe can be resized and magnification level
changed if required. The current magnification is shown at the bottom of the Loupe; 100% means 1 screen to 1
job pixel.

Thumbnail Panel
The thumbnail panel displays a small image of any jobs currently open in SoftProof. Clicking on the
relevant image will switch the SoftProof preview to that window.

Notes Panel So[Ee
Notes gives users the ability to draw a text box on the imaged Ala0(E®
or rendered SoftProof to make a note. The note is attached to
the job file and remains attached until it is either deleted or the job is ENEE =
removed from the system. There is no limit to how many notes can be A

created, and they can be shown or hidden as required.

Check ink for red

When creating a note with the Note Editor, a configurable arrowhead pointer option is available along with the existing
area marker for a more precise commentary on the job. The User and Group of the note creator are also displayed (see
Secure Mode). Notes can be edited or the pointer adjusted by double-clicking on the Note.

Notes cannot be attached to files opened in SoftProof via File Menu > Open
Files. The file needs to be submitted as a job before any embedding of notes can take place.

The Note panel displays any notes attached to the job currently selected in the main viewing window. There is also a
Note column in the QueueManager showing the number of notes attached to a particular job. The Notes icon on the left
menu bar is used when adding Notes to the softproofed image. The Notes icon in the right panel is used to display or
hide any notes on the image.

¢  Show Notes - Show or hide the notes on the preview. Notes can also be toggled by clicking the icon on the right
panel (see image above).

* Text - The text making up the note.

¢ User / Group - The User and Group responsible for the note.

-4 Page Index Panel
===+ The Page Index panel displays a numbered box for each page making up the loaded publication. This

allows for direct navigation to any page by clicking on the page number. Hovering the mouse over a page
number will pop-up a thumbnail for the page.

The page boxes are colour coded:

Light Green indicates the Publication pages are loaded and can be viewed. These show as dark green

when selected.
2 3

Purple indicates there are duplicate pages, i.e., they have the same publication name and page
numbers. Dark purple indicates the pages are selected.

[z 2 3
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Clicking on these pages allows you to select and view the alternative page:

=T I =T 10 ===l —T == =—

19532 GOLF TEXT.job (IMPOSITION) Page 7
19532 GOLF TEXT.job Page 007 (IMPOSITION 07)

Light Red indicates the page is not yet available for viewing in SoftProof. This normally occurs
116 11/| when there are page number gaps if pages have not yet imaged or rendered; or when processing

a de-imposed publication with known (signature defined) page numbers. As the missing pages
image/render, close and re-open SoftProof to update the publication pages.
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Spectro
The Spectro application allows for the measurement of colours with a Spectrophotometer. The accuracy of the
measured value can be viewed against an imported value

when mapped through a selected ICC profile. a08 ETx e A~ G e kel 5

[ P e 10 [ @showall swatches
The window is split into two sections. The right side allows for . L R o 75C G00% 0008 e i
the import and viewing of a Special Set, which is used as the — o Er wc owe wﬁ w n
comparison base. The left side displays the measured values. e by

I PANT81C 0.00%.7.06% CMYK
I PANT.15C 0.00%..0.98% CMYK
I PANT.17C 0.00%.5.88% CMYK

Selecting a particular measured value matches the closest PNT_82C 0004 000K WK 10
colour of the imported set, giving it relative deltaE values. S R OO oA TG T
These can also be filtered to only show the closest matches for ———Ji ool
. . I PANT..88C  0.00%..0.20% CMYK Overprint 1cy
better viewing,. e i

* LoadSet... ) Pantone Solid Coated

((# Match ICC... ) ../ Reso
[——————————— ) oo [ S Matchicc)

Oitem Rendering Intent: [ Relative Colourimetric I}

/ icc/ ISOcoated_v2_eci.icc

Spectrophatometer (offine)

Options (Gemptreone 8 Ccvare)

* Load Set - Select a Special Colour Set to load. This is -
the set used to compare measured values with. Choose from any of the Special Colour Sets created.

¢  Match ICC - Select a Match ICC profile.

* Rendering Intent - Select the rendering intent for the Match profile.

* Spectrophotometer - Select your device from the list of supported Spectrophotometers.

¢ Activate - Connect to your selected device. Once connected, the pull down device list will change to display any
status messages from the device and the values measured.

*  Turn Off - Disconnects the connected Spectrophotometer. Alternates with the Activate button.

* Add - Select this to append to the list for each reading. If this is not selected, the last reading is updated. This is
available after the device has successfully connected.

* Ae - Select the value of deltaE to display for when comparing measured colours with those in a loaded set. This
is used in conjunction with the Show All Swatches option.

* Show All Swatches - Select this to view all swatches. By de-selecting this, only those swatches below or equal
to the deltaE value entered will be displayed. Colours within the defined tolerance values will show in blue.

Measured / Loaded Set Panels
The Measure and Loaded Set panels show the following information:

¢  Colour - A swatch visually representing the colour.

* Name - The name of the colour. This can be edited by clicking in the name field.
* Space - The colourspace of the colour (Lab or CMYK).

* Mode - The paint mode of the colour.

¢ Tint - The tint value of the colour.

* DotGain - The dotgain curve assigned to the colour (if any).

In addition, the Loaded Set panel displays the following:

e Ae/CIE94/CMC (1:1)/CMC (2:1)/Delta L/Delta a/Delta b - These columns list the relative delta’s of the loaded
set colours when compared to the selected, measured colour.

Export Menu
The Export menu allows for the measured values to be exported to a space or tab delimited file. Save all or only selected
entries and select the format for export:

* Lab - Exportjust the Lab values.

* XYZ - Export just the XYZ values.

¢ Lab XYZ - Export the Lab values followed by the XYZ values on the same line.

* XYZ Lab - Export the XYZ values followed by the Lab values on the same line.

* Separate Values With - Choose if the values are to be separated with spaces or tabs.

A contextual (right-click) menu in the Measured / Loaded Set panels has the option to Delete (a selected colour); Delete
All (measured colours); Print (the measured/loaded set to a system device); and Font Options.
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Touch Console

The Touch Console application offers enhanced control and usability of the SoftProof application through the use of a
touch screen. Ideal for press room environments, the separate touch screen acts as the console, controlling jobs that are
loaded and softproofed on the main screen. Individual jobs or entire publications can be quickly located for proofing.

A Touch Console Settings menu saves valuable time, enabling the operator to choose default navigation options; the
queues the Touch Console will search for jobs; and whether the console switches automatically to the Main control
screen, the SoftProof view navigator, or the page navigator (for publications) once a job or jobs have loaded.

A Mode Bar allows instant switching between control
interfaces from the main Image and Navigation control,
through to Ink Keys and Channels; the Virtual Loupe;
Press Configurations; Page Navigation; Notes and
Tabbed Views.

When the Touch Console is launched, a blank screen
will appear on both monitors (the touch screen and the
main monitor) with instructions to select which
monitor is the touch screen. Simply touch whichever
screen is to be the Touch Console to begin.

The Interface
The interface occupies the whole of the touch screen. At the top is a banner advising which section the user is in at the
time. The title banner will change to reflect the different modes in use. The bottom of the screen displays the various
modes to use with SoftProof. Return to the starting point at any time by pressing the Home button.

Using the Touch Console
When first starting, Home is the default position. View the jobs in the system by selecting one of the mode buttons along
the bottom of the screen:

* Publications - View a list of jobs that are part of a publication only.

* Books - View a list of jobs that make up a Book as defined by the Bookfilter and BookMonitor application.
* Jobs - View a list of jobs that are not part of a publication only.

¢ All - View alist of all jobs in the system.

Jobs must be in the print queue to be displayed, i.e., they must have completed rendering. It will not show any jobs
Waiting to Render or in a Held status.

Once a mode has been selected, the screen will change to display the appropriate list of jobs with the available sorting
and viewing options:

Sort Name Sort Name Sort Time Sort Time View

Ascending Descending Ascending Descending View Imaged R View Flipbook

Actions available include:

* Select - Touch your finger on a job in the list and it becomes selected. The mode options change to display View
Imaged, View Rendered and View Flipbook.

* Scroll - Touch your finger on the list and drag it up or down the screen. Lift your finger off and position it again
to scroll further.

* Fast Scroll - Touch your finger on the list and drag it fast up or down and let go in a “throwing” action. To stop
the list at any point, touch a job on the screen.

¢ Scrollbar (optional) - If enabled, drag your finger down the overlaid scrollbar to move up and down the list.
Moving your finger left-right will change the position of the scrollbar itself.
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When the required job has been located and a viewing mode selected, the Touch Console will open the Main, Navigate
or Pages control panel.

Main Navigate Loupe Press Config Show Pages Show Tabs Close

Actions and modes of the Touch Console will adjust to give the options normally associated with the SoftProof
application. Selecting View Flipbook will load the job into the standard Flipbook application with relevant actions and
modes on the Touch Console.

Modes available include:

Main

Main - The default main screen displayed when a job is first loaded. This is a control screen for macro-
manipulation of jobs. Includes functions such as image inversion and rotation, back page show through, image
size on screen and so on.

Navigate - A control screen for closer examination of proofs - features controls for the viewed image size (fit
width/height, original 100%, printed size) and zoom controls.

Loupe - Opens the Virtual Loupe on the main screen, with controls for the Touch Console.

Press Config — Opens a list of available Press configurations to apply to the SoftProof. This will switch to
Camera Config when an RGB image is opened.

Show Pages - Opens a modified Page Navigator for instant page-to-page viewing.

Show Tabs - Displays a list of job currently loaded in SoftProof Tabs.

Close - Closes the current job, publication or tab.

A job can be manipulated in various ways once loaded, just as with the conventional controls for the SoftProof
application. Some actions will only apply if certain types of jobs are viewed. The actions are colour coded to help group
them into like actions. Buttons can be shown or hidden using the Touch Console settings.

Text Tab Image Tab Tools Status Full Screen e Window / Display
oow 180 sooew | | teven wiror | | awocrop | | mustoe | | GIN5, € Image manipulation
SR R | o || TR | | Neas < Navigation

< Overlaying objects &

Page

Boundary viewing publications
o,y Acus mewen | | o < Fitting methods & tools

Text Tab - Toggles the text job name tabs for multiple loaded images in the SoftProof screen.

Image Tab - Toggles the job thumbnails in the SoftProof screen.

Tools - Toggles the Tool Palette in the SoftProof screen. The Palette must be enabled in the SoftProof
application for this to function.

Full Screen - View the SoftProof window in full screen view or the user-defined view.

90 CW/180/90 CCW/ - Rotate the currently viewed proof in the desired direction.

Invert - Invert the image displayed.

Mirror - Mirror the image displayed.

Auto Crop - Remove white space from around a job. There must be a completely clear area on any one side of
the job.

Blueline - Replace all colours with varying shades of blue to see any traps.

Revert Channels - Revert to the original channel values.
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*  Previous/Next Page - Move to the previous or next page when viewing a publication.

* Notes - Show or hide any notes embedded in the job (see SoftProof - Notes for more information).

* Previous/Next Tab - Move to the previous or next tab when viewing multiple tabbed jobs.

* Page Boundary - Toggle a red line showing the page/image boundary of the proof.

* Signature - Overlays the signature used to de-impose the job/page if it was submitted for de-imposition. This is
only enabled when viewing a de-imposed job/publication.

* Deimposed Pages - De-impose a job submitted as an imposition on-the-fly into separate pages, defined by the
signature attached to the job and return it to its original state. (see RIPMonitor - Submit as Imposition for
more information).

* Back Page - Display the reverse (back) page through the page currently loaded as if the final print was being
held up to light. The Back Page Opacity setting in the Press Settings controls the amount of show through.

* Spread - View the spread of the selected page, for example, pages 2 and 3 as a spread.

*  Show Channels - Opens a simplified Channel Viewer touch console interface, featuring a coloured and labeled
button for each process and spot ink channel. Selecting each button will toggle the ink channel on or off. If the
Channel Viewer (see SoftProof) is open, the channel’s on/off state will be reflected in the panel. Touch the Main
button in the Mode Bar to return to the Main screen.

* Ink Keys - Opens the Ink Key Viewer for the current image on the main SoftProof screen and a set of controls
for it on the Touch Console. Once settings such as Ink Weight and Sheet Placement have been set in SoftProof
(see InkKeyViewer), the touch controls offer the ability to easily switch between Channels and Keys. The
following control buttons are available:

o Excess Ink Area - Toggles the view to show areas inked in excess the defined maximum ink key value.

o Full Screen - Toggles full screen mode for the InkKeyViewer window.

o Channels - Select which channel to view in the InkKeyViewer. Touching the currently active channel
button again will show all ink channels.

o Ink Keys - These are buttons for each separate Ink Key as defined in the loaded Press configuration.
Press configurations with large numbers of Ink Keys may use more buttons than will fit on the Touch
Console screen. Excess buttons can be accessed by touch-and-dragging the Ink Key controls up or
down. Touch the Main button in the Mode Bar to return to the Main screen.

* Find Note - If any Notes are attached to the currently viewed job/page/spread, this button will open a list of
the Notes in the Touch Console. Select a Note to navigate to its location on the proof. Finding a Note will toggle
the Notes button to show all notes.

¢ Show All - Show the whole job within the SoftProof window.

*  Print Size - Show the job in the SoftProof window at print size.

¢ Actual Pixels - Show the job in a one screen pixel to one job pixel ratio (i.e., 100% zoom).

This view mode has the quickest load time as no resampling for scaling is required.

*  Fit Width/Height - Fit the job to the width or height of the SoftProof window.

Navigate
In Navigate mode, it is possible to pan around the image and change the zoom or fitting method. A thumbnail of the
image is loaded into the centre action area of the console.

Touch the thumbnail to jump to that location on the image in the
SoftProof; or touch-drag around the thumbnail to pan around the
proof.

Around the edges of the thumbnail are the Touch Console controls for
Show All, Print Size, Full Screen, Fit Width, Fit Height, 100% (Actual
Pixels).

The two remaining controls alternate between Previous Page/Next
Page or Zoom In/Zoom Out.
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Loupe
The Loupe mode positions a loupe on the SoftProof window. The Touch Console action pane acts like a drawing tablet.
Touch and drag your finger on the touch screen to move the loupe over your image.

Buttons around the edges of the console control the
Loupe’s features:

* Smaller / Bigger - Decrease or increase the size of
the loupe.

* Zoom In / Out - Increase or decrease the
magnification of the loupe.

* Solo Previous / Next Channel - These controls
allow individual Ink Channels of the job to be
viewed within the Loupe, acting as the Show
Channels function. The buttons cycle through each
individual channel then show all channels (default | -~ -
view). ﬂ

* Toggle HUD - Toggles the Heads Up Display in the
Loupe window, showing the CMYK dot percentages at the centered cross-hair or within the average % box.

* Screened Pixel Readout - Toggles the HUD between cross-hair point measurement of ink percentages and a
square for measuring area average dot percentages. The square resizes depending on the zoom % to always
cover an area equal to a full halftone cell at the LPI defined in SoftProof Settings.

View FlipBook
View FlipBook displays a list of available publications that may be opened and viewed using the FlipBook application.
Once a publication is opened, FlipBook controls will appear on the console:

* View 3D, View Calendar, Show Borders and Rendered Thumbnails toggles.

* Decrement/Increment Start Page, Even/0dd Top Page, Read Direction 1->2 / 2<-1 buttons.

* Press Configuration can be selected.

* Top Section and Page Navigator buttons allow sections of the FlipBook window to be toggled on or off.

* Pages can be “flipped” through using Previous/Next Page buttons or accessed directly using the Pages screen.

Touch Console Menu
The Touch Console menu has the following options:

* Font Options - Control the font size for the Touch Console text.

*  Queue Order - Select which Output queues are made available for view/proofing in the Publications and Jobs
lists on the Touch Console.

¢ Book Order - Select which BookFilter queues are made available for view/proofing in the Books list.

* TouchConsole Settings — See below for more information.

Touch Console Settings
Default job viewing and touch screen navigation options can be configured using the Touch Console Settings. There are
two tabs - TouchConsole and SoftProof:

TouchConsole Settings

[TouchConsole = SoftProof |

Touch Console
¢ ScrollBar - Enable or disable the scrollbar and set the default
side it appears on (Right or Left).
* Thumbnails - Enable or disable viewing thumbnails for Thumbnails @ Publications @ Jobs M All
Publications, Jobs or All selection lists.

ScrollBar (¥l Enable

() Default Left (8) Default Right

((Cancel ) (0K )
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SoftProof

SoftProof
¢ Entry Screen on Load - Select the control screen the Touch Console will default to when loading a new
job/page:
o Main - The console defaults to the Main screen on
load. (YeNe) TouchConsole Settings
o Navigate - The console defaults to the Navigate ( TouchConsole [ SoftProof |
screen on load. Entry Screen On Load | Main B
o Pages - The console defaults to the Show Pages Navigate Option [ Zoom In / Zoom Out )
screen on load. Duplicate Page Viewing | Manual Select )
* Navigate Option - Choose whether the Navigate console Publication Load Page [ First Available Page B
screen has the Previous Page/Next Page or Zoom In/Zoom
Out buttons.
* Duplicate Page Settings (Veripress/Blackmagic Softproofing (Cancel ) (oK)

Add-On Only) - When viewing a publication with duplicate
(purple) pages, choose from these page load options:
o Manual Select - When a page with duplicates is selected in the Show Pages screen, the page to view
must be manually selected. This is the default mode of a non-Veripress Touch Console.
o Select Newest Page — Useful in publishing workflows where page updates/revisions are common. This
option will automatically display the latest version of the page.
* Publication Load Page (Veripress/Blackmagic Softproofing Add-On Only) - When loading a multi-page
publication, choose from these load options:
o Manual Select - After selecting the Book or Publication to SoftProof, this will open the Show Pages
control panel. The publication will open at the page selected.
o First Available Page - Loads the selected Book or Publication at the first available [rendered] page.
This is the default load method.
* Edit Touch Console Ul - Opens an Edit Interface window to allow for the
configuration of the enabled (visible) buttons for control of SoftProof in ——

the Main screen of the Touch Console. ool | e | e
Enable or disable buttons by selecting them. Those disabled will appear

with a red cross and will be excluded from the Touch Console when

using it to view softproofs.
The Toolbar has a Preview checkbox to see how the Touch Console

controls will appear and a Reset button to restore and enable all
= [ [ [+ [+

buttons.
|| | | [ D€ | 7
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Serendipity Client Menu Items

The Serendipity Client menus provide access to direct job submission options, system settings, and extra functions and
utilities.

Application Menu (Windows/Linux) or Serendipity Client Menu (Mac OS X)

Preferences - Select this menu option to open the Client Settings (Preferences) for the Serendipity Client, containing
default values and preferences configured for the Client and its applications and modules. See the System Settings >
Client Settings section of this manual for further information.

Submit Menu

Submit Files
Select files to send to a Media and Pagesetup for processing. One or more files may be selected for processing.

Selecting Open will present a chooser showing the Pagesetups and Medias available. Choose the combination to submit
the files to and click the Submit button. This will copy the files into the system for processing. The flow control can be
enabled to hold the job after imaging or rendering; the
number of copies can be set; or jobs can be placed as
pages in a publication.

bt Files.

Epson Stylus Pro |
7900/710/9900/9910, PX- |
HB00O/H10000 with HTM module
72.00 by 72.00 dpi

RGB

0.00cm x 0.00cm

5. 8 for Art
son 7900HTM-RGE

OHTM-Ar e Roll

Submit Window
The Submit window is comprised of four (4) sections - a
Pagesetup selection list; a Media selection list; an X — B .

\manda

00 Amanda copy Media and print mode ~ Premium Luster Photo Paper (260)
(720 x 1440 pi)

Paper source Roll

Information panel displaying details of the currently |, ... oo s e
selected Pagesetup or Media; and a Submission control |5 e @
panel. B rotru o

mEE (e @D

Pagesetup Selection List

* Pagesetup - When selected, this button displays a list of Pagesetups available to submit jobs to.

An active (selected) Pagesetup is highlighted in blue.

Media Selection List
This list is only active if the Pagesetup button is selected in the Pagesetup selection list.

When a Pagesetup has been chosen, a list of Media compatible with the Pagesetup will be displayed for selection.
An active (selected) Media is highlighted in blue.

If no Media is selected, the submitted job(s) will be output to the Pagesetup’s default Media.

Note: The Serendipity Client saves the last Pagesetup and Media selection so it need not be selected every time a job is
submitted to the same Pagesetup.

Information Panel
This panel displays the settings for the currently selected Pagesetup or Media.

Submit Options
The lower section of the Submit window has the following options available when submitting files:

Flow Control
* Hold After Imaging - Check this box to hold the job after the Imaging stage has completed. Held jobs can be
released to continue processing via the QueueManager toolbar or contextual (right click) menu.
* Hold After Rendering - Check this box to hold the job after the Rendering stage has completed. Held jobs can be
released to continue processing via the QueueManager toolbar or contextual (right click) menu.
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* Nest - Submits the jobs for imaging and rendering, then on to be nested with other jobs. Nesting criteria are
defined in the Output for the Pagesetup/Media to which the job is sent (see Workbench - Output for further
information). Note: This Nesting function only requires that the Output used has nesting parameters defined.
The Output itself can have nesting disabled for normal use. This allows selected jobs to be nested when
submitted while leaving the Output non-nesting for normal use.

* Rotate 90 - Rotates the job 90 degrees. This will override any rotation settings in a Pagesetup.

Copies
* No. of copies field - Enter the number of copies of the job to be printed.
* Copy Lock button - Locks the number of copies to be printed for any files submitted until unlocked and
changed.

Publication
* Publication Name field - Optionally type a publication name to which the submitted file will be assigned. The
job will be viewable in the Publication View of the QueueManager.
* First Page field - Enter the page number for the submitted file in the publication. If submitting multiple files,
the page numbering will start at the defined page number and increase sequentially for each job.

Submit Files For De-Imposition

Also available via the RIPMonitor, this option allows for the submission of files directly for de-imposition, rather than
from a RIP queue. After selecting one or more files, a chooser will appear to enable selection of a Pagesetup and Media,
or Pagesetup Pool. A Signature Group can also be assigned to de-impose the files (see Workbench - Signature Groups
for more information).

Submit Files As Imposition

Also available via the RIPMonitor, this option allows for the submission of files directly as an imposition, rather than
from a RIP queue. This will submit an imposed job in its original form, but attaches a Signature Group (via popup
chooser) to allow the job to be de-imposed on the fly using the Deimposed Pages button in the Veripress SoftProof
Touch Console (see Touch Console for more information).

Submit ICC Target
After selecting one or more ICC target files, select a Pagesetup and Media to submit the ICC target file to.

Note: This option is used as part of creating an ICC calibrated Pagesetup/Media. After creating and assigning a Paper
Profile and Linearisation curve to a Media, this option is used to submit an ICC target file to the printer with all ICC
options disabled. The target is then read by third party ICC profiling software and used to generate the printer’s output
ICC profile, which is then assigned to the Media.

Submit ICC Target Without Colour Correction
After selecting one or more ICC target files, a chooser allows you to select a Pagesetup and Media to submit the ICC
target file to.

Note: This option works in a similar way to “Submit ICC Target” however, all Linearisation data will be disabled at the
time of submission, unlike Submit ICC Target which enables colour correction curves. The job info will display
Calibration Target, ICC Disabled in the Properties field.

Test Prints
Select one or more Pagesetups and Medias and send multiple copies (if desired) of internal test prints for processing.

Note: You can add your own files to the lib/testprints directory for use as test prints. Any files you have permission to
use that are placed in this directory will appear for selection in the Test Prints chooser window.
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Server Menu

Server Settings

Select this menu option to open the System Settings (Preferences) for the Serendipity Server. The Systems Settings
section contains default values and preferences configured for the Server. See the Server Settings section below for
further information on each panel.

Connect to Server

This allows the Serendipity Client to connect to a Veripress Server running on the network. The Refresh button will
search for and display any active Servers. Alternatively, you can enter the name or IP address of the Server in the
Server Address field under the Manual tab.

If there are multiple Servers (Masters) running on the network, the list is cached on the first “Connect to Server”
selection. A dropdown list of available Servers is accessible via the Auto Detect tab. If a new Server appears after this
time, the Refresh button must be pressed to find and add it to the list. Likewise, if a Server becomes unavailable, the
connection will fail and the list will require a refresh.

When the Serendipity Client is started, it will attempt to connect to the last Veripress Server accessed by default.

Accounts Admin

Accounts Admin allows an authorised administrator to create, modify and manage User accounts and User Groups.
Users can be reassigned to groups dependent upon the operating privileges granted to each User Group. See the
Accounts Admin/Secure Mode section below for further information.

Log Out (Secure Mode only)

This menu item only appears while Veripress is in Secure Mode (see Accounts Admin/Secure mode for more
information). Selecting Log Out while using Veripress in Secure Mode simultaneously logs out the current user and
generates the Login window. At this point, the options available are to enter a username and password; Choose Server
before login; and to Quit the Veripress Client.

While the Login window is displayed, the Veripress Client is effectively LOCKED to all users. The Server will continue to
operate as normal.

Chatterbox

Chat to other users connected to the same Server. The Chatterbox window will display the Clients connected to the
Server. If the user has entered a nickname in the System Settings, this name is displayed; otherwise the machine name
is used. If the user’s name cannot be selected, the user has selected the Away option and is not available.

Broadcast Message

This allows messages to be sent to all users connected with a Client to the same Server. Selecting the Broadcast option
displays a message window to type into and send. The message is displayed on the users window for a short time and
will automatically dismiss if it is not acknowledged by clicking OK.

Download PPD

This option downloads the Megarip PPD from the Server to the desired location. A chooser will appear to navigate to
the location for saving the PPD file on the drive. This saves having to get the PPD off the disk. Use the PPD when
installing a local printer. When installed, the Megarip PPD (Postscript Printer Description) is selected as the printer
driver when setting up a Veripress Published Pagesetup as a print destination for third party applications (see
Workbench - Pagesetup and the Publish to a Windows Printer sections for more information).
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Accounts Admin / Secure Mode

Veripress gives users the option to login using Secure Mode, which allows the administrator to create accounts for
users and groups, with each group configured to allow or deny its users access to particular applications and functions.

When Secure Mode is active, users are required to enter a username
and password whenever the Client is started or users are changed.
The username and password are both case sensitive.

The Accounts Admin menu option is selected in order to display the
panels for configuring any Users and Groups and these should be
created prior to activating Secure Mode.

Y. Yveripress
v U

golem.swdevel.serendipity-software.com.au:9100

The Log Out option only appears once Secure Mode has been
activated. Selecting this while using Veripress in Secure Mode Name: |]
simultaneously logs the current user out and generates the Login
window with options to login as a new user and select a Server to
connect to, or Quit the application. While the Login window is
displayed, the Client is effectively locked to all users. The Server will (Quit) ( Choose Server.. )
continue to operate normally. - ' '

Password:

Setting up Users and User Groups
Veripress’ Secure Mode is set inactive by default. The software will continue to function normally whether or not
Secure Mode is activated.

Important Note: It is recommended all users and groups requiring access be setup BEFORE activating Secure Mode.
Secure Mode cannot be activated until at least one (1) user has been created. This would usually be the Admin account,
as this is automatically created when the Accounts Admin option is selected for the first time.

1. Select Server Menu > Accounts Admin... to display the configuration panels.

Activating Secure Mode o
Once the initial user account(s) have been setup, Secure Mode can be
activated by checking the tick box located via Server menu > Server
Settings (General tab).

Secure Mode can only be activated or deactivated by an administrator (a
member of the Admin group).

Configuration Panels o=

Users Panel
The fields within the Users panel are:

* Name - The username of the account. This is case sensitive.

¢ User ID - This is a numerical ID assigned automatically but may be changed
by the administrator.

* Password / Verify - The password is entered and stored here. New
passwords must be verified by entering the details in each field. The
password is also case sensitive.

*  Permission - The level of permission for the user is created here. Click Edit to
make changes to the user read/write/execute permissions.

* Email - Enter the users email address here.

* Comment - Allows the administrator to enter a note on the particular user account if necessary.
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* Group (dropdown) - Assign a user group to the user account.

¢  User Privileges - Privileges other than those in the user’s group can be added here.

* Notifications - Select which email notifications the user is to receive by clicking the + icon or remove any via
the - icon. Notifications are available for Job Spooling failure, Job Autodetection failure, Job Imaging/Rendering
failure, Job Printing failure, Dongle removal, Server Crash, Media Remaining warnings and Software Updates
available.

To create a User:
1. Click the + icon in the bottom left of the window. To delete a user, click the - icon
Enter a username in the Name field.
Enter a User ID number or leave the default value.
Create a password for the user and verify the details. The password boxes will always display black dots
irrespective of the length of your password.
Edit the permission level to the required access level.
Enter the user’s email address (if notifications are required).
Add a comment against the user if necessary.
Assign a Group for the user.
Add any extra privileges to the user if required. This will only show privileges not included in the group
selected for the user.
10. Add any notifications to the user if required.
11. Apply the changes or select Revert to cancel.

W

Lo

Groups Panel
An admin User and Group are created by default with access to all permissions and privileges when the Accounts
Admin option is selected for the first time. The admin user and group cannot be deleted. It is recommended this be
the only group with access to the Accounts Admin application.

e = |
Avaiable Privieges 8 + |98
Name: [Serendipity

ch =

e

The fields within the Groups panel are:

* Name - The name of the Group.

* Group ID - This is assigned automatically but may be changed
by the administrator.

* Comment - Enter a note on the particular user group if
necessary

*  Group Privileges - This is a list of available privileges relating to
functions within Veripress.

* Members - A list of Usernames and IDs belonging to the Group.

— Revert Apply

To create a Group:

1. Click the + icon in the bottom left of the window. To delete a group, click the - icon.

2. Enter a name in the Name field.

3. To add privileges, click the + icon in the Group Privileges panel. A list will appear to the left with all available
items. To add, highlight the privilege and click the + icon at the top right of the window.

4. Once you have finished adding privileges, click the X in the middle of the right edge of the panel to close the
window.

5. Click Apply to save any changes to the group or Revert to cancel.

Assigning Users to a Group
Users are assigned to the groups via the Users panel.

(@ Users @§ GCroups ]

1. Once you have created the user group, click on the Users panel.

2. Select the User Name from the list of users.

3. Select the Group to assign the user to from the Groups dropdown menu.
4. Click Apply to save any changes or Revert to cancel.

Important Note: A user can only be assigned to one User Group at a time. If extra privileges are required, these must
be assigned against the user via the Users panel.

Serendipity Software - Veripress User Manual - Version 5.3 105



Hosts Panel

The Hosts panel allows for the configuration of automatic Client logins for selected host computers or network IP

addresses when using Secure Mode.

@ Users i Groups | Hosts

Name: Test
Host

Test Hostname/IP: 192.168.0.30

Automatic Login: | g guest

The fields available are:

* Name - Enter a name for the Host setup.

* Hostname/IP - Enter the Hostname or IP address of the computer the user will automatically connect to.

* Automatic Login - Disable or Select a User from the dropdown list. Only one user may be selected per Host
setup.

Activating Secure Mode

Secure Mode should be activated after any users and/or groups have
been created. Only an administrator or member of the admin group can
activate or deactivate Secure Mode.

To activate:

1.
2.
3.

4,
5

Select Server menu > Server Settings.

Click on the General tab.

Tick the checkbox at the bottom of the screen - Secure mode
- to activate or deactivate.

Click OK and close the settings when done.

If activating Secure Mode, a login window will appear as
soon as you close the Server Settings.

If Email Notifications are setup for users:

Maximum Memory For PS RIP:  OMB

Maximum Memory For Rotation: OMB

Maximum Print Preview Resolution: 180

Minimum Broadcast Interval: 1s

Server Settings

General | Colour Management
Default Units: | in +

Working Paths

! Low quality thumbnail (faster)
Compression: | Faster .
@ DPI
M.

Polling Service Refresh: 0h  [2:0m 0

Server Back Log: [2) Days

)

Processes: Image 1 ||

M

M

Render 1

[ Output unknown files to printer

[ Log printed jobs
() Secure mode

Mail Server

8]

Sender Email Address

(_Cancel

oK

* Enter the mail server details in the Mail Server field. This is the outgoing SMTP server.
* Enter the email address for the Sender (From) field of the email in the Sender Email Address field.
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System Settings

The Systems Settings section contains default values and preferences configured for the Server and Client. The settings
are split into two (2) different sections - Server and Client.

Access the Client Settings via the Application menu (Win) or Serendipity Client menu (Mac).

Access the Server Settings via the Server menu.

Client Settings
The Client settings are divided into three (3) tabbed categories: General, Colour Management and Working Paths.

General

Internationalisation - Select your preferred language from those
available. This displays all Client and log messages in the chosen
language. The default is English. A restart is required if the language
setting is changed.

Show Tooltips - Enable or disable tooltips within the Client.

Turn Sound FX Off - Check this to disable the sound effects. Sounds
are used for things such as drag and drop, and error message alerts.
Undo Levels - Set the number of levels for Undo. The default is zero
(0), which means no restriction.

Default Units - Set the measurement units used by the Client and all
of the Applications/Modules.

Instant Messaging Nickname - Enter a nickname to use when
accessing the Chatterbox application.

Memory Cache Maximum Size - Set the maximum cache size for the
SoftProof application. The default is zero (0), where the Server
chooses the default depending on system configuration.

800 Client Settings

General - Colour Management  Application Shortcuts '

Internationalisation
Default 3
General User Interface Settings

™ Show Tooltips ¥ Turn Sound FX Off
™

Undo Levels: 0
Default Units: [mm  [4]
Instant Messaging
NickName: ]
SoftProof
Memory Cache Maximum Size: 0 BR

Maximum Preview Resolution: 0 (3 on

oo e
N? Cancel

OK

Maximum Preview Resolution - Set the maximum preview resolution for SoftProof for both Imaged and
Rendered options. The default is zero (0), which is the full job resolution of the output file.

Colour Management
Choose Default Match ICC Profile — Select a default match ICC profile for accurate display of CMYK data.

CMS Dithering - Disabled by default. Use CMS Dithering for smoother
results whenever conversion between 16 bits to 8 bits is required.
Calcheck Managed - Enabling this will display the current calibration
status of the selected monitor. When selected, there will be a small
icon showing a green tick or a red cross. This icon is shown in the
bottom right corner of the SoftProof window. Its status depends on the
expiration time of the monitor calibration (as set below) and the
Calcheck status.

Use Native Profile — Enable this to use the operating system defined
ICC profile for colour management. The Client will use the monitor
profile as setup for the operating system, i.e.,, Mac OS will use what is
in the Display Preferences Colour tab, Windows will use the Display
Adapter Settings.

Choose Monitor ICC Profile - Select a monitor ICC profile for the
display the Client is running on. The profiles are used so any colour
element viewed on the display is shown as accurately as possible. This
includes SoftProof and any colour swatch. It is recommended the
monitor be calibrated and set to the same match profile as is used for
the softproofing Pagesetup.

eNoO Client Settings

General | Colour Management | Application Shortcuts

Match

(% Choose Default Match ICC Profile... )

# CMs dithering

Monitor 1
I Calcheck Managed ¥ Use Native Profile

Choose Monitor ICC Profile.
Resolution

Calibration expires.

Never B

@ Use system setting: 93x95 DPI

O Custom resolution: 72 DPI

Monitor 2
I Calcheck Managed ¥ Use Native Profile

Choose Monitor ICC Profile.

Resolution

@ Use system setting: 99x 98  DPI Calibration expires

bPl Never %

(O Custom resolution: 72

(_cancel )

[

../Resource...d_v2_eci.icc

/home/mandy...040711-3.icc

/home/mandy...D-040711.icc

@

=

[’

Resolution - Choose the default resolution to use for the monitors. This is used in SoftProof for calculating

various fit methods. Options include:

o Use System Settings — The Client will calculate the system’s monitor resolution.

o Custom Resolution - Specify your own resolution.

o Calibration Expires - Set a reminder to popup when a calibration needs updating.
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Additional Monitors
Specific settings may be set for each monitor when in a multi-monitor environment. The [I] E]
Client Settings will show additional sections with Monitor 2, Monitor 3 etc listed. To identify
which monitor is which, press the monitor indicator button to display a graphic in the middle
of the screen for the relevant monitor.

Calcheck Managed
The Calcheck Managed option (under Colour Management) constantly reports the calibration status of the monitor(s).

By enabling this option, a small, tick or cross icon will appear in the SoftProof
window, giving the current calibration status of the monitor. ¥ Auto SoftProof Press = v

Hovering the mouse over the cross or tick will display profile information and status.

ICC Profile

Status: OK

Created: 4/07/11 1:09 PM
Expires: Never

This is linked to the Monitor ICC selected in the System Settings, the time it was [siename inome/manoy/usrarycoosynesmofies ac-010711-31cc

created with the Displays application and the expiration time set. If the monitor has  [Gnscilmmsesons
Measured: 25/07/11 12:12 PM

been calibrated and the expiration time has not been reached, there will be a green  [s&esics

. . . Ae Cyan:0.73
tick displayed on the monitor. If the time has expired, there will be a red cross [aVnss”

Ae Black:0.96
displayed. 5% Mucrage 0.63
Sanind devaion .27

Right clicking on the tick or cross will display extra options:

¢ (alibrate - Opens the Displays application and begins to calibrate. If the instrument previously selected is
connected, calibration begins. Once calibrated, select an appropriate name and click OK. This will save the ICC
to the chosen location. Select the ICC in the system settings and dismiss the Displays application.

¢ Calcheck monitor - Available when a Calcheck Chart is attached to the Press settings for SoftProof.

If either option - Calibrate or Calcheck Monitor - are selected, the previously used instrument (Spectrophotometer) is
set as the default for the Displays and Calcheck applications to use for taking measurements. If this has changed since
last use, an error may appear. Dismiss the error and adjust the selected instrument in the Displays application
dropdown for the Calibrate and Calcheck sections. Close the Displays application and retry the option in SoftProof.

Calcheck Managed is also linked to the Calcheck application, where the status is saved to a Calcheck Chart and used
when a job is opened in SoftProof.

When a Calcheck is run for the monitor, a Calcheck Chart is selected. The result is stored with the chart, which can be
selected in a Press setting. If a job is viewed in SoftProof with that particular Press and Chart selected, the status of the
proof being viewed is displayed. This condition lasts for the duration of the current life of the calibration. When a
calibration expires, all Calcheck statuses need to be updated.

Application Shortcuts
This tab displays a list of the Applications and Modules for which keyboard shortcuts can be created.

Note: It is the responsibility of the user to check the created shortcuts do not conflict with any other Veripress, third
party software, or operating system shortcuts/hotkeys.

To add a shortcut:

1. Highlight the selected application or module in the list.

2. Use the Edit option in the context menu (right click) or click in the Shortcut field to the right of the
application/module name.

3. Typein the key or key combination for the shortcut and press Enter.

The shortcut will now appear in the Application menu of the Client.
To remove a shortcut:
1. Highlight the selected application or module in the list.

2. Use the Clear option in the context menu (right click); or
3. Click in the Shortcut field and delete the shortcut.
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Server Settings

Server settings are saved to the Server and are common to all connected Clients. The Server settings are divided into

three (3) tabbed categories — General, Colour Management and Working Paths.

General

Default Units - Set the units used by the Server. Options are mm, cm, inches, points, picas, metres or feet. These

units are used for Server related items and are not linked to
the Client settings for Default Units.

I YeYe)

Server Settings

( General

Colour Management | Working Paths

Maximum Memory for PS RIP - Set the maximum memory meini I

used by the Postscript RIP. The default is OMB (which uses the e L j

internal default amount). O ety amtat e

Maximum Memory for Rotation - Set the maximum memory S |

used for Rotation. The default is OMB (Server chooses the Al i sy setion [ 8 £E

default depending on system configuration). Poling Service Refresh: 0 1 @‘°: Bro-
Server Back Log: 0 %] Days

Low Quality Thumbnail - Selecting this produces a lower
quality thumbnail. This is faster but some detail may be lost in
the thumbnail.

Compression - Control the compression for the intermediate
file format (the Imaged file). Choices are Faster or Better. The
default is Faster.

Processes:

Minimum Broadcast Interval:

Mail Server

Sender Email Address

image 1 [3) Render 1 [)
IQl

1ls

[ Output unknown files to printer
(") Log printed jobs
Secure mode

Maximum Print Preview Resolution - Set the maximum
resolution for the rendered preview. The default is 180dpi.
Polling Service Refresh - Set the interval between poll service checks, i.e.,, how long between checks to see lf
any RIPs require polling. The default is 50 seconds if the times are left at 0.

Server Back Log - Number of days to keep the log. Older days are trimmed when the Server starts. Zero (0)
means the log will not be trimmed.

Processes - Control the number of processes the machine will handle, i.e., the number of Imaging and
Rendering tasks simultaneously run on the Server. The defaults are 1/1. Up to one imaging and rendering task
can be set per CPU core the Server machine possesses. In practice, it is recommended the combined number of
imaging and rendering tasks be set to no more than the number of cores. For example, 4 CPU cores = 2 Image/2
Render.

Minimum Broadcast Interval - Set the interval between the Server sending out updates to connected Clients.
The default interval is 2sec. High-end systems with good networking are able to set the interval to Osec for
slightly improved image/render times when processing large numbers of jobs. Sites using the Client remotely
connected via the internet should set a longer polling interval of 10-20sec.

Output Unknown Files to Printer - Output any unknown files direct to a printer. If this is unchecked, any
unknown files will result in errors and will not be output.

Log Printed Jobs - When enabled, this option will log completed print jobs in the Server log. The jobname and
dimensions are noted.

Secure Mode - Enable or disable Secure Mode.

Mail Server - Enter the details of the mail server for error notification emails when using Secure Mode.

Sender Email Address - Enter the details of the Sender (From) address for error notification emails.

( Cancel ) oK

N2
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Colour Management

ICC Engine Accuracy - Select Faster or Better, depending on
preferences.

Default ICC Profiles - Select the default ICC profiles used when
first creating a new Pagesetup (Input profiles) and Media
(Output profiles).

Version 3.4 spot colour handling - This is a compatibility
setting for users with Spot colour setups, upgraded from
Versions v3.4 or earlier to get consistent results from spot
jobs. It is recommended as a temporary setting only and
setups should be recreated using the improved and more

Server Settings

! General | Colour Working Paths |

ICC Engine Accuracy: | Better | &

Default ICC Profiles

("% Input RGB Profile ... ) monitors/AdobeRGB1998.icc

(" + Input CMYK Profile ... )

fogra-altona-testsuite/ISOcoated_v2_eciF39.icc

(% Output RGB Profile ... )

monitors/sRGB_v4_ICC_preference.icc

(" 4 Output CMYK Profile ... )

fogra-altona-testsuite/ISOcoated_v2_eciF39.icc

(] Version 3.4 spot colour handling

(] Apply ICC Correction to CMYK Specials
[_] Force Relative Colourimetric Media White
¥ CMS dithering

accurate (post v3.4) spot colour handling.

* Apply ICC Correction to CMYK Specials - Select this to apply
ICC correction to CMYK Specials.

* Force Relative Colourimetric Media White - Various ICC
profiling packages and some older ICC v2 profiles included an
Lab value for media (paper) white in the Relative
Colourimetric Intent LUT. This has the effect of printing a paper layer when printing with Relative
Colourimetric rendering intent. When enabled, this option ignores the Lab value for paper in the Relative LUT,
leaving paper white areas unprinted.

¢ CMS Dithering - Disabled by default. Use CMS Dithering for smoother results whenever conversion between 16
bits to 8 bits is required.

* Change System Specials - Select a default Special Colour Set for plate matching. This is used by the RIPMonitor
and polling service for plate assigning. Colours in this set are automatically assigned in the RIPMonitor.

* Unknown Specials - Select a Special Colour Set (optional) to which unknown special/spot colours included in
PDF or Postscript jobs can be automatically added.

(% Change System Specials ... ) Reference-Lab

(% Unknown Specials ... ) None

(Cancel ) (oK)

z?

Working Paths
Working Paths lists the default location of the paths the Server uses to process jobs.

* Raster - Holds all the imaged, rendered and print jobs while

8no Server Settings
they are live in the system. ((General | Colour Working Paths )
* Spool - The location where the job is spooled prior to ( Raster... ) Applications Serendipity/vpress/raster
processing. (Spool... ) /Applications/Serendipity/vpress/spool
* Temp - After spooling, the job is moved to the temp directory e e
where it is worked on. T (R e R D
¢ Drop - The default location for the DropFolders.

The Raster directory holds all jobs while they are in the system and as such, can be very large. If this is moved it needs
to be placed on a disk with plenty of space. A Server restart is required if any paths are changed in order for the
changes to take effect.

Important Note: All existing files in the new working path directory are
deleted when the Server is restarted. Ensure the new working path directory
has no essential data. A warning message will popup to confirm whether to
proceed with the path change.

Server Working Path

All existing files in the new
working path directory will be
deleted at server restart.

Do you wish to proceed?

| ———
( No ) Yes
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Web Server

The Veripress Server has a built-in web server. Accessed via a web browser, the Web Server provides status
information about the Server and jobs currently in the system. It cannot be used for submitting or managing files in the
system.

Accessing the Web Server
To connect to the Web Server:

1. Enter the IP address or machine name (if using DNS) of the computer running the Server in the browser
window, followed by a colon and the port number 8080. For e.g., 192.168.3.43:8080

Y 0 192.168.3.43:8080

2. Press Enter once the address has been typed in. When it connects, the browser address bar will look like this:

¢ Mnup://192.168.3.43:8080/

3. Ifyou have a DNS Server, you can use the machine name instead:

/l‘ B http://papaya: 8080/

4. Once you are connected, the front page will appear with an options menu on the left:

HOME BLOG CONTACT ‘

Company. Downloads

Welcome to Veripress

Vrrone Select an option from the list on the left to continue.
Queues
Log File
System Info
Support

*  Queues - Shows all the queues configured on the Server you are connected to.
* Log file - View the log file.

* System info - Displays information about the system.

*  Support - Shows various support options & information.

Available queues:

. . . . . Serendipity Blackmagic .
Queues - Click on any of the queues to get information about jobs in that queue. >
. . . . . Queues [} * Image
Information about the job, including name and current status will be shown. og e T B
e« Printer queues
System Info « Show all queues

Support

Available printers:

et 19k

‘Spoot e

]

] « Doublesided Printing
: « Epson 7900
]

]

image:

« Epson 4000

Render: de

Doublesded Prning: 1de
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System info - Choose this to display information about the system.

Product Info, Licensed Modules - available printers and input filters;

and Available Destinations are shown.

Support Company Downloads

Serendipity Support

e Our support ages ofe the ollowing nformation forour Blackmagic and Megarp producs:

A Software Updates
Find the asteet updates.

yourse

Serendipity Ciiont

Manuals
Foums. o o ol

Malling lists FAQ
Review our

Contact

Release Notes
Find out wha's new and Whafs baen fixed with our atest rleases.

Forum information
J0iur Forum and become part o the Serendipty communty.

Mailing Lists
Receiva Updaes a they ae rleased via email aly ot i digest form,

s o sl s oty oo !
e i v Log File - To view the log file, select the option from the list on the left.
: e S A
L From here, you can select a particular time period to fetch from the Server.
s s s Once viewed, you can print the file or save it to disk. The log can be printed,
— e saved or exported from the browser.

Disk usage:

Disk Used Total  Path

Spool gl 46.33GB 595.85G8 /Applications/Serendipitylbmagic/spool
Print - 46.33GB 595.85GB /Applications/Serendipitylbmagiciraster
ProdTemp 46.33GB 595.85GB /Applications/Serendipitylbmagic/tmp

osTemp 46.33GB 595.85GB /Applications/Serendipitylbmagic/tmp

Drop - 46.33GB 595.85GB /Applications/Serendipitylbmagic/drop

Product info:

ProductName: Serendipity Blackmagic version 4.0 (Build 21029)
Product Created: Jul 22 2009 13:11:48

ProductType: NFR (not for resale)

Hostname: golem.swdevel serendipity-software.com.au
Operating system: Darwin 9.7.0 1386

Dongle serial no: 48feb2441538

Dongle created: Wed Oct 22 15:55:32 2008

Licensed modules:

Available Printers

Canon BJC-8500 Rev 3.04

Canon imagePROGRAF W6400 / W8400 Rev 1.07
Canon iPF5000 / iPF8000 / iPF9000 Rev 1.07
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Support - To access the Serendipity Support site, select this option
from the menu. This is the same as if you accessed the Serendipity
Software website directly.

From here, you can download databases, release notes, manuals,
updates, tutorials, FAQs and other helpful information.

You will need to have an active Internet connection for access to the
support website function.
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Publishing a Pagesetup on Mac OS X (10.6.x)

Veripress Pagesetup’s can be set up as a Mac OS X system printer destination to allow jobs to be easily submitted via
the Print option of third party software or design packages.

Jobs going to a Published Pagesetup will be automatically sent for processing and colour management in Veripress,
eliminating the need for dropfolders or manual file submission.

Note: Jobs processed via Veripress in this way must be in a file input format available to your Veripress version.

Installing the Serendipity Printer Drivers
The first step when Publishing a Pagesetup for the first time is to install the Serendipity Printer Drivers for Mac OS X.

The installation package is located on the Veripress 5.3 Installation DVD:

3. Navigate to the /drivers/mac folder and run the file Serendipity Printer Drivers.pkg
4. An installer window will appear. Follow the prompts to complete the installation of the drivers. The installer
will require administrator access privileges.

Configuring a Pagesetup for Publishing as a TCP/IP System Printer

To configure a calibrated Pagesetup for Publishing:

Publish
[_| Publish DropFolder

1. In the Workbench, select the Pagesetup from the list of available data

1 Location .. Default Default
types.
2. Go to the Publish panel and enable the checkbox for TCP Port: Activate Printer: ([ Mac (I Windows
port number Option_ TCP Port: ¥ Activate port number 10201 8]
Flow Control: (| Hold After Imaging | Hold After Rendering

3. Enter the TCP port number into the field and Save the Pagesetup.

Port Numbers
It is recommended that the port number assigned to a Pagesetup be a port over 10000 to avoid any conflict with the
operating system or an existing application. Each Pagesetup to be published needs its own unique port number, for
example, 10200, 10201, etc.

Media

When submitting jobs to a Published Pagesetup, the default Media assigned to the Pagesetup is used. If you wish to
publish to different media on the same Output, each Media required needs to be assigned to its own Pagesetup, with its
own unique port number.

enn

Creating a TCP/IP Mac OS X System Printer
A system printer needs to be created and configured on the Mac OS X computer that is
running the Veripress Server.

1. Open the System Preferences for the Mac OS X. ——— :
2. Choose Print & Fax. F o

3. Click the + icon at the bottom of the printer list panel to create
a new printer.

4. Select the IP icon at the top of the Add Printer window.

5. Protocol - Select HP Jetdirect - Socket from the dropdown
menu.

6. Address - Enter the TCP/IP address and port information for
the printer setup in the following format: Computer
[Paddress:PagesetupPortNumber (see image for example). The
IP address for the printer should not be used. 2

7. Name - Enter the desired name for the printer. It should be
easily recognisable as a Published Pagesetup and/or the particular e
Pagesetup being published. Sl @D

Sewen
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8. Print Using - Select Printer Software from the dropdown menu.

9. Alist of available Mac OS X system printer drivers will popup.

10. Either scroll down the list and select Serendipity Veripress, or type “Serendipity” in the filter field and select
Serendipity Veripress and click OK.

11. Click Add to add the new printer. . B e o

N.oO Printer Software d
12. Set the published Pagesetup “Printer” as S oo .
the system default and/or share the C

printer on the network as required.

Defaul Last Printer Used. 2]
Defaul e (A4 ]
(Cancel) [ PSR- ®
Configuring a Pagesetup for Publishing as a Bonjour Printer
To configure the Pagesetup for Publishing:
Publish
(| Publish DropFolder
1. In the Workbench, select the Pagesetup to be Published from the list of ——— —
available items.
2. Go to the Publish panel and enable the printer: Mac checkbox. This lists e ?"A":mmn"umZW‘"""‘“
the Pagesetup in the Mac OS X system Bonjour destinations as Flow Conrol: CJHold Aftermaging (] Hold Afer Rendering (et
“Pagesetup name @ computer name”.
3. Save the Pagesetup configuration when done.

Creating a Bonjour System Printer for Mac OS X
A system printer needs to be created and configured on the Mac OS X computer running the Veripress Server.

Open the System Preferences for Mac OS X.

Choose Print & Fax.

Select the Default icon at the top of the Add Printer window.

Choose the Pagesetup from the Printer Name list. The Pagesetup will be

BN

listed as Kind: Bonjour and named “Pagesetup name @ computer name”.
5. Print Using - If you have installed the Serendipity Printer Drivers, the
Print Using field should auto-fill to show Serendipity Veripress.

a. If the Serendipity Printer Drivers have not been installed, cancel
the printer setup and install the drivers as per the above =
instructions. ety |

b. If the field does not auto-fill, choose Select Printer Software from . P
the dropdown menu. A list of available Mac OS X system printer —
drivers will popup. Either scroll down the list and select
Serendipity Veripress or type “Serendipity” in the filter field and = —
select Serendipity Veripress. Click Add. [el] (e 2

6. Name - Enter the desired name for the printer. It should be named to be
easily recognisable as a Published Pagesetup and/or the particular
Pagesetup being published.
Click Add to add the new printer. e v
8. Set the published Pagesetup “Printer” as the system default and/or share

the printer on the network as required.

.

N

¥ Share this printer on the network  (Sharing Preferences...)

Default printer: [ Last Printer Used B
Default paper size: [ A4 =}

! ik e fock o prevensfurther changes ®
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Publishing a Pagesetup on Windows 7

Veripress Pagesetup’s can be set up as Windows system printer destinations to allow jobs to be easily submitted via the
Print option of third party software or design packages.

Jobs printed to a Published Pagesetup will be automatically sent for processing and colour management in Veripress,
eliminating the need for dropfolders or manual file submission.

Note: Jobs output via Veripress in this way must be in a file input format available to your Veripress version.

Megarip Printer Driver
The first step before proceeding is to enable access to the Megarip.inf driver file. The Megarip printer driver is a
proprietary Serendipity Software driver that Windows will use as the printer driver.

The file is located on the Serendipity Veripress installation DVD in the following directory:

/drivers/win/win_xp_vista_7/

Configuring the Pagesetup for Publishing as a System Printer
To configure a calibrated Pagesetup for Publishing:

Publish
[_| Publish DropFolder

* In the Workbench, select the Pagesetup from the list of available data

types.
*  Go to the Publish panel and enable the checkbox for TCP Port: Activate Printer: (] Mac O Windows

TCP Port: ¥ Activate port number 10201 )

rt number ion. .
po tnu be Opt 0 . . Flow Control: (| Hold After Imaging | Hold After Rendering
* Enter the TCP port number into the field and Save the Pagesetup.

1 Location ... Default Default

Port Numbers
It is recommended that the port number assigned to a Pagesetup be a port over 10000 to avoid any conflict with the
operating system or an existing application. Each Pagesetup to be published needs its own unique port number, for
example, 10200, 10201, etc.

Media

When submitting jobs to a Published Pagesetup, the default Media assigned to the Pagesetup is used. If you wish to
publish to different media on the same printer, each Media required needs to be assigned to its own Pagesetup, with its
own unique port number.

Creating a TCP/IP Windows System Printer
A system printer needs to be created and configured on the Windows computer that
is running the Veripress Server.

¢ Select Windows Start Menu > Devices and Printers.

¢ Click on Add Printer. The Add Printer wizard will appear.

¢ Select Add a Local Printer and click Next.

* Select Create a New Port and Standard TCP/IP Port from the Type of Port

dropdown menu. Choose a printer port
¢ (Click Next. A printer portis 2 typeof connectionthat allows your computer o exchang information witha prnter,
* Type a Printer or Hostname Address: st am esisting port EuE e
o Device Type - TCP/IP Device © Cresteanewport
o Hostname or IP address - Enter the Network IP address Type ofpor Standard TCRIP Por .

of the Windows computer running the Veripress Server.
(e.g., 192.168.3.59).

o Port Name - Enter a name for the Windows port (this iS | ,..umeop e 1216035
NOT the printer name). Port name WegarppPo

o Uncheck the option to Query the Printer and —|Doueymepiotesnsuomstioyssectnedivertouse
Automatically Select the Driver to Use.

Device type: TCP/IP Device
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¢ (Click Next.
¢ Additional Port Information Required:

Device Type - Custom.

Click the Settings button. A configuration window will

O
O

appear.

* Configure Standard TCP/IP Port Monitor:
Protocol - Select Raw.
=  Raw Settings:

(e]

Port Number - Enter the unique TCP
Port number assigned to the Pagesetup
to be published, e.g., 10201.

Click OK. The window will close and return to the

Additional Port Information window.
Click Next.

¢ Install the Printer Driver:

(e]

(e]

If this is the first time installing a Veripress system printer, insert

the Veripress Installation DVD and select Have Disk.
Navigate to the /drivers/win/win_xp_vista_7/ directory.
Select the Megarip.inf file and click Open. The Serendipity
Megarip driver should now be displayed.

Click Next.

Note: The above step can be skipped for any subsequent installs of
Veripress system printers. The driver can be chosen from the Windows
printer driver list.

*  Which Version of the Driver do you want to use:

Additional port information required

The device is not found on the network. Be sure that:

. The device is turned on.

The network is connected.

. The device s properly configured.

The address on the previous page is correct.

[

-

If you think the address is not correct, click Back to return to the previous page. Then correct the
address and perform another search on the network. If you are sure the address is correct, select the

device type below.

Device Type

Standard | Generic Network Card

Port Settings

Configure Standard TCP/IP Port Moni

Port Name: MegaripPPD-1

Printer Name or IP Address: 192168.3.59

Protocol

Raw Settings

® Raw LPR

Port Number: 10201

LPR Settings

an instalation D, click Have Disk.

Printers

Serendipiy Software

Sharp.
Sony
TOSHIBA

Manufacturer E

+ ol sgnedt Windows pdte ] [ Have Disk

portent

e

) o)

o Select Use the driver that is currently installed (recommended) unless you are replacing an older
installed version of the Serendipity Megarip driver.

o Click Next.

¢ Type aPrinter Name:

o Enter a name for the printer. This is the name that will appear in the Windows Printers list and be
available as a printer option when printing from Windows applications. The name should be unique
for the Published Pagesetup.

o Click Next.

*  Printer Sharing:

o Select Share this printer so that others on your network can find and use it.

o Keep the default printer name or enter a share name.

o Click Next.

*  You've Successfully added “Printer Name”:

o Choose whether the Published Pagesetup destination is to be o ve sucestlly sl Megarip Publishe Pgesetop
the default system printer.

o If desired, click the Print a Test Page button. The test page job "
should appear in the Veripress QueueManager.

o Click Finish to close the wizard.
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Printing to a Published Pagesetup Printer across a Network

Printing from Mac OS X > Mac OS X, or Windows = Windows
Printing to a Published Pagesetup printer across a network where both computers (the machine sending the print and
the machine running the Veripress Server) share a common operating system is straight forward.

If network sharing has been enabled for the system printer destination created for use with the Veripress Pagesetup,
the printer will be available in the printer options of any other computer on the network.

Printing from Mac OS X > Windows, or Windows = Mac 0S X
Printing from a computer on the same network, but with a different operating system to the computer running the
Veripress Server requires the creation of a new system printer on the computer wishing to print to Veripress.

This is done by following the appropriate steps outlined previously for the relevant operating system.
The only alteration is when entering the TCP/IP address and the TCP port number:

1. Enter the network TCP/IP address of the computer on which the Veripress Server is running, i.e., the machine
you wish to print to.
2. Enter the TCP Port Number assigned to the Published Pagesetup you wish to print to.
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Troubleshooting

Clustering
Here are some suggestions of where to look if you run into trouble and experience problems when using a Cluster.

Jobs Not Processing Through a Cluster Node
The possible reasons for this are:

Here the Cluster Node called “pomelo” is currently offline. In this |>/2ve Nodes

case, you would check the node server is up, the machine is still 'Pv"gelsgz 168348 ::)ar:/":swdevelse '752';:7";';
connected to the network and can see the Master. If there is a # Imaging ' T

problem with the node, check the error log. One the problem is ™ Rendering

resolved, click the Refresh button or close and reopen the Clustering v élni:stSN pomelo.swdevel.... 963.05 par
Application. 7 Ren?je?mg

The Cluster Node is not configured to image, render or both. Check the ClusterStatus to see if either of the
processing tasks have been disabled. To enable them, open the Clustering Application and enable the
appropriate task.

The Cluster Node has a Processing Pool attached and the Pagesetup you are submitting jobs to is not contained
within the Pool. You can either unselect the Pool or add the Pagesetup to the Pagesetup Pool.

The Cluster Node has gone offline. To check, open the Clustering Application and check the node. If the
Clustering Application is already open, click the Refresh button. This will check for node status. If the node
appears grayed out or disabled, this indicates the node is not currently online.

The Node and Master are different versions. The node
should always be upgraded when the Master is to maintain the same versions in a Cluster.

Cluster Nodes Errors Log

The Cluster Nodes create an error log, which logs all the messages from the node. This is located in the Veripress
installation directory on the node’s own machine and is called “errors.log”. This can be viewed with a normal text editor
and can help to track a problem, or it can be sent to support for assistance in tracing a problem.

A Node Cannot Be Found
Once you have started your node successfully, you should be able to see it in the Clustering Application. If not, you need
to add the node manually. If this fails, there are a few things to check:

Verify the node is still running and the clock is still counting up.
Check the error log for any messages.
Check that the Master machine can ping the node machine. If not, there may be a network issue and you will
need to contact your network administrator for assistance.
Check the ports on the machines are open for the node to connect to the Master and they are not being used by
anything else. The port numbers for the node are as follows:

o 9103/tcp - Server connects here and submits jobs via this port.

o 9103/udp - Listens to broadcasts so the Server can enumerate available Node Servers.
Make sure the node is the same version as the Master. Nodes (Veripress Slaves) should always be upgraded at
the same time as the Master.
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Glossary

Client - GUI that monitors jobs and allows configuration of the Server.

Clustering - The use of multiple machines on a network for distributed processing.

CMM - Colour Management Module.

CRT - Cathode Ray Tube. Describes the type of monitor.

CTP - Computer to Plate.

CUPS - Common UNIX Printing System.

Data Types - Database groups such as Pagesetups or RIPs etc.

DPI - Dots Per Inch (resolution).

EPS - Encapsulated Postscript File.

FTP - File Transfer Protocol - Method for copying files between computers across networks.
GUI - Graphical User Interface.

ICC - International Color Consortium.

ICC Profile - A colour lookup table used for converting colour of a job from one device to another.
LAN - Local Area Network.

LCD - Liquid Crystal Display.

LPI - Lines Per Inch (Screen Ruling).

Master - A Master Server, controlling Slave nodes in a Clustering environment.
QueueManager - Client module that displays job queues and jobs in those queues.
QueueStatus - Monitors the progress of a job through the system.

Real Density - Colour content of a patch as measured.

RIP - Raster Image Processor.

Server - Software module that handles the processing of jobs.

Slave (Node) - A separate processing node on the network. Used for processing jobs by a Master.
TCP/IP - Transmission Control Protocol / Internet Protocol.

Visual Density — The darkness of the patch measured (how much light is absorbed). The more light absorbed, the
darker the Visual Density.

WAN - Wide Area Network.
Workbench - Client application used to configure the Server.
YN - Yule Nielsen Number.

Yule Nielsen Number - A “fudge factor” used when calculating % tint (dot area) from density readings.
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Copyright Notices

PNG Library Copyright
Copyright © 1995, 1996 Guy Eric Schalnat, Group 42, Inc.

Contributing Authors: Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul Schmidt, Tim Wegner.

The contributing authors would like to thank all those who helped with testing, bug fixes and patience. You know who
you are. This wouldn’t have been possible without all of you.

Thanks to Frank J. T. Wojcik for reviewing the documentation.

The PNG Reference Library is supplied “as is”. The Contributing Authors and Group 42, Inc. disclaim all warranties,
expressed or implied, including without limitation, the warranties of merchantability and of fitness for any purpose.
The Contributing Authors and Group 42, Inc. assume no liability for damages, direct or consequential, which may result
from the use of the PNG Reference Library.

Permission is hereby granted to use, copy, modify and distribute this source code, or portions hereof, for any purpose,
without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.
2. Altered versions must be plainly marked as such and must not be misrepresented as being the original source.
3. This Copyright Notice may not be removed or altered from any source or altered source distribution.

Compression Library Copyright
Copyright © 1995 Jean-loup Gailly and Mark Adler.

This software is provided “as is”, without any express or implied warranty. In no event will the authors be held liable
for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications and to alter it
and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original
software. If you use this software in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original
software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly and Mark Adler.

gzip@prep.ai.mit.edu madler@alumni.caltech.edu

Independent JPEG Group’s Copyright

The authors make no warranty or representation, either express or implied, with respect to this software, its quality,
accuracy, merchantability, or fitness for a particular purpose. This software is provided “as is” and you, its user, assume
the entire risk as to its quality and accuracy.

This software is copyright © 1991, 1992, 1993, 1994, 1995, Thomas G. Lane. All Rights Reserved except as
specified below.

Permission is hereby granted to use, copy, modify and distribute this software (or portions thereof) for any purpose,
without fee, subject to these conditions:

1. [Ifany part of the source code for this software is distributed, then this README file must be included, with this
copyright an no-warranty notice unaltered; and any additions, deletions, or changes to the original files must
be clearly indicated in accompanying documentation.
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2. If only executable code is distributed, then the accompanying documentation must state that “this software is
based in part on the work of the Independent JPEG Group”.

3. Permission for use of this software is granted only if the user accepts full responsibility for any undesirable
consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library. If you
use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author’s name or company name in advertising or publicity relating to
this software or products derived from it. This software may be referred to only as “the Independent JPEG Group’s
software”.

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all
warranty or liability claims are assumed by the product vendor.

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of its copyright holder,
Aladdin Enterprises of Menlo Park, CA. ansiZknr.c is NOT covered by the above copyright and conditions, but instead
by the usual distribution terms of the Free Software Foundation; principally, that you must include source code if you
redistribute it. (See the file ansiZknr.c for full details). However, since ansi2knr.c is not needed as part of any program
generated from the IJG code, this does not limit you more than the foregoing paragraphs do.

“The Graphics Interchange Format © is the Copyright property of CompuServe Incorporated. GIF (sm) is a Service Mark
property of CompuServe Incorporated.”

Copyright © 1980, 1993
The Regents of the University of California. All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following

acknowledgment:

This product includes software developed by the University of California, Berkeley and its contributors.

5. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

>

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 1990, 1994 Regents of the University of Michigan
All Rights Reserved.

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is
hereby granted, provided that the above copyright notice appears in all copies and that both that copyright notice and
this permission notice appear in supporting documentation, and that the name of The University of Michigan not be
used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.
This software is supplied as is without expressed or implied warranties of any kind.

This product includes software developed by the University of California, Berkeley and its contributors.
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Code in sys/linux is developed by Alan Cox. You may redistribute it and/or modify it under the terms of the GNU
General Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

Research Systems Unix Group
The University of Michigan
C/0 Wesley Craig

535 W. William Street

Ann Arbor, Michigan
+1-313-764-2278
netatalk@umich.edu

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright © 1989, 1991 Free Software Foundation, Inc.

675 Mass Ave,
Cambridge,
MA 02139, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public License is intended to guarantee your freedom to share and change free software-to make sure the
software is free for all its users. This General Public License applies to most of the Free Software Foundation’s software
and to any other program whose authors commit to using it. (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead). You can apply it to your programs, too. When we speak of
free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source
code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you
know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the
rights that you have. You must make sure that they too, receive or can get the source code. And you must show them
these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced by others will not reflect on the original
author’s reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors
of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we
have made it clear that any patent must be licensed for everyone’s free use or not licensed at all. The precise terms and
conditions for copying, distribution and modification follow.
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GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder

saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to any
such program or work, and a “work based on the Program” means either the Program or any derivative work
under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with
modifications and/or translated into another language. (Hereinafter, translation is included without limitation
in the term “modification”). Each licensee is addressed as “you”.
Activities other than copying, distribution and modification are not covered by this License; they are outside its
scope. The act of running the Program is not restricted, and the output from the Program is covered only if its
contents constitute a work based on the Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License along with the Program.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

c. If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a notice that there is no warranty (or
else, saying that you provide a warranty) and that users may redistribute the program under these
conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is
interactive but does not normally print such an announcement, your work based on the Program is not
required to print an announcement).

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Program, and can be reasonably considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same
sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Program. In
addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the
Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable
form under the terms of Sections 1 and 2 above provided that you also do one of the following:

a. Accompany it with the complete corresponding machine-readable source code, which must be
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,

b. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,

c. Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above).

The source code for a work means the preferred form of the work for making modifications to it. For an executable
work, complete source code means all the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs,
unless that component itself accompanies the executable.
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If distribution of executable or object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4,

10.

11.

You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their Licenses terminated so long as such parties remain in full
compliance.
You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if
you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying,
distributing or modifying the Program or works based on it.
Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.
If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you
cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license
would not permit royalty-free redistribution of the Program by all those who receive copies directly or
indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely
from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply and the section as a whole is intended to apply in other
circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public license practices. Many people
have made generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of
this License.
If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in
or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the
body of this License.
The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of
this License which applies to it and “any later version”, you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If
the Program does not specify a version number of this License, you may choose any version ever
published by the Free Software Foundation.
If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will
be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting
the sharing and reuse of software generally.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO
THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
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AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Appendix: How to Apply These Terms to Your new Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve
this is to make it free software which everyone can redistribute and change under these terms.

To do so, attached the following notices to the program. It is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to
where the full notice is found.

<one line to give the program’s name and a brief idea of what is does>
Copyright © 19yy <name of author>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General
Public License for more details.

You should have received a copy of the GNU General Public License along with this program,; if not, write to the
Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

Also add information on how to contact you by electronic and paper mail.
If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright © 19yy name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type “show w”. This is free software, and
you are welcome to redistribute it under certain conditions; type “show c” for details.

The hypothetical commands “show w” and “show c” should show the appropriate parts of the General Public License. Of
course, the commands you use may be called something other than “show w” and “show c”; they could even be mouse-
clicks or menu items-whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright
disclaimer” for the program, if necessary. Here is a sample; alter the names:

Yoyodyne Inc., hereby disclaims all copyright interest in the program “Gnomovision” (which makes passes at
compilers) written by James Hacker.

<signature of Ty Coon>, 1 April 1989

Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is
a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this
is what you want to do, use the GNU Library General Public License instead of this License.

Serendipity Software - Veripress User Manual - Version 5.3 125



Copyright
The XFree86 Project, Inc.

Copyright © 1994, 1995 The XFree86 Project, Inc. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software. THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE XFREE86 PROJECT BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of the XFree86 Project shall not be used in advertising or otherwise to
promote the sale, use or other dealings in this Software without prior written authorization from the XFree86 Project.

$XConsortium: CPYRIGHT.sgml,v 1.2/95/01/16 13:17:39 kaleb Exp $

Generated from XFree86: xc/programs/Xserver/hw/xfree86/doc/sgml/CPYRIGHT.sgml,v 3.3 1995/01/28 16:01:20
dawes Exp $

$XFree86: xc/programs/Xserver/hw/xfree86/doc/COPYRIGHT,v 3.8 1995/07/24 06:52:11 dawes Exp $

Serendipity Software - Veripress User Manual - Version 5.3 126



1

16 bit Processing 42

A

Absolute Colourimetric Rendering Intent
44

Accounts Admin 104

Accuracy Correction....scinn 47

Always Use ICC 43

Antialiased Subsampling..............cccooessusreennn. 45

Antialiasing
Application Menu ...
Application Menu Items..
Accounts Admin
Broadcast Message.........rssseesnns
Chatterbox
Connect to Server...
Download PPD ........
Submit Files As Imposition.......c..
Submit Files For De-Imposition
Submit ICC Target..
Test Prints
Applications
Archives
Clustering
Densitometer
Displays
FlipBook
Jobs
Monitor
Press Agent
SoftProof
ToucCh CONSOLE c.ouereeerereeerreeerseeesseeere
Archives
Adding items to.......

Automatic Backup ..
Auto Crop

Auto Publication Name ......ccooeeveresseeenseens
AutoClean
AutoPause

B

Index

Calibration Reminder ........ccccuueenrerserernnnnn. 107
Camera 31
Change White Point.......cnrvceissnnnns 32
CIP3 65
Client 24

Interface 24

Workbench 24
Client Settings 107

Additional Monitors..
Application Shortcuts...
Colour Management.
General
ClientLog
Display Options
Export From
Fetch Back LOg ..ovvevvvvvessninieneenssssssssnnns
Filtering Options.........cniscsssssnnns
Clustering
Cluster Nodes
Master
ClusterStatus
CMS Dithering....
CMYK Slmulatlon from PDF
Colour Management
Default ICC Profiles........ .
ICC Engine Accuracy ...110
Press
Server Settings ..sssssssnennins
ColoUrSPACE ..oreveesersresssisssenns
Convolution Matrix
Copyright Notices
Correction LUT
Cropmarks 46
Cropping 47

D

D-Dot
De-Imposition
Modify
Densitometer
Export Values
Measure Targets
Device Link Profile........

E

Edge Detect 46
Edit
Media from QueueManager .................
Output from QueueManager .....
Output from QueueStatus...
Pagesetup from DropZone.
Pagesetup from QueueManager ........
Plate Colour in VirtualPress ......o......
RIP from QueueManager
RIP from RIPMonitor... .
Signature Group from QueueManager
66
Effects 46
Entering a new polling path................. 28,53
Export
From ClientLog
From QueueManager....
From ServerLog..............
From Special Colour Set......c.... 50,57

F

Fail on RGB Images.......cnnnnscevisssnnns
Fast Polling
Fitting Methods
FlipBook
Allow Multiple Windows
Borders around Pages
Navigation
Page Order
Settings
Flow Control
Folders
Adding to the Workbench...........
FTP

Polling

G

Gap Between Jobs in a Nest.....cneerinneens 41
Glossary
Gradation Curve

Invert Curve

Back Page DotGain Curve.... .. 48 Disable PDF Autoseparation.................. 45 .
Back Page Opacity . Displays 77 Preview Curves...
Backing up the Database. S ) Ambient 80 Table
Black Point Compensation ... 43 Calcheck 78 ) Trace Saved CUIVe o 31
Bonjour 40, 42 Calcheck HiStOrY . mmmmmmsmrsssssssssssesseene 79 Gripper Size 56
Bookfilter 28 Calibration 77 _pGrou
Driver 28 Light Booth 80 Bylob s 68
Paths 28 White Point 78 Pages within Signature Group............. 54
Polling 28 Dongle H
Testing 28 What's on the DVD.....emeeeeesmeecessiesnee
BookMonitor 60 Dongle Updater Hold After Imaging .......cunrisesesinnnns 53,70
Options 60 Updating the Dongle ......oocoveurrecsnne Hold After Rendering... 53,70
Border 46 DotGain Curve Honour Embedded ICC Profiles.................. 43
C Applying to a Pagesetup.. I
Import from CSV
Calcheck Chart 29 Invert Curve ICC
Add Colours From Library .......cccceee.. 29 Table Apply Correction to CMYK Specials 110
Generate Patches from ICC .29 Trace Saved Curve..... Engine Accuracy......... ..110
Import Patches.... Drawing a Rectangle around a Job........... Upload ICC to Server.
Patch Definition...... DropFolders 42 ICC Profiles
Patches DropSpot ICC Tweak Set
Patches Per Strip ...ssssssssssssssnn 30 Setting the colour... - Tweak Value
Reorder Patches ... .29 Setting the number Of copies. Ignore Items
Spectrophotometer .30 DropZone Import
Target Standards.... - 11] Add DropSpot Language Encoding.......comervsnsneens 55
Tolerances 29 Reordering DropSpots ... Import Colours
Calcheck Managed.......c.ccoumusevurssnnnnns 107, 108 Into Special Colour Set.....cuueeuvnee. 50,57
Serendipity Software - Veripress User Manual - Version 5.3 127



Importing Signatures

Dynastrip 54
Facilis 54
JDF 54
Krause 54
Impositions
Grouping Pages .......mssssssssnnesss 54
Inclusive Page Grouping
In a Signature 55
Ink and Paper
Press Configurations .......nceiinns 48
Input Filter 52
Installation 7
What's on the DVD?......cevmeeenmneerrnecnnnen 7
J
Job Genie 33
Actions 33
Definitions 34
Interface Options ......ecessessnenes 33
Job Grouping 35
Plate Identification.........ceveeessrieninn 35
Plate Mapping 36
Separator Options......sns 35
Tabs
Collect Files ..mrnneriseessesssenns 33
Display 37
Filename Break Down..........cccounnn.. 34
Options
Jobname + Plate
Publication + Pages.
Publication Part....
Section Part......ncnens
Tasks
Job Info
Jobs
Tabs
Viewing in RIPMonitor ...
K
Knockout 58
L
Language Encoding
Signature Group.....mnssesisens 55
Linux
What's on the DVD.....ocnmeernmeeernneernnenns 7
Localhost Polling 28
Log File
Web Server 112
Logo 46
M
Mac OS X Installation
Printer Drivers 9
Macintosh Installation
What's on the DVD.....ocnmeernmeeernneernnenns 7
Margins 46,47
Match
Items (Regular Expression).... ... 49
Maximum Ink Weight v 48
Media 38
Colour Correction ........eemeeesseeeens 38
ICC Profiles 39
Output 38
Usage 38
MediaStatus 63
Minimum Plate Count.........ccoueeessrsssrrsenrnens 53
Monitor 85
Add Modules 85
Edit Mode 85
Imaging Thumbnail..........cceunurnernrcerrnnns 70
Layout Options............ .85
Load a saved layout rreeerenne 85
Rendering Thumbnail.......cccouueruurnrvvirnnns 70
Tabs 85

Use Mode 85

Monitor Modules 59
BookMonitor 59
ClientLog 59
ClusterStatus 59
DropZone 59
MediaStatus 59
QueueManager .59
QueueStatus 59
RIPMonitor 59
ServerLog 59
Status 59
Thumbnail 59
VirtualPress 59

N

Nest Jobs 65

0

Open
An Archive 72

Output 40
Collating 41

Automatic Nesting.....oeneeersennn 41
Nesting 41
Destinations 40
Queue 40

P

Page Head Direction
Signature Group......isssessssseesssssns 56

Page Number
Changing 65

Pagenumber 46

Pagesetup 42
Colour Correction ... 43
Colour Keys 44
ColourKeys 44
Configuration 18
Effects 46
ICC Profiles 43
Input Screening....scisseesinnns 45
Logo 46
Media Effects 47
Output 42
Postscript/PDF Options ... 45
Priority. 42
Publish 42
Resampling 45

Paint Mode 58

Pair Pages
Signatures 54

Perceptual Rendering Intent.... .43

Polling 52
Creating a RIP to poll jobs......ccuuuurvee 52
FTP 53

Ignore Mod Time
Initiate a Manual Poll
Logging Statistics ...
Method to use
Paths

Testing Configuration .......eeesseeenn. 54
PPD

What's on the DVD....neecvvevessnssisiennennn 7
Press 48

Colour Management......cooouueeerevceessnennns 48

Dimensions 48

Ink and Paper 48
Press Agent 86

Log 86
Press Sheet Settings .........rniceisssnnns 56
Print Calcheck 44
Progressive Proofs........n. 44
Q
QueueManager 64

Configuration Options......enn: 66
Modify
Viewing Options
QueueStatus
Change Queue
Queue Order
R
Real Dot Technology ...........eccisssnnns 45
Registration Marks ........nnicciissnnn 46
Regular Expression 49
Conditions 49
Expressions 49
String Entry 49
Relative Colourimetric Rendering Intent44
Render Again 65
Render in RGB 45
Rendering Intents ... e 43
Replace Colour Set.... v 50
Tabs 50
Resampling
Bicubic 45
Bilinear 45
Filtered 46
Nearest Neighbour .........ccccoueennicciiirnnnns 45
Retain Pure Black 44
RGB to CMYK Conversion ... 45
RIP 52
AutoProofing 53
Configuration 19
Connection 52
Driver 52
Job Filtering 53
Paths 53
Polling 52
Stripe Paths 53
Testing Poll Configuration .......ccceueee... 54
RIPMonitor 68
Rip List 68
Submit Jobs for De-Imposition........... 68
VirtualPress 68
Rotation 47
Running the Software.........ccocunnnrnrcvrirrnnnn 16
32 bit 16
Starting the Client.. .17
Starting the Server.
Rush Jobs
S
Saturation Rendering Intent.............c.. 44
Save
An Archive 72
The Database 72
Scheduled Backup..... ]
Search 30
Searching
For messages in the ClientLog............ 61
For messgaes in the ServerLog...........
Secure Mode........ 104,109
Activating 106
Configuration ....esnncsssssssssenns 104
Creating Groups.. ..105
Creating Users..... .105
Error Notifications .... 105
Hosts Panel 106
Setting up Users and Groups.............104
User Privileges ......nneenniinninnn 105
Selective Import
Choosing Signatures to import into
Signature Group ... 54

Sending
A Job to another Pagesetup
Separated Postscript
Serendipity Client Menu Items
Submitt ICC Target Without Colour
(01635 cTot5 1) + HPT N 102
Server 21
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Help Menu 21
Info 26
Options 21
Server Settings
Colour Management.........cceossueeernnenns 110
General 109
Working Paths.......ieciininn. 110
ServerLog 69
Filtering messages.......crnereeiiens 69
Setting
The Colour of a DropSpot.....w. 62
Signature
Delete 55
Duplicate 55
New 55
Signature Decorations........n 46
Signature Group 54
Auto Paginate 54
Close Page Number Gaps. .55
Deleting a Page......cusunees .. 56
Deleting Signatures.... .55
Duplicating a Page .
Duplicating Signatures . .55
Editing Page Numbers .. .. 54
Grid Attributes .56
Gripper Size 56
Grouping Pages....... .54
Import Signatures.. .. 54
Language Encoding......ccc...... .. 55
Multi-selecting Signatures .. .55
Offset Page Numbers. .54
Page Attributes ....... ..
Page head direction ... ..56
Page Orientation.........nnieciis 56
Pair Pages 54
Plate Options 55
Press Sheet Settings... .56
Rename Signatures .... .54
Rotate Selected Signatures .54

Rotating Signatures....

Selecting Import. .54
Setting Page Size. .56
Setting Page Width 1)
Suppress Pages ... 54
Toolbar 54
Slugline 46
SoftProof
Notes 93
Publications 93
Software Updates 22
Sound FX 107
Special Colour Set 57
Adding Colours from Library.......c.... 57
Adjusting Colour Intensity............ 58

Create a New COlOUT ..vvveereverrssernsianns
Delete colours
Duplicate colours.......

Export colours to a file. 50,57
Import colours from files.... ..50,57
Paint Modes 58
Spectro 95
Activate 95
Export Values 95
Load Set 95
Status 70
Stretch Factor 48
Submit
For De-Imposition......risneinenn. 68
Support
Web Server ... 111, 112
System Info
Web Server 112
System Settings 107
Client 107
Server 109
T
Tabs
Reordering
The Serendipity Updater....

The Veripress Client
The Veripress Dongle Updater
The Veripress Server

Thumbnail
Preview.
QueueStatus 67
Show Imaging 70
Show Rendering ......eeessssseesees 70
Tiff Multichannel
Export 66
Touch Console 96
Fast Scrolling 96
Interface 96
Modes 97
Loupe 99
Main 97
Navigate 98
Settings 99
Trimming
The ClientLog 61
The ServerLog ... 69
Troubleshooting 118
§)
Ungroup pages
Signature Group....... 54
Unsharp Mask 46

\

Veripress
Product OVerview .......ecennens 6

View
Errors 65
Imaged 65
Rendered 65

View Errors 65

VirtualPress 70
Edit Plate Colour.....eenreseerissrssnseenns 70
History 70
Quick Submit 70

w

Watermark 46

Web Server 111
Accessing the Web Server ... 111
Log File 112
Queues 111
Support 112
System Info 112

Windows Installation ... 8
32 bit. 8
32 bit Agent 8
64 bit. 8
64 bit Agent 8
Dongle Driver 8
Serendipity Agent .....esrssnsisiennn: 8
Veripress 8
What's on the DVD

Workbench
Organise Data Types......nenn: 25

Workbench Data Types ...vmrevuseinnens 27
Bookfilter 27
Calcheck Chart 27
Camera 27
| DIoTuCF: 11 o W 0111 a7 27
Gradation CUIVE......eemeesseeesseeenens 27
ICC Tweak Set 27
Job Genie 27
Media 27
Output 27
Pagesetup 27
Press 27
Regular EXpression ... 27
Replace Colour Set.....reriennesennns
RIP
Signature Group
Special Colour Set ..

Y

Yule Nielsen Number .......ccoveeenereririsnnnnnn 119
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